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Software and Documentation License Agreement 

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE OPENING THE 
CD PACKAGE.  OPENING THE CD PACKAGE INDICATES ACCEPTANCE OF THESE TERMS 
AND CONDITIONS.  IF YOU DO NOT AGREE WITH THEM, PROMPTLY RETURN THE 
PACKAGE UNOPENED AND YOUR MONEY WILL BE REFUNDED. 

Title to the media on which the program is recorded and to documentation in support thereof is 
transferred to you, but title to the program is retained by  Gage Applied Technologies, Inc.  You   
assume responsibility for the selection of the program to achieve your intended results, and for the 
installation, use, and results obtained from the program. 

License 
Under the terms and conditions of this License Agreement you may: 

a) use the program on a single machine; 

b) copy the program into any machine-readable or printed form for backup or modification purposes 
in support of your use of the program on the single machine.  Copying of documentation and other 
printed material is prohibited; 

c) modify the program and/or merge it into another program for your use on the single machine (any 
portion of this program merged into another program will continue to be subject to the terms and 
conditions of this Agreement); and 

d) transfer the program and license to another party if the other party agrees to accept the terms and 
conditions of this Agreement.  If you transfer the program, you must at the same time either 
transfer all copies whether in printed or machine-readable form to the same party or destroy any 
copies not transferred; this includes all modifications and portions of the program contained or 
merged into other programs. 

You must reproduce and include the copyright notice on any copy, modification or portion merged into 
another program. 

You may not use, copy, modify, or transfer the program, or any copy, modification or merged portion, 
in whole or in part, except as expressly provided for in this License Agreement. 

If you transfer possession of any copy, modification or merged portion of the program to another party, 
your license is automatically terminated. 

Terms 
The license is effective until terminated.  You may terminate it at any time by destroying the program 
together with all copies, modifications and merged portions in any form.  The license will also terminate 
upon conditions set forth elsewhere in this Agreement or if you fail to comply with any term or 
condition of this Agreement.  You agree upon such termination to destroy the program together with all 
copies, modifications and merged portions in any form. 
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Limited Warranty 
Gage Applied Technologies, Inc. warrants the media on which the program is furnished to be free from 
defects in materials and workmanship under normal use for a period of one year from the date of 
delivery to you as evidenced by a copy of your receipt. 

THE PROGRAM IS PROVIDED �AS IS� WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK 
TO THE QUALITY AND PERFORMANCE OF THE PROGRAMS LIES WITH YOU.  SHOULD 
THE PROGRAM PROVE DEFECTIVE, YOU (AND NOT GAGE APPLIED TECHNOLOGIES, 
INC.) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR 
CORRECTION. 

SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO 
THE ABOVE EXCLUSION MAY NOT APPLY TO YOU.  THIS WARRANTY GIVES YOU 
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
FROM ONE JURISDICTION TO ANOTHER. 

Gage Applied Technologies, Inc. does not warrant that the functions contained in the program will meet 
your requirements or that the operation of the program will be uninterrupted or error free.  However, 
Gage Applied Technologies, Inc. warrants the media on which the program is furnished to be free from 
defects in materials and workmanship under normal use for a period of one year from the date of 
delivery to you as evidenced by a copy of your receipt. 

Limitations of Remedies 
Gage Applied Technologies, Inc.�s entire liability and your exclusive remedy shall be: 

a) with respect to defective media during the warranty period, Gage Applied Technologies, Inc. will 
replace media not meeting Gage Applied Technologies, Inc.�s �Limited Warranty� if returned to 
Gage Applied Technologies, Inc. or its authorized representative with a copy of your receipt, or 

b) if Gage Applied Technologies, Inc. or its representative is unable to deliver replacement media free 
of defects in materials and workmanship, you may terminate the Agreement by returning the 
program and your money will be refunded. 

IN NO EVENT WILL GAGE APPLIED TECHNOLOGIES, INC. BE LIABLE FOR ANY 
DAMAGES, INCLUDING ANY LOST PROFITS, LOST SAVINGS OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OF OR INABILITY TO USE SUCH 
PROGRAM, EVEN IF GAGE APPLIED TECHNOLOGIES, INC. OR ITS AUTHORIZED 
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
ANY CLAIM BY ANY OTHER PARTY. 

SOME JURISDICTIONS DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY 
FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR 
EXCLUSION MAY NOT APPLY TO YOU. 

General 
You may not sublicense, assign or transfer the license or the program except as expressly provided in 
this Agreement.  Any attempt otherwise to sublicense, assign or transfer any of the rights, duties or 
obligations hereunder is void. 
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This Agreement is governed by the laws of the Province of Quebec, Canada. 

The parties agree that this Agreement be written in English.  Les partis consentent à ce que cette entente 
soit rédigée en anglais. 

Should you have any questions concerning this Agreement, you may contact Gage Applied 
Technologies, Inc. in writing.  Please check the Gage website for the most current address: 
http://www.gage-applied.com/aboutgag/contact.htm. 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT AND 
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS.  YOU FURTHER AGREE THAT IT 
IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN US 
WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND 
ANY OTHER COMMUNICATIONS BETWEEN US RELATING TO THE SUBJECT MATTER OF 
THIS AGREEMENT. 
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Introduction 

GageScope® is a powerful software package which, finally, bridges the gap between 
oscilloscopes and computers, helping scientists and engineers get the most out of their 
measurements. 

All this performance is available without writing a single line of code or drawing any 
diagrams.  GageScope® starts being productive right out of the box. 

GageScope® takes full advantage of the Windows operating system, making the user interface 
for CompuScope and CompuGen cards very easy to learn and use.  

On-screen controls and toolbars give you complete control of all capture and display features, 
allowing you to change settings while data capture is in progress. As many as 60 channels can 
be viewed together on the screen, and signals can be saved to disk for future use. 

Optional software advanced analysis tools allow the power of GageScope® to be further 
enhanced by allowing deep FFTs, unattended transient capture, averaging, waveform 
parameter calculations and correlation.  Many more analysis tools will become available in 
the future, making GageScope® even more powerful. 
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GageScope® is now available in the Professional and the Standard Editions. 

• The Professional Edition 

This edition contains the following advanced analysis tools: 

• Autosave 

• Averaging 

• Waveform Parameters 

• FFT 

• Extended Math 

• The Standard Edition 

All advanced analysis tools, with the exception of the Extended Math tool, are 
included in the Standard Edition but with limited functionality. The limitations are 
listed as follows: 

• AutoSave can only save a maximum of 4 files  

• While Averaging, running average is not available and the maximum averaging 
depth is 8192  

• Waveform Parameters tool supports only the following parameters: 

• Period  

• Frequency  

• Mean 

• RMS 

• The maximum length of FFT is 4096 points 

• Extended Math tool is not available 
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Features 

• No Programming Required – Works Out of the Box. GageScope® brings all the 
advantages of the Pentium processor, Windows operating system and the Internet to the 
CompuScope and CompuGen cards without requiring the user to write a single line of 
programming code or draw diagrams.  It works straight out of the box! 

• Automatic Detection of CompuScope or CompuGen Cards. GageScope® 
automatically detects the presence of CompuScope and CompuGen Cards in the system, 
bringing true Plug-n-Play functionality to the Test and Measurement user. 

• Simple Interface, Complete Control. Change such settings as sample rate, trigger 
depth, timebase, input range, and so on, with a click of the mouse. All options are 
viewable onscreen instead of in menus and dialog boxes. 

• Dynamic Display. Adjustments made to any GageScope® settings are automatically 
reflected in the Display Window. Change the sample rate, channel mode, timebase, 
vertical scale, and other settings on the fly. 

• Zoom In and Out to Fully Utilize Deep Acquisition Memory. Deep memory 
acquisition really comes to life with zooming capability of GageScope®.  You can view 
the entire record, click on the Zoom tool, select the portion of the signal that is of interest 
to you and zoom in.  Completely painless! 

• Scroll Through the Signal Using Familiar Windows Scroll Bars. Now you 
don�t have to scroll through large sets of data using a slow and ineffective scroll knob on 
a traditional DSO.  You can use standard Windows horizontal and vertical scroll bars to 
view different portions of the signal. 

• Import Signals into Reports and Manuals. Capturing signals in the Windows 
environment allows you to effortlessly bring the waveform plots into word processing 
documents such as project reports and product manuals. 

• Remote Control of your CompuScope or CompuGen Cards. GageScope® can 
be run remotely using standard Windows utility programs.  This allows you control over 
your CompuScope or CompuGen cards even when you are not physically in the 
laboratory. 

• Simultaneous Time and Frequency Domain Display. Now you can view captured 
signals in both time and frequency domain using the powerful FFT capabilities of 
GageScope®.  

• Save Signals and Setups to Disk. A virtually infinite number of signals can be saved 
using GageScope®. Saving signal files in binary or ASCII format allows you to post-
process the data using analysis packages such as MATLAB, Excel, Mathcad etc. Setup 
files can also be saved, allowing you to easily go back to a previously set up experiment. 



 

GageScope® xi 

• InfoView . Not only does GageScope® allow you to capture signals and make 
measurements, it also provides results which can be displayed in the InfoView window 
on the screen. 

• Flexible Printing. If you use GageScope®, you can print to any Windows compatible 
printer or fax, including network devices, to get a hard copy of your measurements. 

• Royalty Free File Viewer. Signal files saved by GageScope® can be viewed by your 
colleagues on as many different stations as you desire, using the royalty-free signal 
viewer supplied with GageScope® and downloadable from www.GageScope.com. 

• Independent Timebase and Sample Rate.  Have you ever wanted to capture a 
signal at a very fast sample rate, but view it with a long timebase?  CompuScopes with 
deep memory are capable of doing so, but many DSOs are not.  GageScope® allows you 
to decouple sample rate from timebase for more flexible measurements. 

• Independent Vertical Scale and Full Scale Input Range.  Almost all 
oscilloscopes on the market assume that the signal they are measuring does not have 
enough dynamic range to require more than 8 divisions (256 rows of pixels across 8 
divisions) on the oscilloscope screen.   
 
While this is true for an 8 bit DSO, it is not so for CompuScope cards which can have as 
much as 16 bit resolution which would require 65,536 pixel rows to do justice to the 
dynamic range. 
 
As such, GageScope® completely decouples Vertical Scale from Full Scale Input Range, 
allowing the user to scroll up and down on any vertical portion of the signal. 

• Unattended Transient Capture with Time and Date Stamp. Optional AutoSave 
analysis tool for GageScope® allows completely unattended transient capture and storage 
to disk.  A date and time stamp is also included with the saved data for record keeping 
purposes. 

• Advanced Analysis Tools.  GageScope® advanced analysis tools currently include 
Waveform Parameters, AutoSave, Averaging, FFT Analysis, and the Extended Math. 
These analysis tools dramatically enhance the functionality of GageScope®. 
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How to Use this Manual 

To get the most out of GageScope®, it is recommended that you read through this manual. 

• Part A, Getting Started, provides detailed instructions on installing GageScope®, running 
the program, and configuring your CompuScope and CompuGen cards with the 
Instrument Manager. 

• Part B, Tutorials, contains seven tutorials designed to introduce how GageScope® works. 
If you are new to GageScope®, then Tutorial 1: Fundamentals is the best place to start.  

• Part C, Reference, lists every feature of GageScope® along with detailed descriptions on 
how they work. 

• Part D, Appendices, describes the GageScope® SIG binary signal file format, default 
GageScope® settings, help on setting the I/O address on CompuScope cards, and other 
information related to using CompuScope cards. It also contains information on how to 
configure CompuScope and CompuGen cards using the Instrument Manager utility. 

• Part E, Glossary, lists the terms used in this manual, with definitions for each. 

Important Notes 

• In order to produce most of the examples throughout the manual, CompuScope 2125, 
CompuScope 8500, and CompuGen 1100 cards were used. In instances where examples 
refer to settings that are specific to the equipment being used, it may be necessary for you 
to alter the suggested settings to suit your particular  instrument. 

• CompuScope is sometimes abbreviated �CS� for brevity. For example, CompuScope 
12100 could be written as CS12100.  CompuGen is abbreviated as �CG�. 

•  �CompuScope x012� and �CSx012� are used to refer to the 12 bit ISA bus CompuScope 
cards: CS8012A, CS8012, CS6012, CS1012, and CS512.  

• �CompuScope x012/PCI� and �CSx012/PCI� are used to refer to the 12 bit PCI bus 
CompuScope cards: CS8012A/PCI, CS8012/PCI, CS6012/PCI, CS1012/PCI, and 
CS512/PCI. 
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Specifications 

System Requirements 

• PC with a Pentium 200 MHz processor; 266 MHz Pentium II or higher strongly 
recommended  

• Microsoft Windows 95, Windows 98, Windows NT 4.0 or Windows 2000 operating 
system  

• Arial font is required for the user interface.  If it is not present on the Operating System, 
it can be installed from the original OS install disk(s) 

• 32 MB RAM with Windows 95/98, 48 MB RAM with Windows NT/Windows 2000; 128 
MB RAM or more recommended on all systems 

• Hard disk free space: 20 MB to install the GageScope® application; 60 MB for full install 
(includes Online Help facility and PDF version of User Manual).  128 MB minimum free 
space necessary for operation of the GageScope® program 

• Virtual memory under Windows NT and 2000: it is recommended that you increase the 
Swap File Size by 128 MB to operate GageScope® 

• CD-ROM drive  

• 15-inch monitor 800 x 600 (Super VGA); 17-inch 1024 x 768 Ultra VGA recommended.   
Note that your system must be set to 256 color display in order for the FFT capability to 
display results properly. 

• PC keyboard and 2-button mouse (3rd button, if present, is not used) 

• Internet Explorer 4.1 or higher; version 5.0 required for full functionality 

• The drivers for the PC-based cards must be installed. The PC-based cards are the 
CompuScope and CompuGen card(s).  You must run the Instrument Manager utility to 
configure the PC-based cards. 
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Supported Instruments 

Currently supported instruments include: 

CompuScope Cards 

 CS85G, CS82G, CS8500, CS14100, CS1450, CS12100, CS1250, CS1602, CS512/PCI, 

 CS512, CS2125 

 

 CompuGen 1100 

 

Note 

For an updated list of supported instruments, visit the GageScope® web site at 
http://www.gagescope.com 
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System Control Settings 

CompuScope Cards 
Sample Rate...................... Instrument dependent (5 GS/s to 1 kS/s) 
Capture Modes ................. Dual or single channel, if supported by your hardware 
Trigger Source .................. Ch 1, Ch 2, Ext or Pattern Triggering, if available 
Trigger Slope .................... Positive or Negative 
Trigger Level .................... User selectable 
Timeout............................. 1 ms to unlimited 
Post-trigger Depth ............ 0 to 100% of CompuScope memory 
Pre-trigger Depth .............. 0 to 100% of CompuScope memory 
Depth Units....................... Samples 
Multiple Record................ Available, if supported by your CompuScope 

CompuGen Cards 
Sample Rate...................... Instrument dependent 
Output Channels ............... Instrument dependent 
Trigger Source .................. Internal or External 
Mode................................. Triggered, Continuous, or Burst 
Source............................... AWG Channel loaded or created within GageScope 
Gain .................................. Instrument dependent 
Offset ................................ Instrument dependent 
Filter ................................ Instrument dependent 

Display Control 

Timebase........................... Instrument dependent; no less than 2 samples per division and no 
more than the entire signal in full range can be displayed. 

Display Features ............... All channels plus the Grid, X axis, Y axis, Zero Lines, and Trigger 
Line can be hidden. Colors for these elements as well as the 
background color are customizable.  

Channel Control 

Max # of Channels ........... 60 
Full Scale Input ................ ±20 mV to ±205 V, if supported by your CompuScope  
Input Coupling.................. AC or DC, if supported by your CompuScope   
Impedance ........................ 50 Ohm and 1 Mega Ohm, if supported by your CompuScope  
Vertical Scale .................... 5 mV/div to 1000 V/div, if supported by your CompuScope  
Polarization....................... Normal or inverted 
Display Methods............... Mean, MinMax or Skip Samples 
Other options .................... Connect Dots on/off, color, pen style, pen width 
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Advanced Analysis Tools 

AutoSave................................Allows unattended transient capture to disk with time and date 
stamp for record keeping 

Averaging...............................Allows averaging or co-adding of multiple acquisitions.  
Averaged or co-added data can be displayed and saved to disk 

Waveform Parameters ............Mean, RMS, Amplitude, Peak-to-peak, Period, Frequency, Fall 
Time, Rise Time, Positive Width, Negative Width, Positive 
Duty, Negative Duty, Positive Overshoot, Negative Overshoot, 
Peak, Trough, Top Value, Bottom Value, TAA Pos, TAA Neg, 
TAA, Pk-Pk Time, Pk-Tr Time, Tr-Pk Time, Tr-Tr Time, Ext-
Ext Time, Base Line, Delta Base Line   

FFT Analysis ..........................Up to 4 million point FFT 
Extended Math .......................Allows creation of sub-channels, auto- and cross-correlation, 

differentiation and integration. 

Math 

Addition, subtraction, multiplication or division of up to two channels, physical or disk-based 

Info View 

Window.............................Docking type (resizable) 
Display ..............................Any number of parameters from any channel 

Other Features 

Saving ...............................GageScope® .SIG files, AWG .EGG files, ASCII .TXT files, 
GageScope® Setup .INI files 

Loading .............................GageScope® .SIG files, AWG .EGG files, GageScope® Setup  
.INI files 

Printing..............................Any Windows 95/98, Windows NT or Windows 2000  compatible 
printer; color printing supported 
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Materials Supplied 

GageScope® CD 
GageScope® User�s Guide 

Warranty 

One year warranty on the media which contain the GageScope® program.  

All Specifications are subject to change without notice 
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 GageScope
®
 – Part A 

A Getting Started 
Follow the simple, 4-step procedure outlined below to properly install GageScope® and start 
running within minutes of opening the GageScope® software package: 
 
• Install and verify the Windows Drivers for your CompuScope or CompuGen card. 

• Install GageScope®.   

• Configure GageScope® to work with your CompuScope and CompuGen card(s) using the 
Instrument Manager utility. 

• Launch GageScope®.  

 

Note : 
The procedure outlined in this section assumes that you are installing the software using a 
CD.   
 
If you have downloaded GageScope® software off the Gage web site, please extract the 
SETUP and data files to a folder on your hard disk and run the SETUP program from that 
folder. 
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Installing the Windows Device Drivers for 
your CompuScope or CompuGen Card 

In order to operate your CompuScope or CompuGen card under GageScope®, you must install 
the appropriate Windows driver for your CompuScope or CompuGen card before launching 
GageScope®. 
 
For instance, if you have a CS8500 card and want to operate GageScope® under Windows 
NT, you must install the CompuScope Win NT Drivers in addition to installing GageScope® 
under the same operating system. 
 
Failure to install the appropriate driver will result in GageScope® not being able to 
communicate with the cards installed in your system. 
 
For complete instructions on installing the Windows Driver for your CompuScope, consult 
the Driver Installation Guide that came with the CompuScope or CompuGen hardware. 
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Installing GageScope® 

Step-by-step Installation 
1 Insert the GageScope® CD-ROM into your CD-ROM drive. 

The installation program will start automatically after a few seconds.   
 

2 If you are running a Windows 95 system that does not have the appropriate version of 
DCOM95 installed, you will be asked if you want to install DCOM95. You must select 
the installation of DCOM95. 
 
After DCOM95 has been installed, you will then have to reboot your PC and run the 
GageScope® installation program again. 
 
If you are installing GageScope® under Windows 98, Windows NT, or Windows 2000, 
the DCOM95 will not be installed as these operating systems come with all DCOM 
components required by GageScope®. 

3 If your system does not have Internet Explorer 5.0 or equivalent installed, you will be 
asked to install Internet Explorer 5.0 from Microsoft’s web site. 
 
After Internet Explorer 5 has been installed, you will then have to reboot your PC and run 
the GageScope® installation program again. 
 

4 In case the installation program does not start automatically, follow these steps to start 
the setup process: 
 
Click Start from your desktop and select Run. You will see the Run dialog box as 
follows: 
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5 Type CDROM drive letter:\GageScope\Disk1\Setup.exe in the Open text box The 
CDROM drive letter depends on the settings in your PC.  
 

 
 
Click OK. 
 

6 The installation program will begin its setup procedure. You should then see the 
Welcome screen. 
 

 
 
Click Next. 
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7 In the User Information screen, enter your Name, Company name and Serial number, 
found on the back of your CD-ROM jewel case. 
 

 
 
If you do not enter a proper Serial Number, some of the functionality of GageScope® 
may not be available to you.  
 
Now click Next. 
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8 Choose a destination location for GageScope®. 
 

 
 
It is recommended that you accept the default location of C:\Gage\GageScope, but if 
you wish to use a different location, click on the Browse button and select the 
destination of your choice. 
 
Click Next. 
 

9 Now you must select a Program Folder.  It is recommended to accept the Gage program 
folder, click Next; otherwise, type in another name and click Next. 
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10 The Start Copying Files screen gives you a final notice of what will be installed, and in 
which directory. The components being installed depend on the Edition of GageScope® 
you have purchased. The current installation shows that you are installing the 
Professional Edition of GageScope®. The settings will change if you install the Standard 
Edition of GageScope®. 
 
If you have made a mistake, click Back.  Otherwise, click Next to continue. 
 

 
 

11 The installation process will commence. You will see the installation progress indicators 
during the installation process. When the installation is successfully completed, you will 
be prompted to register online: 
 

 
 
Click Yes to register online. Then follow the onscreen instructions to complete the 
registration process.  
 
Click No to register later. For the current installation, we have opted to register later. 
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12 You will see the Setup Complete screen. 
 

 
 
The default option shown above is to restart your computer at this stage. You can restart 
your computer later by selecting the other option. 
 
Please note that GageScope® will start working only after a restart, as some components 
must be registered with the Windows operating system. 
 

13 Installation is now complete.  
 
IMPORTANT:   

• You must now proceed to Install the Windows device drivers for your 
CompuScope and CompuGen card(s), if you have not done so prior to installing 
GageScope® program.  

 
• After installing the drivers, use the Instrument Manager utility to configure these

PC-based cards. 
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Configuring CompuScope and CompuGen Cards 
with Instrument Manager 

The Instrument Manager configures one or more CompuScope and CompuGen cards in your 
system.  
 
It is very important to install the appropriate Windows drivers for your CompuScope or 
CompuGen cards before attempting to use Instrument Manager. 
 
For example, if you have a CompuScope 85G present in your PC, you must install the PCI 
drivers first before using the Instrument Manager utility.  
 
Refer to the CompuScope driver installation guide for step-by-step PCI driver installation 
procedure for the PCI-based CompuScope cards. 
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Step-by-step configuration procedure 
 
1 Launch Instrument Manager from your desktop using the following sequence of left 

mouse clicks: Start --> Explore --> Instrument Manager. 

Click Instrument Manager Icon  to launch the Instrument Manager Explorer. You 
can also get directly to this step by double-clicking on the Instrument Manager Icon on 
your computer’s desktop. 
 

 
 
In the right pane, you will find the PC-based Instruments under the Name and Type 
columns. 
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2 Click PC-based Instrumentation Icon, . The PC-based Explorer opens: 
 

 
 
Note that the right pane displays the PC-based resources currently present in the system. 
System1 comprises CompuScope card(s) while System2 consists of CompuGen card(s). 
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3 Double click on System1 to view the System1 configuration as follows: 
 

 
 
You can see that the CompuScope card, CS8500, present in the system, has 
2MegaSamples of onboard memory. 
 
The CS8500 configuration settings are saved in the Status field. The Status field is the 
last field in the right pane.  You may have to use the horizontal scroll bar to view this 
field. In case the Status field does not show Saved, click on Save configuration icon 
from the toolbar or the drop down Gage menu. 
 
Follow the same procedure for the CompuGen card to view and save the configuration 
settings for that card. 
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4 Double click on System2 to view the System2 configuration as follows: 
 

 
 
You can view the configurations settings for a single CompuGen card, CG1100, present 
in your PC. Click on Save configuration icon from the toolbar or the drop down Gage 
menu. 
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Gage Menu in the Menu bar within Instrument Manager Explorer allows users to 
configure newly installed Gage cards, set various options like adding, removing, saving 
file configurations for Gage CompuScope and CompuGen cards. Click on the Gage in 
the menu bar.The Gage menu drop down list appears: 
 

 
 
The details of each individual item in the menu are explained in Appendix A  
 
Once the CompuScope and CompuGen cards are configured properly, these need to be 
verified for proper operation. Click Verify System and Verify all Systems to make sure 
that the newly installed card(s) are verified. 
 
The description given above is a quick verification procedure in case the driver 
installation encountered no problems. You must consult Appendix A for detailed 
description of the items in the Instrument Manager utility.    
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Launching GageScope® for the First Time 

Before you run the program, connect a signal (from a signal generator or other source) to the 
Channel A input of your CompuScope card.  

Launching GageScope® 

1 A Windows shortcut icon was placed on the desktop during installation. 
Double-click this icon to run GageScope®. 
 
You can also access GageScope® through the Start menu. Click on Start, 
Programs, Gage, GageScope, GageScope. 
 

2 If your CompuScope card is configured properly, GageScope® will start. 
 

 
 
In the above example, two signals are being acquired using a CompuScope 2125. Your 
screen may differ. If you are not feeding any signals into the input channel(s), you will 
see a flat line. 
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No Instruments Detected? 
• If you do not have any instrument installed in your system, you will see the following 

message at launch: 
 

 
 
• You will be asked if you want to run GageScope® in Demo Mode.   
 

 
 
As you are not connected to a live instrument, some features are disabled. You can, however, 
load and save disk-based GageScope® files (extension .SIG, .EGG, etc). To load a file, click 
on  File > Load Channel. Sample .SIG files are located in the Signal Files folder inside the 
C:\Gage\GageScope folder. Sample .EGG files are located in the AWG Equations folder 
inside the C:\Gage\GageScope folder. 
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Default Settings 
In order to display a signal immediately upon startup, GageScope® assumes certain defaults 
when it is run for the first time.  Subsequent sessions will set the CompuScope and 
CompuGen hardware to the same settings that were in use when the previous session was 
closed. 
 
The defaults for the first session are: 

CompuScope Card Settings 
Capture Mode: Continuous 
Channel Mode: Dual (if two channels are available) 
Sample Rate: Maximum allowed by your CompuScope 
SuperRes Mode: Off 

Trigger Settings 
Trigger: Set to channel 1 
Trigger Level: 0 mV 
Timeout: 10 ms 
Slope: Positive 
Pre-trigger depth: 4096 Samples (if available) 
Post-trigger depth: 4096 Samples (if available) 

Channel Settings 
Identification: Channel A of the CompuScope is channel 1 

Channel B of the CompuScope is channel 2 
Colors: Channel 1 set to yellow, channel 2 set to green 
Input Range: All channels set to ±1V (±2V for CS1016) 
Position: Depends on the number of channels. If there are two channels, 

channel 1 is displayed in the top half of the Display Window, and 
channel 2 is displayed in the bottom half. If there is only one channel, 
it is displayed in the middle of the Display Window 

Vertical Scale: All channels set to 1 Volt per division 
Method: Min Max 
Trace: Connect Dots 
Impedance: 1 MOhm (if the CompuScope allows it) 
Probe:  X1 
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Display Settings 
Timebase: 5 us/d 
Channels Shown: All channels visible. A CompuScope channel that is not connected to 

a signal will display as a flat line 
Persistence: Off 
Grid: On 
X/Y Axis: On 
Zero Lines: On 
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Uninstalling GageScope® 

GageScope® is equipped with a special uninstall program, allowing you to uninstall all 
components at once.  To uninstall, simply follow these steps: 
 
1 In your Windows Start menu, select Settings →→→→ Control Panel. 

 
2 Double-click on Add/Remove Programs. 
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3 The Add/Remove Program Properties dialog box will appear:  
 

 
 
In the list of programs, select GageScope®.  Click Add/Remove. 
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4 The Select Components dialog will appear. 
 

 
 
You have the option to either reinstall the GageScope® program or completely remove it 
from your system.  
 
 

5 To completely uninstall all installed GageScope® components, select RemoveAll from 
the Select Components screen: 
 

 
 
 Click Next. 
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6 All components will be uninstalled as soon as you confirm by clicking OK. 
 

 
 
 

7 Once your system is no longer busy, close the Control Panel, re-open it and select 
Add/Remove Programs to verify that GageScope® and all installed components have 
been removed from the list of installed programs. 

 
 



 GageScope® - Part B 

B Tutorials 
 

About the Tutorials 
This chapter consists of seven tutorials: 

• Fundamentals ................................................... B-3 

• Working with Channels .................................... B-39 

• Triggering......................................................... B-66 

• Working with Special Modes ........................... B-98 

• Working with Subchannels............................... B-156 

• Arbitrary Waveform Generator ........................ B-164 

• Using the Graphical Waveform Editor ............. B-181 

Each section is a self-contained tutorial. If you are new to GageScope®, it is recommended 
that you do the tutorials in the order they are presented, as each section assumes you have 
gone through the previous material. 
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Tutorial 1: Fundamentals 

The GageScope® screen contains menus, a toolbar, a display area, and controls for changing 
most settings. 
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Menu Bar 
The menu bar gives you mouse access to many GageScope® features, such as opening and 
saving files. As you will soon see, most features are accessed through easy-to-use on-screen 
controls. 

Toolbar 
The Toolbar gives you one-click access to commonly used features such as opening and 
saving files, cursors, capture controls, SuperRes, trigger alignment, zoom tools, full screen 
display etc. 

 
If you wish to find out what each button does, position the mouse pointer over a button – a 
“tool tip” will appear. For more information, see the Toolbar in the Reference section of this 
manual. 

Display Window 
The Display Window displays live signals being acquired from your CompuScope card as 
well as signals you load from disk. You can also move signals and change certain settings 
directly in this window. 

Status Bar 
The Status Bar is located at the bottom left of the Display Window. It shows the status of the 
CompuScope card (triggered, waiting for a trigger, etc.), the current timebase, and the relative 
position of the trigger (M.Pos). 
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System Control 
The System Control contains options for setting the sample rate, the channel mode (single or 
dual), type and level of trigger, and trigger depth. Related settings are grouped into tabs. For 
example, settings related to the amount of data captured (pre-trigger depth, post-trigger depth, 
multiple record, etc.) are in the Depth tab. 

 

Display Control 
The Display Control contains options for changing the look of the current display, such as the 
timebase and channel visibility, along with display element properties such as grid color. 
These settings do not affect the captured data. 
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Channel Control 
The Channel Control contains options for changing the settings of individual channels, such 
as position, vertical scale, input range, and coupling. 
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InfoView Palette 
The InfoView palette is used to display various measurements being performed on the signal. 
These capabilities are normally performed through optional advanced analysis tools, which 
add extra functionality to GageScope®. 

For example, InfoView is the window used by the Waveform Parameters analysis tool, which 
performs measurements such as Mean, Amplitude, Peak-to-peak, and many others on the 
specified channel of the active display. 

Below is a sample of what the Waveform Parameters analysis tool displays. 
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About Capture Modes 

GageScope® has two capture modes: Continuous and One Shot. These modes are represented 
in the capture portion of the toolbar along with a “Stop” button, an “Abort” button and a 
“Force Trigger” button.  

 

The “pressed-in” button indicates the current mode. By default, GageScope® sets the capture 
mode to Continuous upon startup. 

Continuous Mode In Continuous Mode, GageScope® repeatedly waits for a trigger 
event, acquires and displays the data, then waits for another trigger 
event. 

One Shot Mode In One Shot Mode, GageScope® waits for a trigger event, acquires 
and displays the data, then stops. 

When you click on the One Shot button, GageScope® automatically 
disables its timeout feature. In other words, the program will wait 
forever for a trigger event to occur. This allows for unattended capture 
of both pre- and post-trigger data. 

Stop Button If you are in Continuous or One Shot Capture Mode and click on the 
Stop button, GageScope® finishes the current capture, then stops. If a 
trigger event has yet to happen, GageScope® acquires and displays the 
data that existed the moment you pressed the Stop button.  If the 
acquisition were to take more than 2 seconds to finish after you press 
Stop, a dialog box will appear with a completion bar which shows 
how much longer you have to go before the acquisition is to finish. 

Abort Button If you are in Continuous or One Shot capture mode and click on the 
Abort button, GageScope® aborts the current acquisition immediately. 
This is helpful for very long acquisitions. The data you see is that 
which existed when you clicked on Abort. 

Force Trigger Button If you want to force a trigger to occur upon manual command, you 
can click on this button. 

To see changes on screen as you make adjustments to your signal, leave GageScope® in 
Continuous Capture Mode. If you are sure of your settings and are setting up a trigger in order 
to do a one-time capture of data, use One Shot Mode. 

Triggering is discussed in more detail in Tutorial 3. 
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Capture Mode Exercise 
The following exercise will demonstrate the different capture modes and their characteristics. 
The exercises will only be useful if you have a signal connected to your CompuScope card, 
and if triggering is left to its default settings. To avoid any problems during this tutorial, do 
not change any settings other than those demonstrated in the examples. 

Set the Capture Mode to Continuous 
1 Check if GageScope® is set to continuous capture. (The Continuous button  in the 

toolbar should be “pressed in.”) 

You can also click on the Capture menu—the item that is “pressed in” indicates the 
current mode. 

  

2 As GageScope® is set to capture continuously, the signal you are seeing is “live.” 

As demonstrated in the next few pages, any adjustments you make to your signal 
generator are immediately reflected in the Display Window. 



B-10 Tutorials 

3 Reduce the amplitude of the signal on your generator.  The signal in the Display Window 
should change accordingly.  Note that channel A of the CompuScope card corresponds to 
channel 1 in GageScope®. 

 

4 Increase the amplitude of your signal back to its original setting. The signal in the 
Display Window should increase accordingly. 
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5 Change the signal to a triangle wave. 

Again, the signal in the Display Window should change immediately, as GageScope® is 
set to capture continuously. 
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Set the Capture Mode to One Shot 
1 Click on the One Shot button  in the Toolbar. You can also choose One Shot from the 

Capture menu. 

2 Once you click on One Shot, the Stop button  becomes active. 

 

This is normal. When you clicked on One Shot, GageScope® waited for a trigger event, 
acquired and displayed the data. If the trigger settings were not changed since launching 
GageScope®, the trigger event occurred immediately. 

Once the capture was done, instead of looking for a new trigger event, GageScope® 
stopped all trigger-and-capture operations. This is the reason the Stop button became 
enabled. 

3 Change the signal on your generator to a sine wave. 

As GageScope® is in Stop Mode, the signal in the Display Window does not change—
GageScope® is not looking for new trigger events, and no new captures are being 
performed. 

Keep in mind that, although the signal in the Display Window is a triangle wave, the 
signal supplied by your generator is now a sine wave. 
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4 Click on the Continuous button  in the toolbar. The Display should change to a sine 
wave as soon as you press the Continuous button, as GageScope® immediately looks for, 
then acts on, a trigger event. 

 

Again, as the trigger is set to the same channel that is being acquired, the trigger event 
and the subsequent change in the display occur immediately. 
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About Controls and Tabs 
Tabs allow you to quickly switch between the many different parameters found in each 
control. The current tab is indicated by it being “in front,” as shown below. To switch to a 
different tab, click on that tab with the left mouse button. 

 

In the System Control, you should have at least one tab with the name of your CompuScope 
card. As a CompuScope 2125 was used for this tutorial, CS2125 shows up as a tab in the 
System Control. 

Control-level tabs 
Some controls have more than one tab at the bottom of the control. For example, the Channel 
Control (at the lower right of the screen) has tabs underneath the control, one for each 
channel. 
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When making changes to channel settings, always verify that the proper channel tab is in 
front. 



B-16 Tutorials 

Channel Mode 
The Channel Mode setting defines whether the CompuScope card should operate in single or 
dual channel mode.  

• In dual channel mode, both channels A and B on your CompuScope card are available for 
input. 

• In single channel mode, only channel A is available for input. 

Note that not all CompuScope cards support this feature; the CompuScope 8500 and 
CompuScope 1016 are single channel only, for example, while the CompuScope 512 and 
CompuScope 512/PCI are dual channel only.  

Click on the tab that is farthest to the left in the System Control to see this setting. The name 
of this tab will depend on your CompuScope model. In the case of this tutorial, the tab is titled 
CS2125. 

 

Effects on Sample Rate 
The advantage of single channel over dual channel is that the maximum sample rate in single 
channel is twice that of dual channel. For example, the maximum sample rate of a 
CompuScope 2125 in dual channel mode is 125 MS/s, while in single channel mode, it is 
250 MS/s. 

You can also use the entire memory buffer of your CompuScope for one channel when you 
are in single-channel mode.  In dual-channel mode, the memory buffer is divided equally 
between the two channels. 

Changing the Channel Mode 
By default, channel mode is set to Dual. If you do not see the Channel Mode setting, your 
card does not have the ability to switch channel modes. 

To change to single channel mode, click on the Single button. 
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Change Back to Dual 
Click on the Dual button to change the channel mode back to dual. For the rest of this tutorial, 
leave this setting in Dual Channel mode. (As the CompuScope 8500 and CompuScope 1016 
support single channel mode only, you will have to stay in single channel mode.) 
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Sample Rate 

The sample rate defines how many sample points per second should be acquired by the 
CompuScope card. The available sample rates will change depending on the CompuScope 
model and the channel mode. 

 

 

It is best to set the sample rate to at least twice that of the input frequency. For example, if you 
are sampling a 1 MHz signal, you should set the sample rate to 2 MS/s or higher.   

Obviously it is preferable to have as many samples per cycle of the input frequency as 
possible.  The industry standard is to have five to ten samples per cycle.  In other words, 
sample rate should be five to eight times the input frequency to get a good representation of 
the signal on the screen. 

Effect of Channel Mode on Sample Rate 
The maximum sample rate in single channel mode is twice that of dual channel mode. For 
example, the maximum sample rate of a CompuScope 2125 in dual channel mode is 
125 MS/s, while in single channel mode, it is 250 MS/s. 

Initial Settings 
Upon startup, GageScope® sets the channel mode to dual and the sample rate to the maximum 
available. As a CompuScope 2125 was used for this tutorial, the sample rate was set to 
125 MS/s, the maximum available in dual channel mode. 
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Sample Rate Exercise 
In this short exercise you will change the sample rate to a very low value and then back to a 
high value. 

Change the Sample Rate to a Low Value (5 MS/s for example) 
1 Verify that you are in dual channel mode and that the Continuous Mode button is active. 

2 Click on the CS Tab in the System Control. In the case of this tutorial, the tab is titled 
CS2125. 

 

 

3 Click on the Sample Rate drop-down menu to see a list of sample rates. 
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4 Scroll up the list and click on 5 MS/s or similar small number. The low sample rate 
results in a signal that is not as smooth as before. 

 

When the sample rate is low, the CompuScope card is acquiring fewer sample points per 
second. In other words, the time resolution of the signal decreases. With fewer points 
available for building a representation of the signal, the resulting waveform looks jagged.

Change the Sample Rate Back to Highest Available 
1 Click on the CS Tab in the System Control. In the case of this tutorial, the tab is titled 

CS2125. 

 

 

2 Click on the Sample Rate drop-down menu to see a list of sample rates. 
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3 Scroll down to the bottom of the list. 

4 Click on 125 MS/s or similar high number. The higher sample rate results in many more 
acquisitions per second and a much smoother signal. 

 

 Note that sample rate is not linked to the timebase setting. 

This has been done to allow you to take advantage of the very deep buffer memory on your 
CompuScopes.  You can capture at a very fast sample rate and still view it with a very small 
timebase.   

All digital oscilloscopes on the market control sample rate using the timebase you select, 
because they have limited memory buffers. 
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Hiding and Showing Channels 
Hiding a channel temporarily removes the channel from the Display Window. 

Note that you can also delete channels, but only math and file channels—you cannot delete 
live signals originating from a CompuScope card.  In this exercise, we will merely hide the 
channel. The Delete Channel command is found in the Channel Context menu.  Simply click 
with the right mouse button on a channel’s zero line, and then click with the left mouse button 
on Delete. 

Hide Channel 1 
1 In the Display Control (lower middle of the screen), click on the General tab. 

2 Position the mouse pointer on the checkmark next to Ch 1 in the list.  
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3 Click to “uncheck” it. Channel 1 should disappear from view. 

 

Note that you are still in dual channel mode, as hiding a channel does not change the 
CompuScope card’s channel mode. The channel is still available, just hidden from view. 
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Unhide Channel 1 
1 Click on the empty checkbox next to Ch 1. Channel 1 reappears. 
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Using the Context Menu to Hide and Show Channel 1 
You can also hide channels directly through the Display Window. 

1 Move the mouse pointer on top of channel 1. In response, channel 1 turns white to 
indicate it has the current focus. The cursor also changes to a “move”  pointer. 

 

2 Click with the right mouse button to bring up the channel context menu. 
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3 Click with the left mouse button on Hide. Channel 1 becomes hidden. 

 

4 To bring back channel 1, right-click on an empty area of the Display Window (and not on 
a channel) to bring up the Display Window context menu.  

Notice that Ch 1 has no checkmark, indicating that it is hidden. 
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5 Left-click on Ch 1 in the context menu to bring it back. 
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Timebase 
The timebase is a display function only and does affect the data being acquired. Changes to 
the timebase affect the display of all channels in the Display Window. 

Increase the Timebase 
1 If not already visible, click on the General tab of the Display Control, located in the 

lower middle of the screen. 

Look for the word “Timebase.” By default the timebase is set to 5us/d (5 microseconds 
per division). 
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2 Click on  once to increase the timebase to 10us/d. 

 

Increasing the timebase increases the segment of time shown per division in the Display 
Window. Thus, when you increase the timebase, the signal peaks get closer together. 

Note that your signal may look a bit different from the examples presented here. 

Decrease the Timebase to 1us/d 

Use  to decrease the timebase. 

1 If not already visible, click on the General Tab of the Display Control. The timebase is 
currently set to 10us/d. 

2 Click on  once to decrease the timebase to 5us/d. 
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3 Keep clicking until the timebase reaches 1us/d.  

Your display should look something like this: 

 

Decreasing the timebase decreases the segment of time shown per division in the Display 
Window. Thus, when you decrease the timebase, the signal peaks get farther apart. 
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Change the Timebase back to 5us/d 
1 If not already visible, click on the General tab of the Display Control. The timebase 

should currently be 1us/d. 

2 Click on  repeatedly until the timebase comes back to 5us/d. 

 

 Note that sample rate is not linked to the timebase setting. 

This has been done to allow you to take advantage of the very deep buffer memory on your 
CompuScopes.  You can capture at a very fast sample rate and still view it with a very large 
timebase.   

All digital oscilloscopes on the market control sample rate using the timebase you select, 
because they have limited memory buffers. 
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The Zoom Tools 
The Zoom In tool  magnifies the area you select, allowing for closer inspection of a 
particular part of a signal. The Zoom Out tool  reduces the magnification. In the following 
example, you will zoom in on the second and third positive peaks of the sine wave signal. 

Zoom In the Second Negative Peak of the Sine Wave 
1 Click on the “zoom in” icon  in the toolbar.  

2 Press and hold down the mouse button on the second peak of the signal in the Display 
Window. A vertical line will appear where you first click. 
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3 Drag the mouse to the third peak in the Display Window. A second line will follow the 
movement of the mouse. 
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4 Let go of the mouse button. The area you selected is magnified. 

 
When magnifying a particular area, the zoom tool actually changes the timebase based on 
the width of your selection, then centers the area in the Display Window. 

In this example, GageScope® adjusted the timebase to 200 ns/d in order to magnify the 
Display Window the amount you specified. 

Note that zooming changes the horizontal scale only—it does not affect the vertical scale 
of the channels. 
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Zoom Out to 5us/d 
1 Click on the Zoom Out icon . 

2 Click the mouse somewhere in the Display Window to zoom out (increase the timebase) 
one increment. The timebase changes to 500 ns/d. 

 

3 Once you click with the Zoom Out tool, the pointer changes to an arrow again. To return 
to 5us/d, use the Zoom Out tool once more. You can also use the  button. 
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Customizing the Display 
Many Display Window elements (Grid, X Axis, Y Axis, Trigger Line, and Zero Lines) can be 
turned off using the Settings tab of the Display Control. 

Hide All Window Elements 
In the following example, you will hide all Display Window elements. 

1 Click on the Settings tab of the Display Control to bring it to the front. A Display 
element whose button is “pressed in” is visible. All Display elements are on by default. 

2 Click on the buttons Grid, X Axis, Y Axis, Trigger Level, and Zero Lines to turn each 
of these Display Window elements off.  

As you click each button, notice how the Display Window changes. In the example 
below, all elements have been turned off. 
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Show All Window Elements 
3 Click on the buttons Grid, X Axis, Y Axis, Trigger Level, and Zero Lines. As you click 

each button, the corresponding Display element reappears. 

About the Other Buttons in the Settings Tab 
The Color buttons next to Grid, X Axis and Y Axis allow you to change the color of these 
Display Window elements. The Back Color button allows you to change the background 
color of the Display Window.  
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Tutorial 2: Working with Channels 

A channel can originate from a live signal through a CompuScope card, or it can be loaded 
from disk. Most channel settings are changed through the Channel Control at the lower right 
of the screen.  
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Be sure to verify that you are making changes to the proper channel by first clicking on the 
Channel tabs at the bottom of the Channel Control. The channel tab that is “in front” is the 
channel that will be affected by your changes.  If the All tab is in front, you will be making 
changes to all current channels. 
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Input Range 
The input range is the range in Volts that GageScope® will measure when acquiring data. If 
the input range is less than the maximum magnitude of an input signal, the peaks of the signal 
will be cut off. 

 

Note: You will not be able to change this setting if you are using a CompuScope 1016, as the 
input range for this card is fixed at ±2V. 

Change the Input Range of Channel 1 to ±500mV 
1 Click on the Ch 1 tab in the Channel Control (at the bottom of the control).  

2 Click on the CS Input tab. By default the Input Range is set to ±1V. 
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3 Click on the drop-down menu and choose ±500mV (or a similar small number) from the 
list.  

 

4 As ±500mV is smaller than the peaks of the signal created by the generator (which for 
these examples is set to about 1.8 V), a significant amount of clipping is seen—the 
positive and negative peaks are cut off. 
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Change the Input Range of Channel 1 back to ±1V 
1 Click on the Input range drop-down menu and choose ±1V from the list. 
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Coupling 
You may have noticed that, in the examples shown so far, channel 2’s signal was only visible 
above its zero line. This is because GageScope® has automatically set all channels to DC 
coupling.  

To see the signal centered around zero, you can change to AC coupling. 

Note: You will not be able to change this setting if you are using a CompuScope 1016, as this 
card is DC only. Also note that only DC coupling is available when Impedance (appearing just 
below Coupling in the CS Input Tab of the Channel Control) is set to 50�. 

Change the Coupling of Channel 2 to AC 
1 Click on the Ch 2 tab in the Channel control. 

 

2 Click on the CS Input tab. By default the Coupling is set to DC. 
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3 Click the AC button. 

 

 

 Note that Input Range is not linked to the Vertical Scale setting. 

This has been done to allow you to take advantage of the high resolution offered by 
CompuScopes.  You can capture a signal with ±1V range and still view it with a vertical scale 
of 50 mV/div. 

All digital oscilloscopes on the market are limited to 8 bit resolution and can digitize the 
signal with 256 levels only.  This way, they can fit all 256 levels on screen.  CompuScopes, 
which offer up to 16 bit resolution, digitize the signal with up to 65,536 levels.  There is no 
screen in the world which can display that many pixels.  Hence, the ability to display only a 
portion of the capture signal’s dynamic range is necessary. 
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Channel Position 
You can change the position of channels by moving them directly in the Display Window or 
through the position buttons in the Channel Control. 

Move Channel 1 Down via the Display Window 
1 Position the mouse pointer on the zero line of channel 1. The signal changes to white, and 

the arrow pointer changes to a drag pointer.  
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2 Hold down the mouse button, then drag the mouse up and down. 

 

3 Before continuing to the next example, move Channel 1 to the Display Window’s X Axis 
(in the middle of the window). 

Raise Channel 1 to 1.0 div using the Position Buttons 
The Position Buttons are in the Trace tab of the Channel Control. 

1 Click on the Ch 1 tab in the Channel Control. 

2 Click on the Trace tab. 
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3 Click on  repeatedly to raise the channel’s position, until it reaches 1.0 div. 

 

Channel 1 in the Display Window moves as you click on the position buttons. 
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Vertical Scale 
The Vertical Scale setting is located in the Trace tab of the Channel Control. 

Change the Vertical Scale of Channel 1 to 5V/div 
1 Click on the Ch 1 tab in the Channel control. 

2 Click on the Trace tab.  

 

 

The Vertical Scale is currently set to 1V/d (1 Volt per division). In other words, a sample 
point that measures 1V is displayed as 1 division high, a division being one square in the 
Display Window’s grid. 
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3 Click repeatedly on  until the vertical scale is set to 5V/d.  

 



Tutorials B-51 

Reduce the Vertical Scale of Channel 1 to 100mV/div 
1 Click repeatedly on  until the vertical scale is set to 100mV/d. 

 

Scroll to See the Positive and Negative Peaks of Channel 1 
When you increased the vertical scale to 100mV/div, the signal peaks became hidden from 
view. To see the peaks, you can use the vertical scroll bar. 
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1 Click repeatedly on Scroll Up  until you see the positive peaks of channel 1. 

 

2 Alternatively, instead of clicking the up or down scroll arrow, you can drag the scroll bar 
itself to bring it to a new location. The Display Window is updated dynamically as you 
drag the scroll bar. 
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Drag the scroll bar down until you see the bottom of Channel 1. 

This feature makes your GageScope®/CompuScope combo one of the most powerful 
oscilloscopes in the world.  You are able to capture a signal with very high resolution and 
view a portion of it. 

 

Change the Vertical Scale of Channel 1 back to 1V/div 
1 Click on the Ch 1 tab in the Channel control. 

2 Click on the Trace tab. 
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3 Click repeatedly on  until the vertical scale is set to 1V/d. 

The signal may seem to disappear. 

 

The signal is outside of the visible Display Window area. You can fix this easily with the 
Arrange Channels command, as demonstrated on the following page. 
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Re-arranging Channels Automatically  
After returning the vertical scale back to 1V/div, the signals are not positioned nicely for 
viewing. An easy way to fix this is by using the Arrange Channels button, which 
automatically re-organizes visible channels in order of channel number. 

1 Click on the Arrange Channels button  in the toolbar.  

 

 Note that Input Range is not linked to the Vertical Scale setting. 

This has been done to allow you to take advantage of the high resolution offered by 
CompuScopes.  You can capture a signal with ±1V range and still view it with a vertical scale 
of 50 mV/div. 

All digital oscilloscopes on the market are limited to 8 bit resolution and can digitize the 
signal with 256 levels only.  This way, they can fit all 256 levels on screen.  CompuScopes, 
which offer up to 16 bit resolution, digitize the signal with up to 65,536 levels.  There is no 
screen in the world which can display that many pixels.  Hence, the ability to display only a 
portion of the capture signal’s dynamic range is necessary. 
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Connect Dots 
By default GageScope® draws a line between each sample point in order to display a 
continuous waveform. To have GageScope® display the acquired data as only points, you can 
toggle the Connect Dots button in the Drawing tab of the Channel Control. 

Turn off the Connect Dots Setting of Channel 1 
1 Click on the Ch 1 tab in the Channel control. 

2 Click on the Drawing tab. By default the Connect Dots button is on. 

3 Click on Connect Dots to turn it off. Instead of a single line, channel 1 is displayed as 
points. 

 

 

Turn Connect Dots Back On 
1 Click on Connect Dots once again to turn this option back on. 
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Channel Color 
The Color button changes the channel color via the standard Windows color dialog. 

Change the Color of Channel 1 to Green 
1 Click on the Ch 1 tab in the Channel Control (at the bottom of the control).  

2 Click on the Drawing tab. 

3 Click on the Color button. The standard Windows color dialog appears. 

 

4 Click on the green color that is in the third row, third column. 

5 Click the OK button. 

Change the Color of Channel 1 back to Yellow 
1 Click on the Color button in the Drawing tab of the Channel Control. 

2 Choose the yellow that is in the second row, second column. 
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Saving and Loading Channels 
GageScope® allows you to save waveforms to disk in the GageScope® SIG file format. In the 
following exercise, you will save channel 1 to the Signal Files folder of your GageScope® 
directory, then load the saved channel. 

Save Channel 1 to Disk 
1 Choose Save Channel from the File Menu, or click on Save Channel  in the toolbar. 

 

2 The “Save Channel to File” dialog appears. 

 

3 At the bottom of the dialog, next to “Channel,” GageScope® gives you the option to 
choose which channel you want to save.  In this example, Ch 1 is listed. 

If you wish, you can choose another channel to save by clicking on the Channel drop-
down menu.  Note that you can also save all visible channels at once by selecting All in 
the Channel list. 
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4 You can also specify that only the visible portion of the file be saved.  To do this, click on 
the checkbox: 

 

5 Enter the name chan1.sig in the “File name” section of the dialog box. 

6 By default, GageScope® will save your files in the Signal Files folder. This folder 
contains sample signal files. 

7 Click Save. 

Load “chan1.sig” from Disk 
1 Choose Load Channel from the File menu; or, click on Load Channel  in the 

toolbar. The Load Channel dialog appears. 

2 If you are not already in the Signal Files folder in C:\Gage\GageScope\Signal Files, 
move to the folder now. 

3 Click on the file chan1.sig. 
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4 Click Open.  

The channel you loaded should appear at the zero line of the Display Window, with a 
channel number of 3. 

 

Once a channel is loaded, you can change many of its settings just like any other channel. 
Note, however, that this channel is not “live,” in that it is not linked to any live signal source 
via a CompuScope card. 

Hide Channel 3 
1 Position the mouse pointer on the zero line of channel 3. 

2 Click with the right mouse button to bring up the channel context menu. 
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3 Choose Hide from the context menu. 

 

4 Channel 3 disappears from the display window.  While channel 3 remains in the list of 
channels in the Display Control (unchecked), it no longer appears as a tab in the Channel 
Control. 

Note 
You can also delete channels, but only math and file channels—you cannot delete live signals 
originating from a CompuScope card.  The Delete Channel command is found in the Channel 
Context menu.  Simply click with the right mouse button on a channel’s zero line, and then 
click with the left mouse button on Delete. 
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Saving and Loading Setups 
GageScope® allows you to save your current setup to so that you can load it again later.  A 
Setup file contains all of the GageScope® settings which were current at time of saving.  The 
Setup file has the extension .INI.  In the following exercise, you will save the current 
GageScope® setup, make a change to the current setup, and then load the previously saved 
setup file. 

Save the Current Setup 
1 Choose Save Setup from the File Menu. 

 

2 The Save Setup dialog appears. 

 

The default file name is GSWin32.  
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3 In the “File name” field, type in mysetup.ini. 

 

4 Go to the folder where you would like to save your Setup file. 

5 Click Save to save the Setup file. 

Make a Change to the Current Setup 
1 Click on the Ch 2 tab in the Channel control. 

 

2 Click on the CS Input tab. The Coupling should be set to AC from one of the previous 
exercises. 

3 Click the DC button. 
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4 The coupling on Ch 2 is now DC. 

 

5 Click Stop  in the Toolbar or in the Capture Menu. 

Load the Previously Saved Setup File 
1 Choose Load Setup from the File menu. 
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2 The Load Setup dialog appears. 

 

 

3 Go to the folder where you saved your Setup file and choose mysetup.ini from the list. 

 

 

4 Click Open to load the Setup file. 
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5 Click the Continuous Capture button   in the Toolbar.  Your previous settings are 
back—Channel 2’s coupling is again set to AC. 
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Tutorial 3: Triggering 

Basic Concepts 
Once GageScope® is set to Continuous or One Shot capture mode, it waits for a trigger event. 
One way for a trigger event to occur is if the voltage of an input signal crosses the trigger 
level. For example, if the trigger is set to +1V, and the signal’s peaks is only at +900 mV, a 
trigger event does not occur. But if the signal rises to +1.1V, the trigger level will have been 
crossed, invoking a trigger event and subsequent data acquisition.  

 

Once the trigger event occurs, time zero is established for the purposes of pre- and post-
trigger data. Time zero is identified in the Display Window of GageScope® by the trigger 
marker, a vertical line with a small T at the bottom.  
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Pre- and Post-trigger Data 
Pre-trigger data is the part of the signal acquired before the trigger event occurred, and is 
located to the left of the trigger marker. Post-trigger data is the part of the signal acquired 
after the trigger event occurred, and is located to the right of the trigger marker. 

Once a trigger event occurs, GageScope® will ignore any new trigger events until the desired 
amount of signal is captured. Once the acquisition is complete, GageScope® will look for a 
new trigger event or stop, depending on whether the capture mode is set to Continuous or One 
Shot. 

Trigger Events 
The detection of a trigger event is affected by a variety of settings in GageScope®. For 
example, it is possible to change the trigger slope, so that the trigger occurs on the falling 
edge of a signal, instead of the rising edge, when the trigger level is crossed.  

In the diagram below, the trigger event is occurring on the signal’s falling edge. 
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The trigger source can also originate through the external trigger connector on the 
CompuScope card, if the card is so equipped, instead of an input signal.  

The trigger event may not occur before a timeout is reached, in which case, in Continuous 
capture mode, GageScope® issues a software trigger, i.e., it triggers on its own. Or 
GageScope® will wait forever for a trigger to occur if timeout is disabled altogether. This 
useful feature allows for unattended one-shot capture. 

Trigger Defaults 
By default GageScope® sets up the trigger as follows: 

• Trigger is set to Channel 1. 
• Slope is positive. 
• Timeout is 10 ms. 
• Trigger Level is 0 mV (zero line of channel 1). 
• Pre-trigger depth is on and set to 4096 Samples. 
• Post-trigger depth is set to 4096 Samples. 

Setting up for the Examples 
In order to continue this tutorial, make sure you have at least one input signal originating from 
a signal generator connected to channel A of your CompuScope card.  For the examples used 
here, a 200 kHz sine wave signal with an amplitude of approximately 1.8V was connected to 
channel A of a CompuScope 2125. 
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Trigger Marker Align 
The Trigger Align buttons allow you to quickly position the trigger marker to the left, center, 
or right of the display window.  

 

The trigger marker indicates where the trigger occurred in the data acquisition. The data to the 
left of the “T” is pre-trigger data, and data to the right of the “T” is post-trigger data. 

By default GageScope® centers the trigger marker in the Display Window.  

Using the Trigger Align Buttons 
1 Click the Trigger Left Align button  in the toolbar to position the trigger to the left of 

the display. 

2 Click the Trigger Right Align button  in the toolbar to position the trigger to the right 
of the display. 

3 Click the Trigger Center Align button  in the toolbar to position the trigger in the 
center of the display.  

These buttons have the same effect as scrolling toward the trigger using the horizontal 
scroll bar.  
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Trigger Source 
The trigger source is located in the Trigger tab of the System Control. 

 

The trigger source options are input signals (“Ch 1” and “Ch 2,” etc.), “External,” and 
“Disabled.” By default, the trigger source is set to Ch 1 (input channel 1, which corresponds 
to channel A of the CompuScope card). Note that on the CompuScope 1016, the trigger source 
options are External or Disabled only. 

This is also indicated by the slope icon to the left of channel 1, as shown below. 
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Changing the Trigger Source 
1 Click on the Trigger tab. 

2 Choose Ch 2 from the Trigger Source drop-down list. Notice that the slope icon in the 
Display Window has moved next to channel 2. 

 

3 Click on the trigger list once more. 
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4 Click on Ch 1. The slope icon has moved back to channel 1. 
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Trigger Level 
By default the trigger level is set to 0mV (the zero line of channel 1). 

 

Change the Trigger Level by Dragging the Slope Icon 
1 Position the mouse pointer over the slope icon at the far left of the signal. 

2 Hold down the left mouse button. 
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3 Drag the mouse up or down to change the trigger level. 

 

Note that if you raise or lower the trigger level so that it is higher or lower than the signal 
peaks, trigger events will stop occurring. This is because the signal voltage is not 
reaching the trigger level in order to start a capture. 

Also note that the changes you make to the trigger level are reflected in the trigger level 
field in Trigger tab of the System Control (lower left of the screen). 
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Change the Trigger Level by Dragging the Slider 
1 Click on the Trigger tab in the System Control. 

2 Using the trigger level slider, raise the trigger level to approximately 600 mV. 

 

 

➧  Reset the Trigger Level to Zero 
1 Click on the Level button to quickly reset the trigger level to 0. 
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Trigger Slope 
The slope icon in the Display Window reflects the current trigger slope. 

  indicates positive slope, i.e. the trigger occurs on the signal’s rising edge. 
 indicates negative slope, i.e. the trigger occurs on the signal’s falling edge. 

Change the Trigger Slope 
1 Double-click on the slope icon in the Display Window to change the slope of the trigger. 

In response, the slope icon changes to a negative slope. 

 

2 Double-click on the slope icon once again to change the slope back to positive. 

The slope is also available through the Trigger tab. 
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Trigger Timeout 
The timeout setting is the amount of time GageScope® waits for a trigger event. As there is 
one timeout setting for all available triggers, timeout is located in the Depth tab. The default is 
10 ms. 

 

You can completely disable timeout by clicking on the Auto button. If you click on the One 
Shot capture button, timeout is automatically disabled. 

In the following exercise, you will disable the timeout, then prevent a trigger event from 
occurring. 

Disabling the Timeout 
1 Make sure you are in continuous mode (click on the Continuous mode button). 

2 Click on the Depth tab in the System Control. 

3 Click on the Auto button to disable it (it should now read Normal and not be “pressed 
in”). 

 

4 Click on the Trigger tab in the System Control. 

5 Make sure the Trigger is set to Ch 1. 
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6 Click on the Level button to reset the Trigger level to 0. 

7 The Status bar at the bottom left of the Display Window should state “Ready” on a green 
background.  This indicates a trigger event is occurring properly. 

 

Absence of a Trigger Event with Timeout Disabled 
1 Raise the trigger level to higher than Channel 1’s peaks. Remember you can drag the 

trigger level (the slope icon) in the Display Window.  

By moving the trigger level above the signal, you are preventing a trigger event from 
occurring. 

2 The Status bar at the bottom left of the Display Window should now state “Waiting” on a 
magenta background.  This indicates that GageScope® is waiting for a trigger event to 
occur.  

 

Since you disabled the timeout, GageScope® will wait forever for a trigger event to 
occur. 

3 Drag the trigger level back down to cause a trigger event and subsequent capture. The 
status bar should report “Ready” once more. 

➧  Setting a Timeout of 5 Seconds 
In the following exercise, you will set the timeout to five seconds, then prevent a trigger event 
from occurring. A value of five seconds is used so that you may have a bit of lead time before 
GageScope® issues a timeout.  

1 Make sure you are in Continuous mode and that the trigger is set to channel 1. 

2 Click on the Depth tab in the System Control. 

3 Click on the Timeout button to enable it (it should be pressed in). 

4 Click in the Timeout field. 

5 Press Backspace or Delete to erase what’s in the field. 
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6 Type in 5 s and press Enter.  Be sure to use a lowercase ‘s.’ 

The letter ‘s’ stands for “seconds.” Other abbreviations, such as ms for milliseconds, and 
us for microseconds, are also valid units. 

Five seconds is an extremely long time for data acquisition purposes, and in this case is 
used only for demonstration. 

7 Click on the Trigger tab in the System Control. 

8 Click on the Level button to reset the Trigger level. 

9 The Status bar at the bottom left of the Display Window should state “Ready” on a green 
background.  This means a trigger is occurring properly. 

 

Absence of a Trigger Event with a Timeout of 5 Seconds 
1 Raise the trigger level so that it is higher than Channel 1’s positive peaks. 

2 The Status bar at the bottom left of the Display Window now states “Waiting” with a 
magenta background.  

 

This indicates that GageScope® is waiting for a trigger event.  

3 If you watch closely, a “Ready” message with a yellow background should appear in the 
status bar every 5 seconds. 

 

4 Once a timeout is issued, GageScope® issues a software trigger (it triggers on its own) 
and performs a capture. It then re-arms the card for another trigger event—the status bar 
states “Waiting” again. Note that this is only true for continuous mode. 
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Change to One Shot Mode 
1 Click on the One Shot icon.  You may very briefly see “Stop” on the status bar with a 

blue background. 

 

Thereafter, the status bar should report “Waiting” with a magenta background.  

 

When you change to One Shot mode, GageScope® automatically disables the timeout. 
With timeout disabled, GageScope® will wait forever until a trigger event occurs (or until 
you press the Stop button). This allows for unattended one-shot capture. 



Tutorials B-81 

A Trigger Event Exercise 
In the following exercise, you will use your signal generator to create a trigger event. The data 
will be captured by GageScope® in One Shot mode. 

If you have a signal generator that has a “one shot” button, you can use it to create the trigger 
event. If your generator does not have a “one shot” button, instructions are provided for 
simulating a trigger by removing and reconnecting the cables attached to your generator. 

1 Click on the Trigger Center Align button. 

2 Reset the trigger level to 0 (click the Level button in the Trigger tab). 

3 Switch to Continuous mode. 

4 • If your generator does not have a “one shot” button, unplug the cable from the signal 
generator that is connected to Channel A of the CompuScope card. Your sine wave 
should turn to a flat line. 

5 Raise the trigger level of channel 1 to above channel 1’s zero line. 

6 Set up a one shot capture by clicking on the One Shot button in the toolbar. Timeout will 
automatically be disabled, and the Status Bar should state “Waiting.” 

7 • If your generator has a “one shot” button, press it now. 
• Otherwise, plug the cable back into the signal generator as cleanly and quickly as 

possible. 
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8 The resulting pre-trigger signal should amount to a mostly flat line with some activity 
near the Trigger Marker.  

The post-trigger signal should show an uneven signal turning into a sine wave soon after 
the signal passed the trigger marker. 

 

Notice how the post-trigger data did not begin until the signal measured at least as high 
as the trigger level. When the signal reached the point of the trigger level, the trigger 
event occurred and the capture began. 
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Introduction to Trigger Depths 
Click on the Depth tab in the System Control to see the trigger depth settings. 

 

By default both pre- and post-trigger depth are set to 4096 samples. The trigger depths are 
limited by the amount of memory on-board your CompuScope card. 

You can turn off pre-trigger acquisition by clicking on the Pre Trig button. 

About Trigger Depth Units 
Trigger depths are shown in number of samples (or points). This is displayed in the Units 
value in the Depth tab.  This field cannot be changed. 
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About the Trigger Total 
The Total field reports the total amount of data that can be stored in the on-board memory of 
the CompuScope card. The total is shown in samples. 

 

About Increment Buttons 
The Increment Up  and Increment Down  buttons are located to the right of the pre- 
and post-trigger fields and are used to make changes to these settings.  
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About Fine Mode 
Fine Mode is enabled by default. 

 
When Fine Mode is enabled, the increment buttons increase or decrease pre- and post-trigger 
data settings by 64 sample points. When Fine Mode is disabled, the changes are made in 
increments of 640 sample points. 
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Creating Multiple Independent Trigger Sources 

About Windowed Triggering 
Certain CompuScope cards support “Windowed Triggering,” meaning that you can set two 
independent trigger conditions which are OR’ed together.  Windowed triggering allows you 
to: 

• Set two different triggers on the same channel  
 

 
 
• Or set one trigger condition on each input of a CompuScope 

 

 
 

These triggers are set via the Pattern setting in the Trigger tab of the System Control. 
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The Trigger Pattern dialog allows configuration of multiple independent triggers.  Trigger 
source, slope and level can be modified, and trigger sources may be added and removed.  
Multiple triggers are not available for all CompuScope models. 

Open the Advanced Trigger Configuration Dialog 
1 Click on the Trigger tab of the System Control if it is not already in front. 

 

 
2 Click on the Pattern button. 
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3 This brings up the Advanced Trigger Configuration dialog, listing all of the currently 
specified trigger sources.  Currently only the default trigger source is listed. 

 

Create Two Different Trigger Sources on Channel 1 
1 In the Advanced Trigger Configuration dialog, click Add. 

 
2 This brings up the Trigger Source dialog with a blank Source field. 
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3 Click on the Source drop-down list to select Ch 1.  

 
• Note that on CompuScope 1016, the trigger source can be External only. 

• Note also that if you have a Multi-Card system installed, you will see one trigger 
source for each channel available in your system.  For example, for a three-card 
CS8012A system, there will be six input channel trigger sources available (since 
each CS8012A has two input channels).  If you do not see the right number of trigger 
sources, go to Preferences in the Tools menu.  Make sure the Independent Trigger 
item is checked. 

4 To change the Trigger Level, use the increment/decrement buttons to set a percentage of 
the current input range of the selected trigger source.   

For instance, since our Trigger Source is set to Ch 1, and the current input range for Ch 1 
is ±1V, if we select 50%, the trigger level will be set to +500 mV.  If we select -10%, the 
trigger level will be set to -100 mV.  The maximum positive setting is 100%  and the 
maximum negative setting is -100%. 

Set the Trigger Level to about -40%, or about -400 mV.  You can click and hold the 
Down Increment button until it reaches the desired level. 

 
5 Click OK to accept the new trigger source. 
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6 We will now modify our initial trigger source. 

Click on the first item in the list to highlight it and then click Modify. 

 
7 Change the trigger level from its current value, 0.00 mV, to +40%, equivalent to about 

+400 mV. 

 
Click OK when finished. 

8 Now click Apply in the Advanced Trigger Configuration dialog to apply the changes.  
Your changes will be updated in the Display Window. 
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9 You will now see the signals in the Display Window moving somewhat jerkily to the left 
and right.  This is because the signals are being triggered off the first trigger source and 
then the second, as the trigger level is constantly shifting from +400 mV to -400 mV. 

 

Create a Trigger Source on each Input Channel 
1 We have just created two trigger conditions on Ch 1.  We will now create one trigger 

condition on Ch 1 and one on Ch 2. 

Click the Configure Pattern button in the Trigger tab. 
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2 The Advanced Trigger Configuration dialog appears displaying our two trigger sources 
set to Ch 1. 

Select the item in the list with the positive trigger level to highlight it, and click Modify. 

 
3 Change the Trigger Source to Ch 2 by clicking the Source drop-down menu. 

 
Click OK to accept the changes. 

4 Click Apply to exit the Advanced Trigger Configuration dialog. 
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5 Note first that the second trigger has moved down to Channel 2.  The signals are again 
moving jerkily to the left and right, this time because they are repeatedly triggering off 
Ch 1 and then Ch 2. 

 

Remove the Second Trigger Source 
1 Click the Configure Pattern button in the Trigger tab. 
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2 In the Advanced Trigger Configuration Dialog, highlight the Ch 2 trigger source and 
click Remove. 

 
3 The trigger source will disappear from the list. 

 

Change the Trigger Level Back to 0 mV 
1 Click on the remaining trigger source and click Modify. 
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2 Click the Level button to change the trigger level back to 0 mV. 

 
Click OK to accept the change. 

3 Click Apply to exit the Advanced Trigger Configuration dialog.  Our display shows that 
we are triggering off Ch 1 at 0 mV. 
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Exit the Trigger Pattern Configuration 
1 To return to the regular Trigger Tab, click on the Pattern button so that it is no longer 

pressed in. 

 

Notes 
If you have already created two independent triggers and you attempt to add a third, you 
will not be able to select a Trigger Source—the drop-down menu will be blank.  On 
CompuScope cards that support multiple independent triggers, you cannot set more than 
two trigger sources. 
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Triggering Summary 

• System triggers are set in the Trigger Tab of the System Control as well as in the Pattern 
dialog. Not all CompuScope cards support multiple triggers. 

• The Trigger Align buttons can be used to automatically center, left-align or right-align 
the trigger marker. 

• A trigger is selected in the Trigger Tab of the System Control or in the Pattern dialog. 
Triggers can be set to channel 1, channel 2, or external, and can also be disabled. 

• The trigger level can be changed by dragging the trigger level line in the Display 
Window, or by dragging the trigger level slider in the Trigger tab of the System Control. 

• Trigger slope can be changed by double-clicking the trigger slope icon in the Display 
Window, or by right-clicking to bring up the Slope context menu and then left-clicking on 
the desired slope. 

• Trigger timeout is set in the Depth Tab of the System Control. You can disable the 
timeout by clicking Auto so that it reads Normal and is not “pressed in.” When a timeout 
is reached, GageScope® issues a software trigger, i.e., it triggers at the moment of 
timeout.  

• Timeout is automatically disabled when you click on the One Shot button. It is 
automatically re-enabled when you click on the Continuous button. 

• The amount of captured data is set in the Depth tab of the System Control. The unit of 
measurement can be set in samples, percent of on-board memory, and time. The Total 
field reflects the total amount of data that can be stored in the on-board memory of the 
CompuScope card. 

• Both pre- and post-trigger depths are set to 4096 by default. 

• When the Fine button (Depth tab) is enabled, pre- and post-trigger depths are increased 
or decreased in increments of 64 sample points. With Fine Mode disabled, the changes 
are made in increments of 640 sample points. 
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Tutorial 4: Working with Special Modes 

This tutorial deals with three special modes available in GageScope®: 

• Persistence Mode — page B-99 
• SuperRes Mode — page B-108 
• Multiple Record Mode — page B-114 
• Scope Mode — page B-131 
• Decimation Mode — page B-140 
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Persistence Mode 
The Persistence setting allows the user to control the persistence of the signal display in the 
Display Window.  By default, the signal does not persist in the Display Window.  However, 
with the special Persistence Controls in GageScope®, you can specify any degree of 
persistence that you wish, from none to infinite. 

The Persistence button is located in the Settings tab of the Display Control. 

 

 

Set Persistence to Infinite 
1 Make sure you are in Continuous Capture mode (the   button in the Toolbar should 

be “pressed in.”) 

2 By default, Persistence is disabled.  The button underneath Persistence reads None.  To 
enable persistence, click on None. 
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3 The Persistence field appears. 

 

4 Click on the Infinite checkbox for infinite persistence.  This is equivalent to clicking the 
Overdraw Mode button in the toolbar. 
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5 Our signals are now persisting on the screen.  You may notice the signals getting slightly 
thicker.  

 

However, to truly see Persistence at work, we will change some settings that will affect 
the signal display. 

Change the Timebase to 1 us/d 
1 Click on the General tab of the Display Control to access the Timebase buttons. 
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2 Click on   once to change the timebase to 2us/d.  Watch how your signal display 
changes—the old signal persists while the new signal is being displayed. 

 

3 Click on  again so that the timebase becomes 1us/d.  The new signal will be 
displayed along with the previous two signals. 
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Erase the Display 
1 An Erase Display button becomes available in the toolbar when Persistence mode is 

turned on. 

2 Click on   to clear the previous signals.  The latest signal with a timebase of 1us/d is 
the only one in the Display Window now. 
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Set Persistence to 5 seconds 
1 Click on the Settings tab of the Display Control so that it is again in front. 

 

2 Turn off Infinite Persistence by clicking on the checkmark next to Infinite. 

 

3 Turning off Infinite Persistence turns off Persistence altogether.  To enable Persistence 
again, click on None. 
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4 To change the length of time that the signal will persist on the screen, you can click on 
the Increment Up  and Increment Down  buttons. 

 

5 Click and hold the  button until the Persistence is set to 5.0s. 

 

6 Now our signals will persist, but only for 5 seconds.  To test this, we will again go to the 
General tab of the Display Control. 
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7 Change the Timebase to 2us/d by clicking . 

 

8 You will notice that the old signal briefly persists on the screen.  
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9 The display is erased after a short time, so that only the latest signal is preserved. 

 

Setting the Persistence to 5 seconds has the same effect as clicking the Erase Display 
button every 5 seconds. 

Turn Persistence Off 
1 To disable Persistence Mode, go back to the Settings tab of the Display Control.  Click 

on the Persistence field so that it reads None. 

 

2 To get ready for the next part of the tutorial, change the Timebase back to 5 us/d (click 
on  in the General tab of the Display Control). 
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SuperRes Mode 
SuperRes Mode allows an averaging window to be defined within a single acquisition.  All 
samples within the averaging window are accumulated, resulting in an effective increase in 
the sample bits. The averaging window is then shifted, over the current acquisition, by its 
width and the same averaging process is performed repeatedly. 

SuperRes allows you to specify the desired “Effective Resolution.”  For example, you can 
specify 12 bit resolution even if you are using the 8 bit CompuScope 8500.  GageScope® will 
automatically perform digital filtering (averaging of oversampled data) to enhance the 
effective resolution at the expense of sample rate. 

For example, in order to provide 12 bits for the CompuScope 8500 (an increase of 4 bits), 
GageScope® has to average 24 = 16 adjacent points, hence reducing the sample rate by a 
factor of 16.  This means that instead of 500 MS/s, the sample rate will be 500/16 = 31.25 
MS/s. 

Note 
• The effective resolution mentioned here is not the same as Effective Number of Bits 

(ENOB). ENOB is a measurement of the Signal-to-Noise Ratio. 

 

SuperRes is located in the CS tab of the System Control. 

 

Enable SuperRes Mode 
1 Make sure you are in Continuous Capture mode (the   button in the Toolbar should 

be “pressed in”). 
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2 Click on the CS tab of the System Control to bring it to the front. 

 

3 Click on the SuperRes checkbox to enable SuperRes mode. 

 

You can also click the SuperRes button in the toolbar (it should be “pressed in”). 

4 Notice that SuperRes appears in the upper left of the Display Window, next to the 
sample rate. 
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Increase the Bit Resolution by 6 or 7 Bits 
1 We will now increase the Bit Resolution of the signal displayed on the screen.   

• 8 bit CompuScope cards: Increase the bit resolution to 15 bits 

• 12 bit CompuScope cards: Increase the bit resolution to 18 bits 

To increase the bit resolution, click on the Up Increment button  on the CS tab of the 
System control.  

 

You can also click on the SuperRes drop-down menu in the toolbar. 

2 Note that when you increase the bit resolution, the sample rate decreases.  For instance, 
we have raised the bit resolution on our CS2125 to 15 bits and our sample rate has 
decreased to 977 kS/s from 125 MS/s.  You will not be able to increase the sample rate 
until you decrease the bit resolution again. 
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3 With such a comparatively low sample rate, our signal display becomes jagged. 

 

When the sample rate is low, the CompuScope card is acquiring fewer sample points per 
second.  With fewer points available for building a representation of the signal, the 
resulting waveform looks jagged. Keep in mind that this illustration uses a slow capture 
rate. The true power of SuperRes is more evident with a faster sampling rate; while the 
waveform remains mostly unchanged, the signal to noise ratio improves dramatically 
thanks to the increased resolution of the acquisition. 

Decrease the Bit Resolution by 2 Bits 
1 Decrease the bit resolution by two bits by clicking the Down Increment button .  
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2 Notice that GageScope® automatically raises the sample rate to the maximum rate 
corresponding to the selected bit resolution—in our case, the sample rate rose to 3.91 
MS/s when we decreased the bit resolution to 13 bits. 

 

The signal looks less jagged than before, since more samples are being acquired per 
second. 

Disable SuperRes Mode 
1 To disable SuperRes mode, click on the SuperRes checkbox in the CS Input Tab (so that 

it is unchecked), or click on  in the toolbar (so that it is not pressed in). 
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2 The bit resolution has been returned to normal, and the sample rate is now at its 
maximum value for dual channel mode. 
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Multiple Record Mode 
Multiple Record Mode takes advantage of the CompuScope card’s deep memory buffers by 
allowing the hardware to stack captures in on-board memory, so that many small acquisitions 
can occur in a very short amount of time, with near-zero re-arm time. This feature is 
invaluable in applications in which trigger events are happening rapidly or unpredictably and 
A/D down-time must be minimized. 

When Multiple Record Mode is enabled, the CompuScope card looks for a trigger event, 
acquires post-trigger data, then automatically re-arms itself to look for another trigger event. 
Data collected from each successive acquisition is "stacked" on top of the previous acquisition 
until the on-board buffer fills up.  

For example, if a post-trigger depth of 1024 points is specified, the first acquisition stores data 
in addresses between 0 and 1023, the next acquisition from 1024 to 2047, and so on until the 
buffer is full.  

Important Notes 
• The number of records you can capture will depend on the amount of on-board memory 

your CompuScope card has, as well as other settings, such as the post-trigger depth and 
channel mode. 

• With all currently available CompuScope cards, you can only capture post-trigger data in 
Multiple Record mode. When you click on the MulRec button, pre-trigger capture is 
disabled.  

• Multiple Record Mode comes as a standard feature or as an option on most CompuScope 
cards, but is not available on the CompuScope LITE. If your CompuScope card does not 
have this capability, the MulRec button will not be available. 

 

The Multiple Record setting is located in the Depth tab of the System Control. 
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Perform a Multiple Record Capture 
1 Make sure you are in Continuous Capture mode (the   button in the Toolbar should 

be “pressed in”). 

2 Click on the Depth tab of the System Control to access the Multiple Record controls. 

 

 

3 Click on the MulRec button to enable Multiple Record Mode. Multiple Record Mode is 
enabled if its button is pressed in. 
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4 GageScope® automatically captures the post-trigger data for as many records as possible, 
depending on the current channel mode, sample rate, and post-trigger depth settings.  

 

The number of records will be reflected in the Display Window underneath the channel 
number at the left. For example, if 31 records are captured as in our example, you will 
see “1 of 31” displayed underneath “Ch 1.” 

5 While you are performing a Multiple Record acquisition, you may briefly see the 
message “Transferring” in the Status bar. 

 

This means that GageScope® is transferring data from the CompuScope board to the 
internal buffers of the application. 

Scroll Through the Multiple Record Data via the Toolbar 
1 To see more of your Multiple Record data, click the Trigger Left Align button in the 

toolbar. 
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2 You should now be able to see the entire record. 

 

3 Use the Go to Next Record button in the toolbar to scroll through your records one by 
one.   
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4 Beside Ch 1 and Ch 2 in the Display Window, you can watch the record counters 
increase by one with each click. 

 

5 Click the Go to Previous Record button in the toolbar to scroll backward through your 
records until you get back to Record 1. 

 

Scroll Through the Multiple Record Data via the Record Counter 
1 Select the Trace tab in the Channel Control if it is not already in front. 
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2 Use the  and    buttons to perform the same function as the Go to Next Record 
and Go to Previous Record buttons on the Toolbar. 

 

3 With these buttons, you can cycle through the records of all channels at once (if the All 
Channels Tab is current), or through the records of individual channels (if an individual 
channel tab is current).   

Click on the Ch 1 tab of the Channel Control. 

 

4 Use the Record Counter to go to Record 10 of Channel 1. 
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5 Now you are viewing Record 10 of Ch 1, while Ch 2 is still displaying Record 1. 

 

Set all Records to Record 1 via the Toolbar 
1 Set all channels to the first record with the  button in the toolbar. 

 

Save Channel 1 to Individual Files 
1 You can save a Multiple Record channel just as you would any other channel.  However, 

there are a few options available for saving Multiple Record files which are not available 
with normal acquisitions.  In this section, we will be saving each record in the acquisition 
to a separate file in one step. 

Click Save Channel   in the toolbar. 
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2 The Save Channel dialog appears. 

 

3 In the File Name field, type mulrec.sig. 
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4 Ch 1 should already be selected in the Channel field.  If it is not, select it from the drop-
down menu. 

 

5 To save each record in the acquisition to a separate file, check the Split MulRec 
checkbox. 

 

6 Click Save. 

➧  Load one of the Saved Records to Ch 3 
1 You can also load a Multiple Record channel as you would any other channel—by 

clicking  on the toolbar.  
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2 The Load Channel dialog appears. 

 

Notice that since we selected Split MulRec when saving our Multiple Record 
acquisition, and in our example there were 31 records in the acquisition, we now have 31 
files named “mulrecxx.sig,” where xx is a suffix attached by GageScope®, beginning at 
00. 

3 Click on the first of these files to select it, and then click Open. 
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4 Our signal file has been loaded as Ch 3, in between Ch 1 and Ch 2. 

 

5 Hide Ch 3 by clicking the checkmark next to it in the Channel List (in the General tab of 
the Display Control). 
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Look at All Records of Channel 1 Simultaneously 
1 Up to now, we have been viewing one record at a time.  GageScope® also allows you to 

view all records at once.  

Click on the Ch 1 tab of the Channel Control to bring it to the front again. 

 

2 Click with the left mouse button in the Record field and press the Backspace to erase the 
value that’s there.  Then type 0 (zero). 

 

3 Press Enter.  The 0 will change to All. 

 



B-126 Tutorials 

4 The display will now show all of your records at once.  To the left of the slope icon and 
below “Ch1” on the screen below, notice the message “All of 31,” indicating that all 31 
records are being displayed. 

 

Beneath the start of each record in the signal, its record number is displayed. 

Note that you are still seeing only one record of Ch 2.  If you wish to see all records of 
both channels, you can click the All tab in the Channel Control and type 0 in the Record 
Counter, followed by Enter. 

5 Increase the timebase by clicking on  in the General tab of the Display Control. 
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6 This allows you to see more records. 

 

➧  Save All Channel 1 Records to One File 
1 Now that we are viewing all of Channel 1’s records at once, we can also save all of the 

records to one file.  This is only possible when All is displayed in the Record Counter for 
the channel you wish to save. 

2 Click Save Channel   in the toolbar. 
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3 The Save Channel dialog appears. 

 

4 In the File Name field, type allrec.sig. 
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5 Ch 1 should already be selected in the Channel field.  If it is not, select it from the drop-
down menu. 

 

6 Click Save. 

➧  Load the All Records File to Ch 4 
1 Click  on the toolbar.  

2 The Load Channel dialog appears. 
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3 Along with our multiple mulrecxx.sig records, there is also an allrec.sig file.  Click on 
allrec.sig to select it, and then click Open. 

 

4 Our signal file containing all of 31 records has been loaded as Ch 4, in between Ch 1 and 
Ch 2. 

 

Note 
You can also save only the visible portion of the channel by checking the box at the bottom 
of the Save Dialog (just as you can with a non-Multiple Record acquisition). 
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Scope Mode 

The automatic sample rate and input range selection feature allows GageScope® to be setup 
like a conventional digital oscilloscope. When the Scope Mode icon is pressed in or the Scope 
Mode check box in Preferences dialog box is checked, GageScope® is said to be in the Scope 
Mode. In Scope  Mode, GageScope® automatically selects the signal input range in 
accordance with the selected vertical scale in Volts/division. The sample rate for the input 
signal is also automatically selected and is linked to GageScope’s timebase in 
seconds/division. 

How it works 

Automatic Input Range selection 
 

1 The figure below shows a 1 MHz sine wave being captured on Channel 1 of the 
CompuScope 8500 high speed A/D card.  

 

 

2 The input signal amplitude is close to one volt. This signal has been clipped since the 
input voltage range setting is intentionally selected to be ±200mV. This is shown in the 
Channel Control setting for Channel 1 as follows: 
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3 The display setting for channel 1 is set to be one volt per division. This can be viewed 
by clicking the Trace tab for channel 1 in the channel control which is located in the 
bottom right of the GageScope® display. The Trace tab property page is shown as 
follows: 

 

 Note that GageScope® is not operating in the Scope Mode as yet. 

4 Click on the Automatic Sample Rate and Input Selection Rate Icon. You will notice 
that the Scope Mode appears on the display underneath the 500MS/s sample rate text. 
This implies that the input mode of CompuScope is now the Scope Mode. As a result 
the GageScope® display will automatically select the input range of the input signal 
according to the currently selected vertical display range (1V/div). You will see the 
changes in display as follows: 
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Note that the input signal now no longer appears clipped. The input voltage range is 
automatically adjusted to correspond to the currently selected vertical display range 
(1V/div), resulting in displaying the original 1 MHz sine wave.  

5 As a result of the CompuScope 8500 being in the Scope Mode, the Range setting under 
CS Input tab in the Channel control has been changed from ±200mV to ±1V. Note that 
the Range text box is disabled so it appears dimmed out. This is done to ensure that the 
user is unable to change the range while the Scope Mode is active. 

 

The Sample Rate Option under CS8500 tab in the System Control is also disabled. The 
CS8500 tab is located in the System Control area in the left bottom corner of the 
GageScope® display. 
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6 The Scope Mode can also be activated or deactivated by selecting Scope Mode in the 
Preferences dialog box.   

Click Tools in the menu bar. The drop down menu appears: 

  

7 Click Preferences to view the Preferences dialog box: 
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The Check mark besides Scope Mode shows that the Scope Mode is currently active. 
When the Scope Mode is activated by clicking the Scope Mode Icon in the GageScope® 
toolbar, a check mark is simultaneously placed in front of the Scope Mode in the 
Preferences dialog box, signifying that the Scope Mode is active. 

8 Deselect the Scope Mode by clicking inside the check box. The check mark disappears. 
Click Apply. You will see the following: 
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Note that Scope Mode text is now taken off the display indicating that the Scope Mode 
is no longer active. 

Also note that the Range setting is not reverted to the original value of ±200mV and the 
Sample Rate and Range text box controls have been enabled.  
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Automatic Sample Rate selection 
 

1 A 1 MHz sine wave being captured on Channel 1 of the CompuScope 8500 high speed 
A/D card is shown below: 

 
 
For the signal shown above, the post trigger depth is set to 4096 samples and the input 
range is ±200 mV. The timebase setting is set to 1 us/d (microsecond per division). 

2 Launch the Scope Mode by clicking on the Scope Mode Icon in the toolbar. You can 
also put a check mark in the Scope Mode check box in the Preferences dialog box as 
explained in the previous section. The text Scope Mode appears on the left side of the 
display, as shown below: 
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3 Change the timebase to 2 us/d by clicking once on the time base compression button, 
 . The GageScope® display will appear as follows:  

 

Note that the sample rate has changed to from 500 MS/s to 250 MS/s. GageScope® 
automatically adjusted the sample rate to account for this change in the timebase setting 
from 1 us/d to 2 us/d. The input range was also changed from ±200mV to ±1V. 

4 Click on the Scope Mode Icon  to deactivate it. You can also check off the Scope 
d i i h f di l b l i d i h i i
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Mode setting in the Preferences dialog box as explained in the previous section. 
GageScope® will no longer be in the Scope Mode as shown below: 
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Decimation Mode 

Decimation is a feature by virtue of which a user can view large amounts of data within 
GageScope. The user must first specify the amount of RAM needed for viewing desired 
amount of data. The amount of data needed per channel is specified in megabytes in the Deep 
Memory (DM) Buffer setting in the Preferences dialog box.  

The size of the deep memory buffer is part of the actual physical RAM present in your 
system. The DM Buffer size must be between 8-64 megabytes.  Care must be exercised in 
specifying a value for the DM buffer size.   

The Decimation Mode is enabled when the size of acquisition per channel is more than 1/4th 
the size of the DM buffer size. Let us assume that you have allocated 8 MB for the Deep 
Memory buffer. In this case, the Decimation Mode will be automatically activated whenever 
you specify more than 2 MB of total acquisition length in GageScope. The total acquisition 
length is the sum of the pre and post trigger data size. The Decimation command button will 
then be enabled, signifying that the Decimation mode is currently active.  

When working in Decimation mode, the user can select the starting sample and the number of 
samples to be downloaded from CompuScope acquisition memory.  Only these data are then 
decimated and displayed. 

Decimation functionality has also been incorporated in the Multiple Record mode. When 
working in Multiple Record mode, the user may now select the starting record and the number 
of records to be downloaded from CompuScope acquisition memory.  Only these data are then 
decimated and displayed. 

GageScope® uses skip samples, mean, and min max methods of decimating the data. The 
details of these methods and other decimation features are given in the following example:  
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How it Works 
1 Open the Preferences dialog box by clicking on Tools --> Preferences. The Preferences 

dialog box will appear as follows: 

 

The Deep Memory Buffer size is set at 16 MB as shown in the DM text box. The 
maximum DM buffer size can be 64 MB. 

Click Apply 
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2 Shown below is a 1 MHz sine wave captured by a CompuScope card and displayed as 
Channel 1.  

 

The acquisition post trigger depth is set at 1 Mega Samples (1 MS) as shown in the Post 
Trig text box in the System Control: 

 

Note the total memory available for signal acquisition is 1 Giga Samples (1 G Smpl) as 
shown in the Total text box. 
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3 Let us now have a look at the Channel 1 property page, which is located in the right 
bottom corner of GageScope® screen: 

 

Observe that the Decimation command button is shown disabled implying that the 
Decimation mode is not currently invoked. 

For the settings we have chosen for this acquisition, the criterion for the Decimation 
mode to be invoked is as follows:  
 
GageScope® will decimate the input data whenever the acquisition length per channel 
(pre and post trigger) exceeds 4 MB.  

Note that the 4 MB is one quarter of the DM Max. Buffer Size of 16 MB. The 
Decimation Mode is enabled whenever the size of acquisition per channel is more than 
1/4th the size of the DM buffer size. Since the acquisition depth is currently set to 1 MB 
for Channel 1, the decimation Mode is not invoked.  
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4 Change the total acquisition depth for Channel 1 to 8 MB. As soon as you change the 
total signal acquisition depth and click anywhere within the display, GageScope® will 
start decimating the input data and display it on Channel 1 as follows: 

 
 
Note that the data on channel 1 is now being decimated. By default, a user gets to view 
the best representation of the input data.   
 
One of the three methods is employed for decimating the input data: Skip Sample, Mean, 
or Min Max.  A method of your choice can be selected from within the Decimation 
dialog box. The decimation dialog box opens up whenever the Decimation command 
button is clicked. Make sure that the Decimation button is enabled before you click on it. 
 
There are several other useful features available within the decimation dialog box.  A 
detailed descriptions of these features and their use is given as follows: 
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5 Click on the CS Input tab of Channel 1 control.  The property page appears as follows: 

 

Note that the Decimation command button is shown enabled. 

6 Click on Decimation button. The Decimation dialog box opens as shown below: 
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7 The Decimation dialog box options are as follows: 
 

Source Shows the channel number being decimated and the 
name of the CompuScope card. It can also be the name 
of the file, if the signal is loaded from a file. 
 

Start The starting sample of the data to be displayed. Note 
that the current range of data values spans from the 
Minimum Sample value of zero to the Maximum 
Sample value of 8388592. These are the values in the 
corresponding row as shown in the Min and Max 
columns on the right side of the text box. 
 
Min isthe minimum number that a user can select for 
the corresponding feature. For example the Minimum 
Factor a user can select is 2 as shown in the 
Decimation dialog box. 
 
Max is the maximum number that a user can select for 
the corresponding feature.  For the current setup, 
524287 is the Maximum Factor a user can select. 
 
The user can select any number from within this range. 
Since the maximum size of the signal to be displayed 
in the Decimation Mode is 16, the Maximum Start 
Sample Number (Max.) is set to be signal 
acquisition depth minus 16.   
 

Size The total number of samples to be displayed.   
 
The number in the size text box refers to the total 
length of the signal to be displayed.  
 
Note that no less than 16 samples can be displayed 
on the decimated channel.  The maximum number is 
the acquisition depth per channel specified in the Pre 
and Post Trig text boxes in the System Control. In our 
case the total acquisition depth is 8 MB, which turns 
out to be 8388608 as shown in the corresponding 
column.  
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 Start Record The number of the starting record to be displayed in a 
Multiple Record acquisition. Presently, there is only 
one single record being captured. When the Multiple 
Record Mode is invoked, you will see the Min and 
Max numbers in the corresponding columns. 
 

Records The total number of records to be displayed in the 
Multiple Record Mode. 
 
The Maximum number of records equals the  total 
CompuScope memory available for acquisition divided 
by the acquisition depth per channel. 
 
The minimum number of records to be displayed is 
obviously one. 
 

Factor This is the Compression Ratio. Compression ratio can 
be chosen from the available range of minimum and 
Maximum values.  
 
Decimation is a process of compressing the data so that 
it can be displayed in GageScope. 
 
Note that the best compression ratio corresponds to 
maximum number in the corresponding row in Max 
column. In the present example, you can see that the 
factor is chosen to be the Max by default.  
 
The minimum compression ratio will display the 
maximum number of samples. This will give the best 
possible representation of the entire acquisition. 
 
The best compression ratio is the one that retains key 
features of the signal to be displayed. This number is  
left to the user’s discretion. 
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 Type There are three types of decimation methods available: 
 
Skip Samples: Skips samples automatically according 
to the Factor (Compression ratio) 
 
Mean: Takes the mean value of a group of samples. 
The size of this group is governed by the number 
entered as the Factor. 
 
Min Max:  Depending on the Factor, takes the 
Minimum  and Maximum values of a group of 
samples. These values are then displayed in a vetical  
line connecting the minimum value to the maximum 
value.  
  

8 Getting back to our example, click OK in the Decimation dialog box. You will get back 
to the signal being acquired and decimated: 
 

 
 
According to the current Decimation settings, the Skip Sample method is used to 
decimate the input data shown in the figure above. 
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9 There are two other methods of decimating the data: MinMax and Mean. 
 
The MinMax Method 
 

In MinMax method, as the first step, the entire acquisition is divided into groups 
of samples. Each group contains fixed number of samples. The number  of 
groups and the size of a single group depend on the number entered in the 
Factor text box in the Decimation dialog box. User has no direct control in 
specifying the number of samples to be grouped.  
 
Next, the minimum and the maximum value from each group is extracted and 
saved.  Fro each group , a vertical line is then displayed. The two end points 
correspond to the minimum and maximum value  of the selected group. There 
will be as many vertical lines as the number of groups.   
 

10 In order to use the MinMax method of decimating the data, click on the decimation 
button in the channel control. The decimation dialog box appears. Click on the Type drop 
down menu button. The Type menu will appear:  
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11 Click MinMax from the list. MinMax shows up in the Type text box: 
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12 Click OK.  You will see channel 1 decimated input data as follows: 
 

 
 
Observe that the data is displayed as vertical lines. The number of lines represent the size 
of the decimated data to be displayed.  Divide the Size of the data to be displayed by the 
Factor to get the  size of the decimated data.  
 
In the current example, we have 
 
Size (data to be displayed) = 8388606 
Factor                                       = 524287 
Decimated DataSize             = Size/Factor 
                                                       = 8388606/524287 
                                                    = 16 
Now count the number of vertical lines. You will notice that there are 16 shown in the 
display above. 
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13 The Mean Method 
 

In Mean method, same as in the MinMax method, the entire acquisition is 
divided in groups of fixed length. The mean value for the samples in each group 
is computed.  These mean values for the entire acquisition are then displayed as 
the decimated data.  
 
 

14 In order to use the Mean method of decimating the data, click on the decimation button 
in the channel control. The decimation dialog box appears. Click on the Type drop down 
menu button. The Type menu will appear:  
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15 Click Mean from the list. Mean shows up in the Type text box. Click OK. You will the 
decimated signals as follows: 
 

 
 
Observe that the decimated data according to the Mean method indicates that there is a 
small neative bias in the signal.  Thus the decimated data canbe used to observe and even 
measure trends in the acquired signals. 
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16 In order to further elaborate the Mean method of decimation, shown below is a sine wave 
with a positive DC offset added to it: 
 

 
 

17 Follow the steps in the previous sections to obtain the decimated data emplying the Mean 
method. The decimated data is shown as follows: 
 

 
 
You can see that the positive DC offset now appears as the decimated data. 
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Tutorial 5: Working with Subchannels 

The Subchannel feature is of tremendous use in applications such as ultrasonics where the 
reflected echoes play a key role in identifying several key features of the medium. 

Illustrative Example 

1 A 1MHz sine wave sampled at 125MHz is shown below: 

 

The acquisition contains 1216 pre-trigger and 1216 post trigger sample points. There 
are 10 cycles in the pre-trigger portion and 10 cycles in the post-trigger portion of the 
signal. 

We will choose the portion of the signal between the sample point 1500 and 2100 such 
that the entire subchannel is extracted from the post-trigger part of the source channel 1. 
This means that the Start Offset is 1500 while the End Offset is selected to be 2100. 
Channel 3 is chosen as the resulting subchannel.  

Figure below shows the acquisition parameters: 
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2 Settings in the subchannel window appear as: 

 

3 Click OK. The window with the Subchannel appears 
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4 Note that Subchannel now appears as a tab in the Channel Control area 

 

 

5 Click on Subchannel to further explore the properties of the selected Subchannel 

 

Note that the Start and End options are available in case the Subchannel is obtained 
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using the features of the source (Trough, Rising edge, Falling edge, and Peak) 

The drop down menu shows that the Subchannel starts at sample point 1500 and ends at 
sample point 2100 with reference to the first point of the source channel i.e. Src Start 

6 The Subchannel can be aligned with the Trigger.  

From the Tools drop down menu, select Preferences. Now Select Smart in the Default 
Trace Alignment Box 

 

Click Apply 

7 Repeat steps 1 – 3. The Subchannel appears aligned with the trigger position 
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Note that the channel 3 appears as channel 4 as selected while repeating steps 1 – 3. 

The Subchannel aligns itself with the trigger also when the by Start option is selected in 
the Preferences dialog box. Refer to page C-30 of the Reference section for more 
details on Preferences. 

8 Follow the procedure outlined below in case you wish to obtain the Subchannel using 
one the feature-based references (Peak, Rising edge, Falling Edge, Either Edge, and 
Trough) of the source signal.  

Select the Subchannel between the first and the fifth peak of the original signal. There 
are no offsets specified for the present example: 
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9 Click on Tools in the Toolbar. Select SubChannel 
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It can be seen that Channel 5 has been selected as the Subchannel. The Subchannel will 
conform to the following: 

Sarting point of the Subchannel = First Peak + Offset 

Ending point of the Subchannel = End Peak  + Offset 

In our case, since no offsets are applied, the Subchannel starts at the first peak and ends 
at the fifth peak. 

10 Click OK. The Subchannel appears as Channel 5 

 

11 Click on the Subchannel tab in the Channel Properties dialog box 

 

The Start and the End options are now available. 
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Tutorial 6: Arbitrary Waveform Generator 

GageScope® has the unique ability to connect to Arbitrary Waveform Generators (CompuGen 
cards) sold by Gage Applied Technologies Inc. The primary step in achieving this 
connectivity is to create a rich set of waveforms within the GageScope® software.  The 
waveforms created in GageScope® can then be uploaded to an appropriate CompuGen card. 

There are three different ways to create arbitrary waveforms from within GageScope®: 

• Equation 

• Predefined  

• Standard Waveforms  

In this tutorial, we will go through the unique features of each of the methods outlined above.  
It is assumed that you have launched GageScope® prior to starting this tutorial. 
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Waveform Generation using Equation as an input 
 

1 Click File menu from the menu bar. 

 

It can be clearly observed that the Channel Control at the bottom right hand of the 
GageScope®  screen is blank. This is due to the fact that no channel is currently active.  

2 Select New from the drop down menu. You will see the following window: 
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3 Click on the Generator tab. You will notice that the Equation text is highlighted as a 
default.  
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Using controls in window shown above, users can type in an equation to generate a 
specific signal. 

4 Click inside the text box under the label Equation, brings up the Equation editor dialog 
box as shown below: 

 

There is an entire range of functions provided here. See the Reference Section of this 
manual for a complete listing of these functions. 

We will attempt to create a simple equation at this stage. Later on we will show that 
more complex signals can be created using controls provided in the Equation editor 
dialog box above. 

5 Let us now create the equation for generating a constant frequency sine wave. 

Type Exp[-0.1*X] * Sin[X] in the text box either using keyboard or the buttons 
provided in Equation Editor dialog box.  After entering the complete equation,  

 

Click OK. 

6 New dialog box appears again.  Notice that the equation typed in the previous step, is 
shown in the text box beneath the Equation label. 
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7 Click inside the text box on the left of the typed equation. This is the text box right 
under the Duration label. 

 

Type in 100 in the text box.  These are the total number of samples for the waveform. 
Click OK. 
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8 The New dialog box appears, showing the duration to be 100 samples. 

 

Click OK. 
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9 Damped sinusoid will be displayed in GageScope® as follows: 

 

This signal can be saved as a sig file to be uploaded to an AWG. 

10 Click on Ch 01 tab located in the bottom of Channel Control display.  You will notice 
that AWG Input tab appears in the Channel Control as shown below: 

 

The parameters can be modified using controls in the channel control above. 
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Predefined Waveforms 

 

1 Click File menu from the menu bar. 

 

2 Select New from the drop down menu. You will see the following window: 
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3 Click on the Generator tab. You will notice that the Equation text is highlighted as a 
default.   
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Using controls in window shown above, users can enter an equation to generate a 
specific signal. 

4 Click Predefined from the list in the dialog box. Click OK. 

 

5 Click Select. You will see the Load Channel window as follows: 

 

 

6 The dialog box shows that there are several types of signals stored for use. Click on 
Sawtooth.sig. The signal appears in the Preview window. 
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7 Click Open. The predefined signal appears in the New window as a Preview.  

 

8 To load the Sawtooth signal file in GageScope, click OK. If you do not wish to load the 
signal at this point, click Cancel. 
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9 Clicking Ch 01 tab in the channel control, brings up the AWG Input tab at the top of 
the control. Click AWG Input tab to view the associated property page as follows: 

  

 



B-176 Tutorials 

Standard Waveform Generation 
 

1 Click File menu from the menu bar. 

 

2 Select New from the drop down menu. You will see the following window: 
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3 Click on the Generator tab. You will notice that the Equation text is highlighted as a 
default.   
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Using controls in window shown above, users can specify an equation to generate a 
specific signal. 

4 Click Standard from the list in the dialog box.  Click OK. 

 

5 One can observe that the Sine waveform is the default selection.  Click on the scroll 
down arrow in the Waveform text box. You will find out that there are three different 
types of standard waveforms available for selection. These are Sine, Square, and 
Triangle as shown below: 
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6 Select Square from the drop down list.  Click OK. 

 

The resulting window shows the default settings for input parameters: Duty, Samples, 
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Amplitude and Offset.  Users can choose to change these parameters depending on their 
particular application. 

In the current setting, a single cycle of a Square wave will be generated with 50% duty 
cycle. The total number of samples within one cycle of this wave will be 1600.  The 
amplitude of the wave is 100% referenced to the input range selected. There will be no 
DC Offset. 

7 Click OK.  A single cycle Square wave will be displayed in GageScope®: 

 

Note that Channel 1 displays the generated Square wave.  The AWG Input tab has been 
selected and consequently the AWG property page appears in the bottom right hand 
corner of GageScope® display.  

Refer to the Reference section of this manual on further details for arbitrary waveform 
generation. 
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Tutorial 7: Using the Graphical Waveform Editor 

The graphical waveform editor allows onscreen viewing and editing of waveforms. Complex 
signals can be created with relative ease using the graphics editing capabilities of GageScope® 
software. The complex waveforms created can then be uploaded to an arbitrary waveform 
generator for use in scientific applications. These features have been explained in an 
illustrative example below. 

We will work on a gaussian pulse that has been created and saved as a .sig file in a local 
directory. The objective is to produce a non-gaussian shaped pulse using the graphical editor 
within GageScope. It has been assumed that GageScope® has been launched prior to 
following these steps: 

Waveform Editing Procedure 
1 Click File --> New --> Generator --> Equation --> Load. The file Open dialog box 

appears: 

 

2 Click gaussian.egg from the list in the dialog box. Gaussian.egg will appear in the File 
name text box.  Click Open. The New dialog box opens as follows: 
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3 Click OK. GageScope® will display the gaussian pulse as follows: 

 

Note: The pulse has been expanded in time and displayed at the center of the display 
window in Gagescope.  Refer to the System and Display Control sections in the 
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Chapter titled, Reference, of this manual for details on how to adjust these settings.  

We have selected a gaussian pulse to be edited using the graphical editor for the purpose 
of demonstration. You can either select any other stored waveform or create a new 
waveform using the mathematical equation editor. 

4 Right click on the reference line of the displayed signal. You will observe that the cursor 
changes shape, the waveform changes color and a menu appears at the right click 
position.  

This menu is shown as follows: 

 

5 Double click on Edit to enter the Graphical editor. At this stage, you may be warned 
that for the current time base, only limited editing is available.  

The warning message is displayed as follows: 

 

If you enter Yes, basic editing features like Copy, Cut, and Paste will be available. The 
graphical editing to change the waveform will be available only when the time base is 
expanded to 2 microseconds per division.  



B-184 Tutorials 

 

 

6 Since we are not ready for editing the waveform, click No. You will get back to the 
GageScope® display with the gaussian pulse shown on Channel 1. 

 

7 At this stage, if you click Yes, you will enter the graphical editor but will not be able to 
use any of its features. You must see a few Nodes on the waveform to commence the 
editing process. A node is a point on the trace surrounded by a square.  

 

The figure above shows a selected segment to be edited. Note that the edited segment 
shows three nodes. The end points of the segment are the boundary nodes. The middle 
node is the one that has been created (node creation to be explained later) or is an 
already existing node. The middle node is termed as the control node. The control node 
will be used to modify the selected line segment. 
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Note that the control node is shown with two orthogonal lines with arrows at the end. 
The mouse pointer changes shape to the one shown above when this node is selected for 
editing.  
 
You can select a segment with just the boundary nodes and then create the control node 
anywhere within the segment OR you can select two segments with the middle node as 
the control node. 
 
The important point to remember is that we must have three nodes within a selected 
signal segment to modify the segment.  

When cursor is placed on a node to be selected for editing, it changes into a four way 
arrow as  

8 Expand the time base by clicking  . Keep redisplaying the portion of the signal to 
be edited by using GageScope® display’s horizontal scroll bar every time you adjust the 
time base. The display below shows an expanded view of the gaussian pulse: 

 

9 After expanding the time base and redisplaying the signal as shown above, make 
another attempt to launch the graphical editor. 

Right click on the zero reference line. The cursor will change shape and the window 
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display context menu will appear. Double click on Edit to launch the graphical editor. 
One of the following will happen: 

• If the trace is still too dense, the GageScope® warning window will reappear. 
This indicates that the time base has not been expanded enough for the editor 
to function. 

• In such a case, click No. You will get back to the expanded display. Click on 
the time base expand button, , to expand the time base even further. 
Try launching the graphical editor again by right clicking on the zero 
reference line and selecting Edit from the drop down menu. 

• If the time base is proper for the editor to function, you will see the following 
display: 

 

10 Note that the trace is now divided into four segments and hence there are five nodes 
shown on the trace. You can select any segment for editing purposes. Since the 
displayed portion of the waveform shows the nodes, it implies that we are now ready for 
graphical editing. 

 To start editing the displayed portion of the waveform, you can either use the existing 
Nodes or create new Nodes. 
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Using the Existing Nodes 
 
11 Place the cursor on any portion of the waveform. The cursor changes from an arrow to 

be a plus sign +. This shows that a point on the trace has been selected, as depicted in 
the figure below: 

 
12 Move the hairline cursor closer to a Node. You do not have to move along the trace. You 

can go directly to the Node.  

Once you are in the neighborhood of a Node, you will notice that the hairline cursor 
changes into a four-way arrow, . This signifies that this particular node is now a 
control node and can be used to alter the trace.  The figure below shows the trace with 
the control node: 
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13 To move the control node, click the left mouse button once. This action activates the 
four-way arrow and now we are ready for editing.  Press the left mouse button again and 
move the cursor as desired. Since we wish to make a gaussian pulse, non-gaussian, we 
will move the peak point to the left as shown in the figure below: 
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Observe that the peak has been shifted to the left making the pulse non-gaussian. 

Note that the procedure employed in the drag and drop editing process, is the Cubic 
Spline Interpolation, which has been selected as a default. The Cubic Spline 
interpolation procedure works on fitting a cubic polynomial within a selected interval. 
In the example above, the selected interval is the interval between the two nodes: the 
nodes on the left and right of the control nodes define the left and right boundaries of 
the selected portion of the waveform. When the user moves the control node, the editor 
fits a cubic curve in between the two boundary nodes. This curve passes through the 
selected node as well as the two boundary nodes. 

14 You can also select the straight line interpolation procedure too by selecting Straight 
from the interpolation submenu. While in the Edit mode, right click on any portion of 
the display. You will see following context menu: 

  

Note that Cut, Copy, and Paste operations are not available since the portion of the 
waveform to be edited for cut and paste  operations has not been selected as yet. These 
items will be available for use whenever a portion of waveform is selected by placing 
the cursors on the trace for editing.  The cutting, pasting and copying procedure has 
been outlined in the section to follow. 

15 Select Interpolation to view the submenu as follows: 

 

Spline is shown as the default interpolation option.  
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16 Select Straight option in the menu above. This option connects the three nodes, the 
control node, and the two boundary nodes, by straight lines as shown below: 
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Creating New Nodes 
17 New nodes can be created with absolute ease in the Graphical waveform editor. Newly 

created nodes impart user extreme flexibility to reshape the waveform arbitrarily. 

Follow steps 1-9 to get to the following displayed waveform in GageScope: 

 
18 Move the cursor to the desired location on a selected portion of the waveform. This is 

the location where you wish to create a new node. You will note that the cursor changes 

shape to be a plus sign +. 
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19 Double click on the selected point and the cursor changes shape to look like .  

 

20 At this juncture, you have created a new node at this location. To view the newly created 
node, move the cursor away. You will see the following: 
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You can now use this new node to edit the selected portion of the trace. 

Deleting Existing Nodes 
21 Existing nodes can be deleted by simply double clicking on the Node. 

Follow steps 1-9 to get to the following displayed waveform in GageScope: 
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22 Move the cursor to the node that you wish to delete. We have selected the middle node 
to be deleted. 

Move the cursor to the desired node.  The cursor changes to be a four-way arrow.  
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23 Double click to remove the selected node. 
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Cut, Copy and Paste Features 
These features are available to the user whenever the desired portion of the waveform is 
selected using the cursors provided in GageScope® software. 

Cut and Paste Operations  

The example below illustrates how the Cut and Paste features work within the GageScope® 
software. 
 
1 Before carrying out example below, make sure that GageScope® display is configured as 

follows: 

 

Note that the Channel control area in the lower right corner of the GageScope® display 
appears blank. This is because no arbitrary waveform generator related signal has yet 
been created or loaded. Also note that the CG1100 tabs in the System control and 
display controls have been selected and the CG1100 related display window is shown 
maximized. 

2 Open the file titled 5 Flavors.egg by carrying out the steps as follows: 

Click File --> New --> Generator --> Equation. The New dialog box opens: 
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3 Click Load. The file Open dialog box appears: 

 

4 By default, the contents of the AWG Equations folder appear in the file Open dialog 
box as shown in the above.  

Select the file named 5 flavors.egg. The name of the selected file appears in the File 
name text box. Click Open. The New dialog box appears again: 
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Note that the right hand portion of the New dialog box shows the exact composition of 
the signal to be displayed in GageScope. The signal certainly contains 5 types of 
waveforms. 

5 Click OK to load the signal. GageScope® will display the signal as follows: 

 

In case the signal does not appear exactly the same as in the figure above, you may have 
to align the trigger to the left and compress the timebase to make the signal match the 
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one shown above. 

Click the left trigger align Icon  to align the trigger to the left. Click on the timebase 
expansion  or compression  buttons in the display control area to adjust to 
the timebase to exactly match the display settings as shown in the figure above. 

6 The next step is to invoke the Edit Mode. In order to achieve this end, place the cursor 
on the signal zero reference line. The cursor will turn into a move pointer.  

Right click to view the context menu: 

 

7 Note that Edit is the last option in the context menu. Click Edit to enter the graphical 
editing mode. The following dialog box appears: 

 

This message informs you that the current timebase settings allow limited editing 
features. This means that you may have to expand the timebase to be able to utilize full 
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editing capabilities. Since the timebase settings are frozen in the Edit mode, you will 
have to click No to go back to the non-edit mode and expand the timebase by clicking 
on  button in the display control. After having expanded the timebase, you can 
again attempt to launch the graphical editor by clicking Edit in the windows context 
menu. This is an iterative procedure and we do not want to embark on this route. 

8 We have opted to select Yes. The waveform graphical editing mode is now invoked. You 
will view the original waveform. 

At this stage, click one after the other on the left  , and right cursor  , icons in 
the toolbar. The GageScope® display will show both the cursors at default locations: 

 

9 Place the mouse pointer anywhere on the left cursor.  The mouse pointer will change 
shape to a move pointer.  Hold down the left mouse button and drag the move pointer. 
The cursor will drag with the pointer. Release the left mouse button at the starting 
location of the waveform to be edited. Follow the same procedure for the right cursor.  

In this example, we have decided to cut out the sine portion of the trace. This portion 
will be inserted in between the last part of the trace.  
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You can observe that the sine portion of the signal has been selected. 

10 Right click anywhere on the display (except the zero reference line). You will see the 
display context menu as follows: 

 

The Cut and Copy commands are grouped together at the bottom of this window. 

11 Double click on Cut to select and execute the command.  You will see that the selected 
portion of the signal has been removed from the display and both left and right cursors 
collapsed to show a single cursor.  You must understand that both cursors exist as 
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separate entities. It's just that they seem to be one. 

 

12 Hide the right cursor by clicking on the respective icon  in the toolbar.   

 

Observe that the sine portion of the signal has been removed. The portion to the right of 
the cut part has moved to the left to glue with the left part of the signal.  

Note that the right cursor icon appears enabled in the toolbar. 
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13 Place the mouse pointer on the left cursor, hold down the left mouse button, and drag 
the cursor to the desired insertion point on the displayed waveform. Release the left 
mouse button. You will see the following display with the left cursor positioned at the 
desired insertion point: 

 

Note that the insertion point has been arbitrarily selected. If you wish, you can select 
any other paste location. 

 

14 Right click anywhere within the display window. The display context window will 
appear again as shown below: 
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Make sure that you do not right click on the zero reference line. Right clicking on the 
zero reference line brings up the channel context menu. 

15 You can see that the Cut and Copy commands have been disabled.  Only the Paste 
command is shown enabled at the bottom of the display context menu. 

Double click on Paste to insert the cut portion of the trace. The modified signal will be 
shown as follows: 
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16 Hide the cursor by clicking on the left cursor button   in the toolbar: 

 

17 You will note that while in the edit mode, most of the functionality in GageScope® 
remains disabled.   

Click on the channel 1 tab in the bottom of the Channel Control. Click on the AWG 
Input tab to bring it to front.  The AWG Input property page will appear and is shown 
as follows: 

 

Channel 1 (Ch 01) contains the signal you have just modified.  In order to get back to 
the normal functionality, you will have to leave the Edit Mode. 

18 Click on the File menu in the menu bar. The File menu will be displayed: 
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Note that the Save Setup, Load Setup, New, and Load Channel commands have been 
disabled. These will be re-enabled once you leave the Edit mode. 

19 Click on Capture in the main menu. The Capture menu will appear: 

 

Note that the entire Capture menu has been disabled. These features are not needed 
while editing of signals is in progress. 

20 Click on Tools in the main menu bar.  The Tools menu will appear: 

 

Note once again that the entire menu has been disabled since these functions are not 
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required when editing of a waveform is in progress. 

21 Click on Windows in the main menu bar.  The Windows menu will appear: 

 

You can see that the New Display command is disabled. While in the edit mode, you are 
not allowed to create another signal. In other words, only one signal can be modified at 
a time. 

22 We have finished editing the waveform and now must exit the Edit Mode.  In order to 
do so, move the mouse pointer to the zero reference line. The mouse pointer will turn 
into a move pointer.  Right click on the zero reference line of the waveform.  The zero 
reference context window will appear as follows: 

 

The check mark indicates that the Edit Mode is in force. Double click on Edit. This will 
take GageScope® out of the Edit Mode. You will note that the functions that were 
disabled will now be restored to their original settings.  
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Copy and Paste Operations  

The example below illustrates how the Copy and Paste features work within the GageScope® 
software.  
 

1 Open the file titled Lorentzian.egg by carrying out the steps as follows: 

Click File --> New --> Generator --> Equation. The New dialog box opens: 

 

2 Click Load. The file Open dialog box appears: 
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3 By default, the contents of the AWG Equations folder appear in the file Open dialog 
box as shown above.  

Select the file named Lorentzian.egg. The name of the selected file appears in the File 
name text box. Click Open. The New dialog box appears again: 

 

Note that the right hand portion of the New dialog box shows the exact composition of 
the signal to be displayed in GageScope.  

4 Click OK to load the signal. GageScope® will display the signal as follows: 
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In case the signal does not appear exactly the same as in the figure above, you may have 
to align the trigger to the left and compress the timebase to make the signal match the 
one shown above. 

Click the left trigger align Icon  to align the trigger to the left. Click on the timebase 
expansion  or compression  buttons in the display control area to adjust to 
the timebase to exactly match the display settings as shown in the figure above. 

5 The next step is to invoke the Edit Mode. In order to achieve this end, place the cursor 
on the signal zero reference line. The cursor will turn into a move pointer.  

Right click to view the context menu: 

 

6 Note that Edit is the last option in the context menu. Click Edit to enter the graphical 
editing mode. The following dialog box appears: 
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Choosing Yes will invoke the graphical editor. 

We have already discussed the implications of limited Edit mode capabilities in the 
previous section. 

7 Click Yes. The waveform graphical editing mode is now invoked.  

Following the procedure given in the previous section, select the portion of the trace to 
be copied. This is achieved by positioning the cursors at the desired locations on the 
trace.  The display below shows one such selection: 

 

Observe that we have selected the middle portion of the signal to be copied. 

8 Right click anywhere on the display (except the zero reference line). You will see the 
display context menu.  Click on Copy.  The screen will appear the same but the selected 
portion of the trace will be copied to the memory buffer: 
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9 Hide the right cursor by clicking on the respective icon  in the toolbar.  After hiding 
the right cursor, drag the left cursor to place it at the insertion point on the trace.   

Next, right click anywhere on the display except the zero reference line. The reference 
context menu will appear: 

 

10 You can see that the Cut and Copy commands have been disabled.  Only the Paste 
command is shown enabled at the bottom of the display context menu. 
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Double click on Paste.  The copied portion of the trace will be pasted at the cursor 
location as shown below: 

 

11 The part of the trace copied is again pasted at the end of the signal.  Hide the left cursor 
by clicking on the left cursor button in the toolbar. The GageScope® display will show 
as follows: 
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12 When finished, you must exit the Edit mode.  Right click on the zero reference line. The 
reference context menu will appear.  The check mark besides Edit command shows that 
the Edit mode is currently active.   

 

13 Click on Edit to deactivate the Edit Mode.  The GageScope® window will appear as 
follows:  

 

Observe that the normal operation has commenced since all disabled controls have been 
enabled. 
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Quick Reference 

Use the diagram below to quickly find the reference section you are interested in. 
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Menu Commands 

The following pages contain descriptions of menu commands (some of which have equivalent 
buttons in the toolbar). For descriptions of commands found in the toolbar only (and not in 
menus), see page C-47. 

To quickly find out what a toolbar button does, position the 
mouse pointer over a button—a “tool tip” will appear with a  
description of the button. 
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File: Save Setup 
The Save Setup command saves current GageScope® settings in a Setup file with the 
extension .INI. 

Upon startup, GageScope® chooses several default settings in order to display a signal. As so 
many settings can be changed, it can be tedious to have to repeatedly fix everything to your 
liking. To solve this problem, GageScope® offers the ability to save all the current settings in 
a Setup file. 

What is Saved? 
Setup files record the following information: 

• CompuScope card and CompuGen card’s Display Settings: Channel mode, sample rate  
• Channel Settings: input range, coupling, position, vertical scale, polarization, channel 

name, comments 
• Trigger Settings: Trigger type, trigger level, timeout, trigger slope, depth units, post-

trigger depth, pre-trigger depth 
• Display Settings: Timebase, channel visibility 
 

GageScope® for DOS Setup File Compatibility 
The GageScope® setup file format (.INI) is not compatible with the GageScope® for DOS 
setup file format (.SET).  

How it Works 
1 Choose Save Setup from the File menu. The Save Setup dialog appears. 

2 In the “File name” field, type in a file name. 

3 Go to the folder where you would like to save your Setup file. 

4 Click Save to save the Setup file. 
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File: Load Setup 

The Load Setup command loads a previously saved Setup file.  A Setup file contains the 
GageScope® settings which were current at time of saving.  The Setup file has the extension 
.INI. 

For details on what is saved in a setup file, see Save Setup on page C-7. 

How it Works 
1 Click Stop  in the Toolbar to stop the current acquisition. 

2 Choose Load Setup from the File menu. The Load Setup dialog appears. 

3 Go to the folder where you saved your Setup files and choose a file from the list. 
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File: New 

 
The New command opens the New dialog box.  It imparts user the ability to use advanced 
computational features of GageScope® like Averaging, Parameter Extraction, Advanced Math, 
FFT analysis, etc.  
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How it works 

1 The dialog box opens with Cancel tab selected as a default.  Following options are 
available to the user: 

• Math Channel :  Performs basic mathematical operations of addition, 
substraction, multiplication and division.  Refer to discussion on page 
C-33 for further details on this option. 

• AutoSave Playback :  This command brings up the AutoSave 
Playback dialog, which allows you to locate the previously saved 
AutoSave records on your system as well as the channels to be played 
back.  See AutoSave tool on page C-178 for more details. 

• SubChannel :  Subchanneling allows part of signal to be extracted 
based on a certain feature of interest. Refer to Channel Control Section 
on page C-122 and the Tutorial section on page B-105 for detailed 
discussion on Subchannel   

• Average Channel : Acquired signals can be averaged using the 
Average Channel feature using several methods. See Averaging tool on 
page C-191 for more details. 
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2 To use the waveform parameter feature of GageScope®, click on Parameter tab in New 
dialog box. The following window appears: 

 

Parameter dialog box opens giving user options to choose from a list of signal parameters 
to be acquired. Parameters such as Frequency, Mean, RMS, Peak, Amplitude, etc can be 
computed automatically during signal acquisition.  

This feature is only partially available in the Standard Edition of GageScope®. 
Professional Edition provides full Waveform Parameter measurement capability. 

For further details and a comprehensive list of all parameters that are offered, see 
Waveform Parameters tool on page C-205. 
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3 Click Analysis tab to view the screen as follows: 
 

 
 

The two options available are the FFT and the Extended Math. Dialog box shows 
FFT as the default option.  Refer to FFT Analysis tool on page C-215 for more 
details. 
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4 Clicking Extended Math option opens the Extended Math dialog: 

 

A complete list of Extended Math functions is provided in the Extended Math tool on 
page C-220 
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5 Click on Generator tab to open the Generator dialog box: 

 

The New dialog box allows signals to be created using Equation, Predefined and 
Standard Methods.  

Refer to Chapter 6 in the Tutorials or the AWG section of this guide for further details. 
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File: Load Channel 

 
The Load Channel command opens a previously saved GageScope® signal file. GageScope® 
signal files have the extension .SIG. The channel is placed in the Display Window and 
assigned a unique channel number.  

How it works 

1 Choose Load Channel from the File menu to bring up the standard Windows Open 
dialog box; or, click on the Load Channel button in the toolbar. 

2 Move to the folder that contains the .SIG file you want to open. 

3 Click on the file. 

4 Click Open. 

Compatibility 
GageScope® and GageScope® for DOS share the same .SIG file format. GageScope® can load 
.SIG files saved by GageScope® for DOS and vice-versa. 

Neither GageScope® nor GageScope® for DOS can read an ASCII file.  This format should be 
used for export purposes only. 
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File: Save Channel 

 
The Save Channel command writes a channel to disk in the GageScope® signal file format. 
GageScope® signal files have the extension .SIG. You also have the option to save the signal 
as an ASCII text file, which you can import into a third-party program for further analysis. 

For detailed information on what is saved in a .SIG file, see Appendix A. 

How it works 

1 Choose Save Channel from the File menu to bring up the standard Windows Save As 
dialog; or, click on the Save Channel button in the toolbar. 

You also can right-click on a channel to bring up the channel context menu, then choose 
Save Channel. 

2 Notice the  “Channel” field at the bottom of the dialog. This field tells GageScope® 

which channel to save. If necessary, select the channel you wish to save from this list. 
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3 If you chose Save Channel from the File menu or the toolbar, channel 1 is listed by 
default in the channel field. If you used the channel context menu (by right-clicking on a 
channel and choosing Save Channel), the channel you selected appears in this field 
automatically. 

Note that you can also save all visible channels at once by selecting All in the Channel 
list. 

4 When saving, the GageScope® signal file format (extension .SIG) is chosen by default. If 
you wish to save the signal as an ASCII text file, choose “ASCII File” from the Save as 
type drop-down menu. 

Enter a name in the File name field. There is no need to enter the extension, as 
GageScope® will add the extension .SIG or .ASC automatically. 
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5 You have the option of saving only that portion of the channel that is currently visible in 
the Display Window.  To specify this option, click the Save visible portion of the 
channel checkbox. 

 

6 Move to the folder in which you wish to save the file.  By default, GageScope® will save 
files to the Signal Files folder. 

 Click Save. 

Compatibility 
GageScope® and GageScope® for DOS share the same .SIG file format. GageScope® can open 
.SIG files saved with GageScope® for DOS and vice-versa. 

Neither GageScope® nor GageScope® for DOS can read an ASCII file.  This format should be 
used for export purposes only. 

 



Reference C-19 

File: Print Setup 

Print Setup allows you to change the orientation of the paper and other settings. 

How it Works 
1 Choose Print Setup from the File menu. The Print Setup dialog appears. 

2 To change the orientation of the paper, click on the Portrait or Landscape radio buttons 
in the Orientation area of the dialog. 

3 Choose a printer from the drop-down list. To change the printer’s settings, click on the 
Properties button. 

4 To change the size of the paper, click on the Size drop-down menu in the Paper area of 
the dialog. 

5 To change which tray to take the paper from, click on the Source drop-down menu in the 
Paper area of the dialog. 
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File: Print 

 
The Print command sends a copy of the Display Window to the printer. 

How it Works 
1 Click Stop in the Toolbar or in the Capture menu.  (You will not be able to print unless 

GageScope® has stopped acquiring data.) 

2 Choose Print from the File menu or the toolbar. The Print dialog appears. 

3 Choose a printer from the drop-down list. To change the printer’s settings, click on the 
Properties button. 

4 To print more than one copy, enter a number in the Number of Copies field. 

5 Click OK to begin printing. 

Note 
To get the largest possible printout, it is recommended that you change the page orientation to 
landscape using the Print Setup command. 
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File: Print Preview 

Print Preview allows you to preview how a file will look when you print it, based on the 
current Print Setup. 

How it Works 

1 Choose Print Preview from the File menu. 

Your current signals will be displayed as they will be printed. 

 

2 Click Print to accept the current print settings. 

3 Click Zoom In or Zoom Out to view different parts of the previewed page. 

4 If you have a color printer installed on your system, click Colors to edit the colors to be 
used for each channel trace.  If you do not have a color printer installed, this option will 
not be available. 
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5 You will see the Print Traces dialog. 

 

To edit the colors, click on a channel to highlight it and then click Change. 

6 The Color dialog appears. 

 

Click on another color and click OK to accept. The new colors will be displayed in the 
Print Preview window. 

7 Click Close to exit Print Preview. 
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File: Exit 

The Exit command quits GageScope®.  

How it works 
1 Click on the File menu. 

2 Click on Exit. 

You can also click the X at the top right of the application window. 

Note 
GageScope® will not ask you if you wish to save any unsaved channels. If you exit without 
first saving unsaved channels, those channels will be lost. 
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View: Full Screen 

 
The Full Screen command hides the System, Display, Channel, and InfoView controls, 
allowing the Display Window to expand to fill the screen. The menus, toolbar and status bar 
remain visible. 

How it works 
1 Click on the Full Screen button in the toolbar; or, choose Full Screen from the View 

menu. All controls are hidden and the Display Window expands to take up the remaining 
space. 

2 To return GageScope® to normal, click on the Full Screen button once more. 
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View: Systems, Displays, Channels, InfoView, Toolbar 
Click View on the menu bar. The View submenu appears: 

 

These commands hide or show the System Control, Display Control, Channel Control, 
InfoView Window and Toolbar.  

A checkmark next to an item indicates that the display element is currently visible; absence of 
a checkmark indicates that the element is hidden. 
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Capture: One Shot 

 
In one shot mode, GageScope® waits for a trigger event, acquires and displays the data, then 
stops. This allows for unattended one shot capture of both pre- and post-trigger data. 

• To set GageScope® to one shot capture, select One Shot from the Capture menu; or, click 
on the One Shot button in the toolbar. The capture mode is already set to one shot if there 
is a checkmark next to One Shot in the Capture menu, or if the One Shot button is 
enabled. 

• To cancel a one shot capture, select Stop from the Capture menu, or click on the Stop 
button in the toolbar. 

• When you choose one shot mode, GageScope® automatically disables the Timeout setting 
in the Depth tab of the System Control. 

About One Shot Mode and Stop 
While in one shot mode, if you click on Stop in the toolbar, GageScope® completes the 
current acquisition, then stops.  

If you select Stop while in one shot mode but a trigger event has yet to occur, GageScope® 
issues a software trigger, i.e., it immediately acquires the current signal, then stops. The data 
you see is that which existed when you clicked on Stop. 
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Capture: Continuous 

 
In Continuous Capture Mode, GageScope® repeatedly waits for a trigger event, acquires and 
displays the data, then resets the CompuScope card to wait for another trigger event. This is 
the default capture mode. 

• To set GageScope® to Continuous Capture, select Continuous from the Capture menu; 
or, click on the Continuous button in the toolbar. 

• To cancel continuous capture, select Stop from the Capture menu; or, click on the Stop 
button in the toolbar. 

When you select Continuous mode, GageScope® automatically enables the Timeout setting in 
the Depth tab of the System Control. 

About Continuous Mode and Stop 
If you click on Stop in the toolbar while in continuous mode, GageScope® completes the 
current acquisition, then stops.  

If you select Stop while in continuous mode but a trigger event has yet to occur, GageScope® 
issues a software trigger, i.e., it triggers immediately, acquires the current signal, then stops. 
The data you see is that which existed when you chose Stop. 

About Continuous Mode and the Trigger Timeout 
In the event of a timeout while in continuous capture mode, GageScope® issues a software 
trigger, i.e., it triggers immediately upon timeout, acquires the current signal, then resets the 
CompuScope card to await another trigger event. 
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Capture: Stop 

 
Choose Stop from the Capture menu or click on the Stop button in the toolbar to interrupt the 
current capture mode. Capturing has already stopped if there is a checkmark next to Stop in 
the Capture menu or if the Stop button is enabled. 

When an acquisition is stopped, GageScope® completes the current acquisition, then stops. If 
a trigger event has yet to occur, GageScope® triggers immediately, acquires the current signal, 
then stops. The data you see is that which existed when you clicked on Stop.   

By contrast, pressing Abort (see below) means that the current acquisition will not be 
completed. 
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Capture: Force Trigger 

 
Choose Force Trigger from the Capture menu or click on the Force Trigger button in the 
toolbar to force a trigger.  

Note on Force Trigger and Capture Modes 
• When you are in Continuous Capture mode and GageScope® is waiting for a trigger, if 

you click Force Trigger, the Status Bar will very briefly display the message “Ready” on 
a blue background.  Thereafter, the Status Bar will display “Stop” on a blue background, 
indicating a trigger was forced. 

• When you are in One Shot capture mode and you click Force Trigger, the Status Bar will 
display “Stop” on a blue background, indicating a trigger was forced. 
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Capture: Abort 

 
Choose Abort from the Capture menu or click on the Abort button in the toolbar to abort the 
current acquisition immediately.  While pressing Stop causes GageScope® to complete the 
current acquisition first, pressing Abort means that the current acquisition will not be 
completed.  This is helpful for very long acquisitions. The data you see is that which existed 
when you clicked on Abort. 

See page C-44 for more information on customizing the Abort command. 
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Capture: AutoSave Setup 

Choose AutoSave Setup from the Capture menu to specify settings for an AutoSave 
acquisition. 

How it works 
1 Choose AutoSave Setup from the Capture menu. The AutoSave Setup dialog appears. 

 

The AutoSave dialog allows you to select the channels for which AutoSave should be set 
up, as well as benchmark your settings to determine how long the system will need to 
perform a single AutoSave cycle using your settings.   

2 To benchmark your AutoSave session, select the channels you intend to save to disk and 
then click on Evaluate. GageScope® will determine how long it will take to perform the 
specified AutoSave session. 

3 After you have specified the desired AutoSave settings, click Start to begin the AutoSave 
process. 

4 To save your current AutoSave setup, click Save Setup.   
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5 You will see the Save Setup dialog, allowing you to specify the directory for the setup 
file.  The default directory is C:\Gage\Gagescope\AutoSave, and the default AutoSave 
setup file name is GagescopeAS.asf.   

6 To load a previously saved AutoSave setup file, simply click Load Setup in the 
AutoSave Setup dialog.  This brings you to an Open dialog, allowing you to select an .asf 
file to load. 

 

Note 
If you wish to change hardware settings before beginning the AutoSave, you must exit the 
AutoSave Setup dialog.  To preserve the AutoSave setup changes you have made, click 
Apply, then Cancel.  Make the necessary hardware changes.  When you re-open the 
AutoSave Setup dialog, your settings will have been retained. 

For more information on the AutoSave tool, see page C-178. 
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Tools: Math 

 
The Math command creates a new channel by mathematically combining two existing 
channels. 

How it works 
1 Click on the Tools menu, then click on Math. Or, you can click on  in the toolbar. 

2 When Math is clicked from the drop down menu, following Channel dialog appears: 
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3 When you click on   in the toolbar, the following dialog box appears: 

 

 

4 In either case, choose a channel from the Operand 1 drop-down menu  

5 Click on one of the four buttons:  
   + (addition), - (subtraction), * (multiplication),  ÷ (division). 

6 Choose a channel from the Operand 2 drop-down menu. 

7 Choose a result channel from the Result drop-down menu.Click OK when finished or 
Cancel to abort the changes. 



Reference C-35 

Tools: SubChannel 

 
This command brings up the new SubChannel dialog box, which allows the user to pick out a 
part of the signal depending on the feature of interest. 

How it works 

1 Click on the Tools menu and select Subchannel. You can also select    button in the 
Toolbar. The New Channel Dialog will appear: 

 

2 Choose from the available options that appear in the new channel dialog box 

3 Select a channel from the Result drop down menu 

4 Click OK when finished or Cancel to abort the changes. 

Refer to Channel Control Section on page C-122 and the Tutorial section for detailed 
discussion on Subchannel.  
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Tools: Averaged Channel 

 
This command brings up the new Averaged Channel dialog box, which allows the user to 
carry out the averaging of the selected channels using several methods available. 

Note: The full functionality of the Averaging analysis tool is available only when you have 
purchased and installed the Professional Edition of GageScope® software. There, however, are 
a few features included in the GageScope® Standard Edition. 

See Averaging tool on page C-191 for more details. 
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Tools: FFT 

 
This command brings up the New FFT Channel dialog, which allows you to specify the 
settings for a new FFT signal analysis. 

Note: The full functionality of the FFT analysis tool is available only when you have 
purchased and installed the Professional Edition of GageScope® software. There are a few 
features included in the Standard Edition of GageScope®. 

See FFT Analysis tool on page C-215 for more details. 
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Tools: Extended Math 

 
This command brings up the New Extended Math dialog, which allows you to choose from 
one of the following functions: 

• Integration of the selected channel 

• Differentiation of the selected channel 

• Autocorrelation of the selected  

• Cross-correlation of the selected channel 

Note: You must have purchased and installed the Professional Edition of GageScope® 
software in order to make use of this feature. This advanced tool is not available in the 
Standard Edition of GageScope®. 

See Extended Math tool on page C-220 for more details. 
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Tools: AutoSave Playback 

 
This command brings up the AutoSave Playback dialog, which allows you to locate the 
previously saved AutoSave records on your system as well as the channels to be played back. 

Note: The full functionality of the AutoSave tool is available only when you have purchased 
and installed the Professional Edition of GageScope® software. There are a few features 
included in the Standard Edition of GageScope®. 

See AutoSave tool on page C-178 for more details. 
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Tools: Waveform Parameters 

 
This command brings up the Edit Waveform Parameters dialog, which allows you to change 
which parameters are shown in the InfoView windows. 

Note: The full functionality of the Waveform Parameters tool is available only when you have 
purchased and installed the Professional Edition of GageScope® software. There are a few 
features included in the Standard Edition of GageScope®. 

See Waveform Parameters tool on page C-205 for more details. 
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Tools: Preferences 

This command brings up the Preferences dialog, which allows you to change GageScope® 
preferences. 

 

 

Directories Allows you to specify the directories for loading signals, saving 
signals, and saving AutoSave configuration files (*.asf).  The defaults 
are: 

• Load signals from: C:\Gage\Gagescope\Signal Files 

• Save signals to: C:\Gage\Gagescope\Signal Files 

• AutoSave configuration file name: 
C:\Gage\Gagescope\AutoSave\GagescopeAS.asf 

To change any of these settings, click on . 
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Miscellaneous • Accept long file names: When checked, GageScope® will allow 
long file names when saving files.  By default, this item is 
checked. 

• Show tool tips:  When checked, GageScope® will display “Tool 
Tips” when the mouse is positioned over a toolbar button. By 
default, this item is checked. 

• Use Caltable: When checked, GageScope® will use a Calibration 
Table to set gains and offsets on the CompuScope card(s) instead 
of using Auto-Calibration.  Not recommended for normal use. 
 
This item is available only if GageScope® detects a Calibration 
Table file (filename caltable.dac) in the proper folder.  For 
Windows NT, this file should be kept in the 
Windows\System32\Drivers folder.  For Windows 95/98, this file 
should be kept in the Gage\GageScope folder.   

• Smart tabs:  When checked, GageScope® will “remember” which 
Channel Control tab you were browsing when you move from one 
channel tab to another. By default, this item is checked. 

• Independent Trigger:  For Master/Slave systems of selected 
CompuScope cards only.  When this item is checked, you will be 
able to set not only the Master board channels as trigger sources, 
but also the Slave board channels.  This is very useful in 
applications that require a multi-board system to trigger from any 
one of the channels.  By default, this item is checked. 

• Scope Mode: When selected, this option links the sample rate and 
input range settings to the timebase and vertical scale selected by 
the user.  This provides a control method very similar to that of 
stand-alone digital oscilloscopes on the market. 

Input range is set to be greater than or equal to +/- 4 times the 
vertical scale. 

Sample rate is set to be greater than the value required to display 
more than 4 samples per division. 

You can also set Scope Mode by clicking on the tool. 
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 • DM Buffer Max. Size:  This option is used whenever you have a 
CompuScope card with more than 16 Meg of acquisition memory.
 
The Deep Memory Buffer Max. size refers to allocating, for every 
channel, actual physical memory present in the system, that will 
be used for displaying the acquired signals in GageScope® .   

The minimum and maximum DM Buffer size are 8 and 64 
Mega Bytes (MB) per channel respectively. 

Care must be exercised in allocating a value in the DM Buffer max 
size text box.  You must make sure that the total memory available 
in the PC is significantly greater than the DM maximum buffer 
size.  

Please refer to the chapter titled Decimation in the tutorial section 
of this manual for detailed discussion on how to use the Deep 
Memory option. 
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Default action 
on stop 
acquisition 

• Do not display Abort dialog:  When this item is unchecked, 
GageScope® will display the Abort dialog when the user issues a 
command during a very long acquisition. By default, this item is 
unchecked.  
 
When the Abort dialog is displayed, you must choose between 
Abort and Continue.  Clicking Continue means that the current 
acquisition will be completed before carrying out further 
commands. 
 

 
 
When Do Not Display Abort Dialog is checked, you may select 
between the following options: 

• Always wait: GageScope® will always wait until the acquisition is 
completed before carrying out further commands.  This is the 
default setting. 

• Always abort: GageScope® will always abort the acquisition in 
order to carry out further commands.  
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Default Trace 
Alignment 

When displaying a saved signal that does not cross the trigger marker, you 
can specify where on the screen that signal will be displayed. 

• by Start: GageScope® will display the signal at the Start (at the 
Trigger Marker, or time zero). 

• by Trigger: GageScope® will display the signal at its original time 
position relative to time zero.  This is the default setting. 

• Smart:  If the signal crosses the trigger marker, GageScope® will 
display the signal at its original time position relative to time zero.  If 
the signal does not cross the trigger marker, GageScope® will display 
the signal at the Start (at the Trigger Marker, or time zero).  

Align by Trigger and by Start are also available in the Drawing tab of the 
Channel Control when a signal is displayed which does not cross the trigger 
marker. 

MulRec Player 
Speed 

When playing back the Multiple Records, set the speed to range between 
Fast and Slow. Use the speed tab to set an appropriate speed as desired. 

Note: Use relatively Fast MulRec player speeds when you need to quickly 
browse through the records. Use Slower playback speeds when you wish to 
look in the records for some feature of interest. 

Associate 
GageScope®  
files to this 
application 

When selected, this option associates GageScope® files to the current 
application. 
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Window: Window Menu Commands 
The Window menu and the Window toolbar buttons give you access to commands that control 
the Display Window. 

 

New Display Creates a new Display Window. Each Display Window is independent 
of the others, in that it can have its own timebase, colors, etc. 

Cascade Rearranges and resizes all the Display Windows, offset, one on top of 
the other. 

Tile Horizontally Rearranges and resizes Display Windows horizontally. 

Tile Vertically Rearranges and resizes all the Display Windows vertically. 

Left Bar Hides or shows the left bar of the Display Window. 

Status Bar Hides or shows the status bar of the Display Window. 

Notes 
• A list of all Display Windows is located at the end of the Window menu. 

• To close a Display Window, click on the small x at the top right of the window.  

• You cannot close the last open window. 
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Toolbar Commands 

The following pages contain descriptions of commands found only in the toolbar (and not in 
any menu). 

To quickly find out what a toolbar button does, position the mouse 
pointer over a button—a “tool tip” will appear with a description of 
the button. 
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Toolbar: Trigger Align Buttons 

 
The trigger align buttons automatically repositions the contents of the Display Window so that 
the trigger marker is either at the left, center, or right. 

• The Trigger Left Align button positions the trigger marker to the left of the Display 
Window. 

• The Trigger Center Align button positions the trigger marker to the center of the Display 
Window. 

• The Trigger Right Align button positions the trigger marker to the right of the Display 
Window. 

 

 



Reference C-49 

Toolbar: Zoom In / Zoom Out 

 
The zoom tools allow you to magnify or demagnify an area of the Display Window. This 
allows for inspection of particular parts of a waveform. 

Zoom In 

The Zoom In tool  magnifies the area you select. To use this tool: 

1 Click on the Zoom In button  in the toolbar.  

2 Position the mouse pointer to the left of the desired portion of the waveform. 

3 Hold down the mouse button. A vertical line will appear where you first click. 

4 Drag the mouse to the right of the portion of the signal you wish to see. A second line will 
follow the movement of the mouse. 

5 Let go of the mouse button. The area you selected is magnified. 

When magnifying a particular area, the zoom tool actually decreases the timebase in order to 
display the data within your selection, then centers the area in the Display Window.  Note that 
zooming changes the horizontal scale only—it does not affect the vertical scale of the 
channels. 

Zoom Out 

The Zoom Out tool  reduces the magnification (and consequently increases the timebase) 
of the Display Window.  To use this tool: 

1 Click on the Zoom Out button . 

2 Click somewhere in the Display Window. This decreases the timebase by one increment.  
Continue clicking with the Zoom Out tool to further reduce the magnification. 

Alternatively, you can use the Increase Timebase   button in the Display Control to 
reduce the magnification of the Display Window. 



C-50 Reference 

Toolbar: Arrange Channels Button 

 
Clicking on the Arrange Channels button automatically re-organizes visible channels in order 
of their channel number. Hidden channels are ignored. 

You can also right-click in the Display Window and choose Arrange Traces from the context 
menu. 
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Toolbar: Overdraw Mode and Erase Display 

 
In overdraw mode, GageScope® does not erase a trace before updating the Display Window. 
This causes two or more traces to show where there would normally be one. 

Click on the Overdraw Mode button to enable this feature. Disabling Overdraw Mode 
removes all the extra traces. 

When Overdraw Mode is active, the Erase Display button (located to the right of the 
Overdraw Mode button) is available. Erase Display will erase all the duplicate traces without 
turning Overdraw Mode off. This button is grayed out when Overdraw Mode is disabled. 
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Toolbar: Multiple Record Buttons 

 
The Multiple Record buttons allow you to move from one record to another when viewing 
signals captured in Multiple Record mode. 

  Align all channels to first record 
  Start playback 
  Continuous playback 
  Pause playback 
  Go to the previous record 
  Go to the next record 

Note:  These buttons are also used for AutoSave Playback.  See the AutoSave tool on page C-
178. 

About Multiple Record 
Multiple Record comes as a standard feature or as an option on most CompuScope cards, and 
is not available on the CompuScope LITE. If your CompuScope card does not have this 
capability, these buttons will be disabled. 
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The Multiple Record setting is located in the Depth tab of the System Control. 

 
For more information on this topic, see Multiple Record on page C-88. 
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Toolbar: Cursor Buttons 

 
Cursors allow the user to measure the difference between two locations on the same signal or 
on different signals.  

Enabling Cursors 
Cursors are disabled by default. To enable a cursor, click on either the Cursor 1 or Cursor 2 
buttons in the Toolbar.   

Once a cursor is enabled, a cursor (represented by a small box) riding on the waveform 
appears on channel 1, and is positioned halfway between the center line and left (Cursor 1) or 
right (Cursor 2) edge of the display. 

Moving Cursors 

1 Click on one of the cursor buttons  to enable a cursor, if you have not already done so. 
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2 Position the mouse pointer somewhere on the cursor line. The pointer should change to a 
drag pointer. Note: You do not have to be on the small box – anywhere on the line will 
do. 

 

3 Drag the cursor line to the left or right of the trigger marker line. The cursor will follow. 
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Attaching the Cursor to a Different Channel 
1 Click with the right mouse button on the cursor line. This brings up the Cursor context menu. 

 

2 Click with the left mouse button on the channel you wish to use. A checkmark next to the 
channel indicates which channel the cursor is on. 

The None option will leave the cursor line enabled without being attached to any particular 
channel. You can still move the cursor’s vertical line. 

The Hide option will turn the cursor off, as if you had clicked the Cursor 1 or Cursor 2 
buttons. 
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Getting the Cursor Back After Scrolling Off-screen 
With the exceptionally deep memory buffers offered on CompuScope cards, it is easy to make 
a cursor measurement and then scroll far away from this area to inspect another portion of the 
display. 

The cursors you had set are still in place and the readouts are still displayed.  If you scroll 
back, you will find the cursors again. 

However, if you want to make cursor measurements in a different part of the signal, all you 
have to do is the following: 

 

1 Disable the Cursor by clicking on the Cursor 1 or Cursor 2 button. 

2 Enable the Cursor by clicking again on the same button. 

The cursor will now be on your screen and you will not have to drag it from its previous 
location. 

Cursor Values 
The values of the current cursors are reflected in the Display Window’s status bar to the right 
of M.Pos. 

Cursor 1’s values are in the first cursor status box; Cursor 2’s values are in the second cursor 
status box, and the third cursor status box shows the absolute difference between the cursor 
values, if both cursors are enabled.  

The first field in each cursor status box is the X co-ordinate, measured in seconds, relative to 
the trigger marker. A positive value indicates the cursor is to the right of the trigger marker; a 
negative value means the cursor is to the left of the trigger marker. 

The second field in each cursor status box is the Y co-ordinate, measured in Volts, relative to 
the zero line of the channel. A positive value indicates the cursor lies above the channel’s zero 
line; a negative value means the cursor lies below the channel’s zero line. 

Cursor Deltas 
Once two cursors have been set, GageScope® automatically calculates the absolute 
differences between them. This is shown in the third set of values in the status bar. 
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Delta Track Mode 
Track mode “locks” the distance between two cursors. As such, when you move one cursor, 
the other moves in tandem. 

1 Click on the Track Mode   button to enable track mode. 

2 As a test, try to move Cursor 1 toward Cursor 2. 
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Toolbar: SuperRes Mode 

 
Click on the SuperRes button to enable SuperRes mode.  Click on the Bit Resolution Drop-
down Menu to select the desired bit resolution. 

About SuperRes Mode 
SuperRes Mode allows you to increase the effective resolution of the measurement at the 
expense of signal bandwidth. 

The mathematical operation done as a result of SuperRes selection is that an averaging 
window is defined within a single acquisition.  All samples within the averaging window are 
accumulated, resulting in an effective increase in the sample bits. The averaging window is 
then shifted, over the current acquisition, by its width and the same averaging process is 
performed repeatedly. 

SuperRes allows the user to specify the desired “Effective Resolution.”  For example, you can 
specify 12 bit resolution even if you are using the 8 bit CompuScope 8500. GageScope® will 
automatically perform digital filtering (averaging of oversampled data) to enhance the 
effective resolution at the expense of sample rate. 

For example, in order to provide 12 bits for the CompuScope 8500 (an increase of 4 bits), 
GageScope® has to average 24 = 16 adjacent points, hence reducing the sample rate by a factor 
of 16.  This means that instead of 500 MS/s, the effective sample rate will be 500/16 = 31.25 
MS/s. 

Notes 
• The effective resolution mentioned here is not the same as Effective Number of Bits 

(ENOB). ENOB is a measurement of the Signal-to-Noise Ratio. 

• For more on SuperRes Mode, see page C-68 



C-60 Reference 

System Control 

The System Control is located at the lower left corner of the screen. It contains the control 
settings for CompuScope and CompuGen cards.  

For CompuScope cards, the system control contains the following tabs and settings: 

CS Tab – Page C-62 
The title of the CS tab depends on the model of your CompuScope card.  For example, if you 
have a CompuScope 82G, this tab will display CS82G. 

• Sample rate 
• Single/dual channel mode 
• SuperRes mode 
• External Clock (if available) 

Trigger Tab – Page C-70 
• Trigger source 
• Trigger slope 
• Trigger level 
• Trigger pattern configuration 

Depth Tab – Page C-82 
• Total memory 
• Pre- and post-trigger depth 
• Fine 
• Depth units 
• Timeout (Auto/Normal) 
• Multiple Record (if supported by your CompuScope) 
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Tabs and settings for CompuGen cards are as follows: 

CG 1100 Tab – Page C-95 
• Sample Rate 
• Trigger (Internal/External) 
• Mode (Triggered/Continuous/Burst) 

Out 01 Tab – Page C-100 
• Source Channel 
• Gain 
• Offset 
• Filter 
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System Control: CS Tab: Sample Rate 
The Sample Rate is located in the CS tab of the System Control. 

 

The sample rate sets how many sample points per second should be acquired. A high sample 
rate will result in more sample points acquired per second, resulting in a smooth and accurate 
waveform. A lower sample rate will result in fewer sample points per second, resulting in a 
less smooth signal representation on the screen. 

Changing the Sample Rate 
• To change the sample rate, click on the sample rate drop-down menu and choose a 

sample rate from the list. This menu will differ depending on the model of CompuScope 
card and whether or not it is set to single or dual channel mode.  

For example, a CompuScope 82G can run at 2 GS/s in Single Channel mode, but the 
maximum is 1 GS/s in dual channel mode. GageScope® adjusts the list of available 
sample rates depending on these factors. 

Notes 
• Upon startup, GageScope® sets the sample rate to the highest available. When you switch 

to dual channel mode, GageScope® checks if the sample rate is higher than what is 
possible, and, if necessary, reduces the sample rate. 

• You should normally use a sample rate that is twice (or more) the frequency of the input 
signal. For more information on this topic, see Nyquist Theorem in the Glossary section 
of this manual. 

Obviously, it is preferable to have as many samples per cycle of the input frequency as 
possible.  The industry standard is to have 5 to 8 samples per cycle.  In other words, 
sample rate should be 5 to 8 times the input frequency to get a good representation of the 
signal on-screen. 
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System Control: CS Tab: External Clock 

External Clock appears as an additional entry in the Sample Rate Drop-down menu, located in 
the CS tab of the System Control.   

Please note that External Clock is an optional hardware upgrade on the older CompuScope 
cards and must be purchased from the factory.  If External Clock is not installed on your 
CompuScope card(s), this entry will not be available. 

 

 

GageScope® automatically senses the presence of the External Clock modification on the 
installed PCI bus CompuScope board(s). 

For enabling External Clocking on ISA bus cards, you must provide either of the following 
command line switches prior to running GageScope®: 

/extclk 

or 

/extclkmin=sample_rate_number 

where sample_rate_number is the minimum expected external clock frequency, in Hertz. 
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How it works 
1 Click on the CS tab in the System Control to bring it to the front, if it’s not already 

visible. 

 

2 Click the Sample Rate drop-down menu and scroll down to the bottom of the list to 
ExtClk. 

 

3 The new External Clock options appear on the CS tab. 
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4 Note that when you are in dual channel mode, the Div by field reads 2.  When you are in 
single channel mode, the Div by field reads 1. 

 

5 In addition, the Sample Rate (which is a read-only field when External Clock is enabled) 
in single channel mode is double that in dual channel mode. 

 

6 You can change the external clock rate by typing in the Rate field. 
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7 To disable External Clocking, click on the checkbox to the right of the Sample Rate drop-
down menu.  The regular CS tab will re-appear. 

 

Notes 
• You must have an external clock connected to your system.  If you do not, while you will 

still be able to select External Clock from the Sample Rate drop-down menu, 
GageScope® will display “Waiting” in the Status Bar and a trigger event will not occur. 
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System Control: CS Tab: Channel Mode 
The Channel Mode is located in the CS tab of the System Control. 

 

The Single and Dual Channel Mode buttons allow you to switch between channel modes. 
This feature is not available if your CompuScope card is single-channel only (such as the 
CompuScope 8500) or dual channel only (such as the CompuScope 1602, CompuScope 512 
and CompuScope 512/PCI).  

Changing Channel Modes 
• To change modes, click on the desired button. The current mode is indicated by the 

button that is pressed in. 

Notes 
• Upon startup, GageScope® sets this option to dual channel, if two channels are available 

on your CompuScope card. 

• When you switch to dual channel mode, GageScope® reduces the sample rate if 
necessary. When you switch to single channel mode, GageScope® returns to the sample 
rate which had been set previously in single channel mode. 
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System Control: CS Tab: SuperRes 
SuperRes is located in the CS tab of the System Control. 

 

Click on the SuperRes button to enable SuperRes mode.  Click on the Bit Resolution 
increment/decrement buttons to select the desired bit resolution. 

About SuperRes Mode 
SuperRes Mode allows you to increase the effective resolution of the measurement at the 
expense of signal bandwidth. 

The mathematical operation done as a result of SuperRes selection is that an averaging 
window is defined within a single acquisition.  All samples within the averaging window are 
accumulated, resulting in an effective increase in the sample bits. The averaging window is 
then shifted, over the current acquisition, by its width and the same averaging process is 
performed repeatedly. 

SuperRes allows the user to specify the desired “Effective Resolution.”  For example, you can 
specify 12 bit resolution even if you are using the 8 bit CompuScope 8500. GageScope® will 
automatically perform digital filtering (averaging of oversampled data) to enhance the 
effective resolution at the expense of sample rate. 

For example, in order to provide 12 bits for the CompuScope 8500 (an increase of 4 bits), 
GageScope® has to average 24 = 16 adjacent points, hence reducing the sample rate by a 
factor of 16.  This means that instead of 500 MS/s, the effective sample rate will be 500/16 = 
31.25 MS/s. 

Notes 
• The effective resolution mentioned here is not the same as Effective Number of Bits 

(ENOB). ENOB is a measurement of the Signal-to-Noise Ratio. 
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How it works 
1 Click the SuperRes checkbox to enable SuperRes mode.  Or, you can click on the 

SuperRes button in the toolbar (it should be “pressed in”). 

You will also notice that SuperRes appears in the upper left of the Display Window, next 
to the sample rate. 

2 To change the bit resolution, click on the SuperRes drop-down menu in the toolbar, or 
click on the Increment/Decrement buttons on the CS tab of the System control. 

Note that when you increase the bit resolution, the effective sample rate decreases.  For 
instance, we have raised the bit resolution on our CS2125 to 15 bits and our effective 
sample rate has decreased to 977 kS/s from 125 MS/s. 

 

3 To disable SuperRes mode, click on the SuperRes checkbox in the CS Input tab (so that it 
is unchecked), or click on  in the toolbar (so that it is not pressed in). 
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System Control: Trigger Tab: Trigger Source 
The Trigger Source setting is located in the Trigger tab of the System Control. 

 

The trigger source setting tells GageScope® where to look for a trigger event.  

Click on the trigger source drop-down menu to choose from four settings: 

• Channel 1 
• Channel 2 (if your card has two channels) 
• External (through the External Trigger connector on the CompuScope card, if 

supported by your card) 
• Disabled 

Notes 
• If you have a Multi-Card system installed and the Independent Trigger item is checked 

in the Preferences dialog (accessed via the Tools menu), you can access additional 
trigger sources via the Pattern Dialog.  See page C-74. 

• You can also choose the trigger source via the trigger context menu, by right-clicking on 
the trigger slope icon in the Display Window. 
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System Control: Trigger Tab: Trigger Slope 
The Trigger Slope setting is located in the Trigger tab of the System Control. 

 

The slope icon to the left of a channel in the Display Window indicates the current slope 
setting. 

  means positive slope, i.e., the trigger occurs on the signal’s rising edge. 

 means negative slope, i.e. the trigger occurs on the signal’s falling edge. 

Changing the Slope 
There are three ways to change the slope: 
• In the Trigger tab, click on the desired slope icon. 
• Double-click on the slope icon in the Display Window. 
• Right-click on the slope symbol in the Display Window to bring up the slope context 

menu, then click on either Positive or Negative. 
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System Control: Trigger Tab: Trigger Level 
The Trigger Level setting is located in the Trigger tab of the System Control. 

 

The trigger level is the level in Volts a signal must cross in order for a trigger event to occur. 
For example, if the trigger is set to +1V, and the signal peaks at +900 mV, a trigger event does 
not occur. But if the signal rises to +1.1V, the trigger level will have been crossed, invoking a 
trigger event and subsequent data acquisition.  

 

You may notice that the level of the signal at the trigger line is slightly higher than the level 
set by you.  This is because of trigger hysterisys implemented on CompuScopes which 
protects against triggering on simple electronic noise. 
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In the Display Window, the trigger level is represented by a slope icon to the far left of a 
channel with a dashed horizontal line connected to it. 

The current trigger level value is shown in the Trigger tab next to the Level button. By 
default the trigger level is set to the zero line of channel 1. 

Raising or Lowering the Trigger Level 
• To raise or lower the trigger level directly in the Display Window, drag the slope icon up 

or down.  

• You can also drag the slider located in the Trigger tab.  

Resetting the Trigger Level to Zero 
• To quickly reset the trigger level to 0 mV, click on the Level button. 
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System Control: Trigger Tab: Pattern 
The Pattern setting is located in the Trigger tab of the System Control. 

 

The Trigger Pattern allows configuration of multiple independent triggers.  Trigger source, 
slope and level can be modified, and trigger sources may be added and removed.  Multiple 
triggers are not available for all CompuScope models. 

Windowed Triggering 

Certain CompuScopes support “Windowed Triggering,” meaning that you can set two 
independent trigger conditions which are OR’ed together.  Windowed triggering allows you 
to: 

• Set two different triggers on the same channel  
 

 
 

• Or set one trigger condition on each input of a CompuScope 
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How it works 
1 Clicking on the Pattern button brings up the Advanced Trigger Configuration dialog. 

 

This dialog lists all of the currently specified trigger sources. 

 



C-76 Reference 

Modifying an Existing Trigger Source 
2 To change existing trigger settings, first make sure the trigger source you wish to modify 

is highlighted.  If it is not, click on it. (If there is only one trigger source in your list, there 
is no need to highlight it first.) 

Click Modify.   

 

3 This brings up the Trigger Source dialog. 
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4 To change the Trigger Source, click on the Source drop-down list.  The available trigger 
sources are input signals (“Ch 1,” “Ch 2,” etc.) and “External.”  (Disabled is not available 
from this dialog; to disable a trigger, you must select Disabled from the Source drop-
down menu in the main Trigger tab.) 

 

• Note that on CompuScope 1016, the trigger source can be External only. 

• Note also that if you have a Multi-Card system installed, you will see one trigger 
source for each channel available in your system.  For example, for a three-card 
CS8012A system, there will be six input channel trigger sources available (since 
each CS8012A has two input channels).  If you do not see the right number of trigger 
sources, go to Preferences in the Tools menu and make sure the Independent 
Trigger item is checked.  See page C-42 for details. 

5 To change the Trigger Slope (either positive or negative), click on the Slope drop-down 
list. 
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6 To change the Trigger Level, use the increment/decrement buttons to set a percentage of 
the current input range of the selected trigger source.   

 

For instance, if your Trigger Source is set to Ch 1, and the current input range for Ch 1 is 
±1V, if you select 50%, the trigger level will be set to 500 mV.  If you select -10%, the 
trigger level will be set to -100 mV.  The maximum positive setting is 100%  and the 
maximum negative setting is -100%. 

7 If your Trigger Source is set to External, the Trigger Source dialog looks slightly 
different. 

 

In addition to Source, Slope and Level, this dialog includes the Input Range and 
Coupling settings as well. 

8 Click OK when finished. 
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9 Now click Apply in the Advanced Trigger Configuration dialog to apply the changes.  
Your changes will be updated in the Display Window. 

 

Creating a New Trigger Source 
1 In the Advanced Trigger Configuration dialog, click Add. 
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2 This brings up the Trigger Source dialog with a blank Source field. 

 

3 Now you can proceed as described in “Modifying an Existing Trigger Source” above. 

Note 
• If you have already created two independent triggers and you attempt to add a third, you 

will not be able to select a Trigger Source—the drop-down menu will be blank.  On 
CompuScopes that support multiple independent triggers, you cannot set more than two 
trigger sources. 

Removing a Trigger Source 
1 In the Advanced Trigger Configuration Dialog, highlight the trigger source you wish to 

delete, and click Remove. 
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2 The trigger source will disappear from the list. 

 

Exiting the Trigger Pattern Configuration 
3 To return to the regular Trigger tab, click on the Pattern button so that it is no longer 

pressed in. 
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System Control: Depth Tab: Total 
The Depth Total is located in the Depth tab of the System Control. 

 

The Total field displays the total amount of on-board memory available on the CompuScope 
card.  This value represents the maximum number of samples that can be captured at one time 
using this card. 
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System Control: Depth Tab:  
Pre Trigger and Post Trigger Depth 

The Pre- and Post-Trigger Depth settings are located in the Depth tab of the System Control. 

 

Pre-trigger data is data that leads up to a trigger event. In the Display Window, the pre-trigger 
signal is located to the left of the trigger marker line (the vertical “T” line). 

Post-trigger data is data that follows a trigger event. In the Display Window, the post-trigger 
signal is located to the right of the trigger marker. 

By default, pre- and post-trigger depths are set to 4096 samples. 

Changing the Pre- and Post-trigger Depths 
To change the amount of pre- or post-trigger data, click on the Increment Up  or 
Increment Down  button.  

 

By default, Units is set to samples and Fine mode is on. As such, when clicking on an 
increment button, the depth settings initially change by 64 samples. See Fine Mode and 
Increment Buttons on the following pages for more information on how the depth settings 
are affected by these buttons. 
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You can also type the number of pre- and post-trigger points directly in the dialog box. 
GageScope® will verify that the entry meets the requirements of the hardware and will correct 
it, if necessary. 

Disabling Pre-trigger Depth 
If the Pre-Trig button is enabled, pre-trigger capture is on. To turn off pre-trigger capture, 
click on the Pre-Trig button. 
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System Control: Depth Tab: 
Fine Mode and Increment Buttons 

The Fine Button is located in the Depth tab of the System Control. 

 
 

When Fine Mode is enabled, changes to depth settings occur in increments of 64 samples. 
When Fine Mode is off, changes occur in increments of 640 samples. 

Fine Mode is enabled by default. 

 

System Control: Depth Tab: Units 
The Depth Units field is located in the Depth tab of the System Control.   

 
 

The unit is always set to Samples. 
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System Control: Depth Tab: Auto / Normal 
The Auto/Normal setting is located in the Depth tab of the System Control. 

 

The Auto setting is the amount of time GageScope® waits for a trigger event to occur. The 
default setting is 10 ms.  

If the Auto button in the Depth tab is pressed in, it is enabled.  If it is not pressed in, it reads 
Normal. 

When a timeout occurs in Continuous Mode, the message Ready appears in the status bar on 
a yellow background.  Timeout is automatically disabled in One Shot Mode. 

Disabling the Timeout 
To disable the timeout, click on the Auto button so that it reads Normal. 
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Setting a Timeout 
1 Enable the timeout (make sure the button reads Auto and is pressed in). 

2 Click in the Auto field. 

3 Press Backspace or Delete to erase the existing value. 

4 Enter a new value followed by a unit of measurement. For example, type in 1 ms for 1 
millisecond. You can also use s for seconds. Use only lowercase letters. 

How Timeout Affects Capture Modes 
In the event of a timeout while in Continuous capture mode, GageScope® forces a software 
trigger, i.e., it triggers immediately upon timeout, acquires the current signal, then resets the 
CompuScope card to await another trigger event.  

When you change to One Shot capture mode, timeout is automatically disabled. When you 
change back to Continuous capture mode, timeout is automatically set back to the value it had 
before you entered One Shot capture mode. 
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System Control: Depth Tab: Multiple Record 
The Multiple Record setting is located in the Depth tab of the System Control. 

 

Multiple Record takes advantage of the CompuScope card’s deep memory buffers by 
allowing the hardware to stack captures in on-board memory, so that many small acquisitions 
can occur in a very short amount of time, with near-zero re-arm time. This feature is 
invaluable in applications in which trigger events are happening rapidly or unpredictably and 
A/D down-time must be minimized. 

When Multiple Record is enabled, the CompuScope card looks for a trigger event, acquires 
post-trigger data and automatically re-arms itself to look for another trigger event. Data 
collected from each successive acquisition is “stacked” on top of the previous acquisition 
until the on-board buffer fills up.  

For example, if a post-trigger depth of 1024 points is specified, the first acquisition stores data 
in addresses between 0 and 1023, the next acquisition from 1024 to 2047, and so on until the 
buffer is full.  

Important Notes 
• The number of records you can capture will depend on the amount of on-board memory 

your CompuScope card has, as well as other settings, such as the post-trigger depth and 
channel mode. 

• With all currently available CompuScopes, you can only capture post-trigger data in 
Multiple Record mode. When you click on the MulRec button, pre-trigger capture is 
disabled.  

• Multiple Record comes as a standard feature or as an option on most CompuScope cards, 
but is not available on the CompuScope LITE. If your CompuScope card does not have 
this capability, the MulRec button will not be available. 
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Performing a Multiple Record Capture 
1 Click on the MulRec button to enable Multiple Record. Multiple Record is enabled if its 

button is pressed in. 

 

2 GageScope® automatically captures the post-trigger data for as many records as possible, 
depending on the current channel mode, sample rate, and post-trigger depth settings.  

Note:  If your CompuScope hardware supports this feature, you can also set the desired 
number of records to be captured. 

The number of records will be reflected in the Display Window underneath the channel 
number at the left. For example, if 31 records are captured as in our example, you will 
see “1 of 31” displayed underneath “Ch 1.” 
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Viewing the Multiple Record Data 
1 To move from record to record, click the Multiple Record Playback buttons located in the 

toolbar. 

 

Note that the toolbar buttons will always cycle through all channels at once. 

2 You can also use the Record Increment/Decrement buttons on the Trace tab of the 
Channel Control. 

 

With these buttons, you can cycle through the records of all channels at once (if the All 
Channels tab is current), or through the records of individual channels (if an individual 
channel tab is current).   

Remember that you can always set all channels to the first record with the  button in 
the toolbar. 
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Viewing All Records of the Acquisition Simultaneously 
1 To view all records in the acquisition at once, click with the left mouse button in the 

Record field and type 0 (zero). 

 

2 Press Enter.  The 0 will change to All. 
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3 The display will now show all of your records at once.  To the left of the slope icon and 
below “Ch1” and “Ch2” on the screen below, notice the message “All of 31,” indicating 
that all 31 records are being displayed. 

 

Notes 
• The View All Records command is available whether the All Channels tab or an 

individual channel tab is current.  If the All Channels tab is current, as it was in our 
example above, you will see all records of all current channels.   

• If you wish to see all records of Channel 1, for example, but only a specific record of 
Channel 2, make sure the proper channel tab is current when you are changing the 
Record field in the Trace tab of the Channel Control. 
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“Transferring” Message in the Status Bar 

When you are in Continuous Capture mode (the  button in the toolbar is “pressed in”) and 
Multiple Record mode is enabled, you may see the message “Transferring” in the Status bar. 

 

This means that GageScope® is transferring data from the CompuScope board to the internal 
buffers of the application. 

Saving a Multiple Record Channel 
1 You can save a Multiple Record channel just as you would any other channel—by 

clicking Save Channel in the File menu, by clicking  in the toolbar, or by right-
clicking with the mouse on the zero line of the channel display. 

2 The Save Channel dialog appears. 

3 Type a name for the file and select the channel to be saved from the Channel drop-down 
list. 

4 By default, only the current record is saved.  However, there are several options for 
saving a Multiple Record acquisition: 

• The Split MulRec checkbox (checked in the sample screen above) allows you to 
save each record of your Multiple Record acquisition as an individual file.  If this 
box is not checked, the entire acquisition will be saved to one file. 

• To save all of the records in the acquisition to one file, make sure that all records are 
visible onscreen by following the steps under the heading Viewing All Records of 
the Acquisition Simultaneously.  Then, save the file as usual.  

• You can save only the visible portion of the channel by checking the box at the 
bottom of the Save Dialog (just as you can with a non-Multiple Record acquisition).

5 Click Save when you have specified all of the options you wish. 

Loading a Multiple Record Channel 
1 You can also load a Multiple Record channel as you would any other channel—by 

choosing Load Channel from the File menu or by clicking  on the toolbar.  

2 The Load Channel dialog appears. 
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3 Click on one of the files to select it, and press Open. 

 

Our signal file has been loaded as Ch 3, in between Ch 1 and Ch 2. 
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System Control: CG1100 Tab: Sample Rate 
The CG1100 tab in System Control contains the Sample Rate setting:  

 

The Sample Rate specifies the number of sample points to be generated per second. The total 
number of sample points to be generated is specified in the AWG Input tab of Channel 
Control.  Refer to the channel control section of this chapter for further details. 

Changing the Sample Rate 
• To change the sample rate, click on the sample rate drop-down menu and choose a 

sample rate from the list.  

For example, CompuGen 1100 can generate at the maximum rate of 80MS/s:  

 

and a minimum of 1KS/s:  
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Notes 
• Upon launch, GageScope® sets the sample rate to the highest available. Therefore in case 

a CompuGen 1100 is present in the system, you will notice that a sample rate of 80MS/s 
shows up as a default whenever the CG1100 tab is selected. 

• To select an External Clock for your CompuGen 1100, you must choose Ext Clock from 
the sample rate drop down list. 
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System Control: CG1100 Tab: Trigger 
The Trigger setting is located in the CG1100 tab in System Control: 

 

The Trigger Setting indicates the type of triggers available to a generator card. As shown in 
the figure above, CompuGen 1100 can be triggered either internally or externally. 

Internal Trigger 
1 Internal triggering shows up as the default option when the CG1100 tab is selected. This 

is depicted in the figure shown above. 

2 Note that when internal trigger option is selected, the GageScope® Screen indicating that 
the card is being internally triggered. 

External Trigger 

3 External triggering option can be selected by pressing the Ext. command button in the 
Trigger Group. This is shown in the figure below: 

 

 
2   
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System Control: CG1100 Tab: Mode 
The Mode setting is located in the CG1100 tab in System Control: 

 

The Mode Setting governs the manner in which the data is going to be uploaded to the 
CompuGen card.  Following choices are available: 

Modes 

• Triggered In Triggered mode, the displayed waveform pattern is output from 
the CompuGen only once after a trigger event has been received.  

• Continuous In Continuous mode, the displayed waveform pattern is output from 
the CompuGen in an endless loop.  

Note that Continuous is the default Mode setting. 
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• Burst In Burst mode, the displayed waveform pattern is output from the 
CompuGen an exact number of times. 

Left click the command button with Caption Burst. The button will 
look pressed in. The text box can now be used to enter the number of 
sequences to be generated. 

 

Note that the default number of samples to be uploaded is 2. You can 
change the value in the text box by either directly entering the 
desired number of sequences or by using the increment and 
decrement buttons at the right end of the text box. 
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System Control: Out 01 Tab: Source 
The Source setting is located in the Channel Number tab in System Control: 

 

Source Settings refer to the display channel number that will be used to generate the desired 
waveform on the output Channel, labeled as Out 01. The Source is linked to the display 
channel containing the waveform created in GageScope.   

 

Selecting a Source Channel 

1 Click on the down arrow to view the drop down Source list: 
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2 Select Out 01 from the list to choose channel 1 as a Source Channel for signal 
generation. Out 01 now appears as the source channel in the Source text box.  

 
 

Note that a waveform has already been created in GageScope® and is represented as Out 
01. This is the source waveform that shows up as Out 01 in the Source drop down list. 
You will only see None in the drop down list if no AWG Channel exists. We are 
assuming at present that there is at least one AWG channel, Out 01, available to be 
uploaded to the generator.  

Several options exist for creating waveforms in GageScope. The controls associated with 
the user defined, predefined or standard waveform generation, are part of the AWG 
Input tab in the Channel Control. Refer to Channel Control section of this manual to 
obtain further details about the AWG Input options. 
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System Control: Out 01 Tab: Gain 
The Gain setting is located in the Channel Number tab in System Control: 

. 

The Gain Setting imparts the user ability to change the output gain of the signal to be 
generated. Following Gain settings are available: 

• ±  5 Volts 

• ±  2 Volts 

• ±  1 Volts 

• ±  200 milli Volts 

• ±  100 milli Volts 

Selecting a Gain Value 

1 Click on the down arrow in the text box associated with label Gain, to view the drop 
down list: 

 
 
Note that +/- 5V appears as a default Gain setting. 
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2 To change the Gain to be +/- 2V, select the corresponding value from the list: 

 

Note that Ch 01 displayed in GageScope® contains the waveform to be generated.  

3 Click anywhere in the user interface or double click on your select to appear in the 
Gain text box. 
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System Control: Out 01 Tab: Offset 
The Offset setting is located in the Channel Number tab in System Control: 

 

The Offset Setting allows the user to enter the DC Offset in milli Volts for the output signal to 
be generated by the arbitrary waveform generator. Offset is linked to the Offset setting in the 
Channel Control property page.  
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System Control: Out 01 Tab: Filter 
The Gain setting is located in the Channel Number tab in System Control: 

 

The Filter Setting allows the user to filter the output to be generated by the arbitrary 
waveform generator. A 20MHz filter, for example, means that all frequencies above 20 MHz 
will not be present in the output. Three settings are currently available for CompuGen 1100: 

• No Filter 

• 20 MHz Filter 

• 5 MHz Filter 

Selecting a Filter Value 

1 Click on the down arrow in the text box associated with label Filter, to view the drop 
down list: 
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2 To change the Filter frequency to be 20MHz, select the corresponding value from the list 
and double click: 
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Display Control 

The Display Control contains options for changing the look of the current display, such as the 
timebase and channel enable/disable, along with display element properties such as grid color. 
Display settings do not affect the captured data. 

The Display Control contains the following tabs and settings: 

General Tab – Page C-108 
• Timebase 
• Channel list and visibility 

Settings Tab – Page C-110 
• Grid Button 
• X Axis Button 
• Y Axis Button 
• Persistence Button 
• Trigger Level Button 
• Zero Lines Button 
• Display Window Background Color 
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Display Control: General Tab: Timebase 
The Timebase setting is located in the General tab of the Display Control. 

 

The Timebase is a display function only and is measured in time per division, a division being 
one square in the grid in the Display Window. For example, a timebase of 5us/d equals five 
microseconds of data per division. 

• To increase the timebase, click . 

• To decrease the timebase, click . 

Notes 
• Changes to the timebase affect all channels in the current Display Window. The size of 

the bar in the horizontal scroll bar is also affected. 

• It is possible to set the timebase to any value; however, if there is a timebase conflict with 
the minimum display requirements, the timebase will be changed to the smallest timebase 
value that does not conflict at display time. 

• If you want to see the same set of signals using different timebases, simply create a new 
display, select the channels you want displayed, and set the timebase to the desired value.  
If you tile the two Display windows, you will be able to see the same signals with 
different timebases. 
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Display Control: General Tab: Channel List 
The Channel List is located in the General tab of the Display Control. 

 

The Channel List shows all channels currently available, including channels loaded from disk 
and channels created mathematically. The icon next to each channel indicates the channel’s 
type. 

 indicates that the signal originates from an input of a CompuScope card. 

 indicates that the channel has been loaded from disk. 

 indicates that the channel has been created mathematically. 

If more than three channels are available, a vertical scroll bar appears, allowing you to move 
up and down the list. 

Hiding and Showing Channels using the Channel List 
The checkbox next to each channel in the list indicates the channel’s visibility. A checkmark 
means a channel is visible; lack of checkmark means a channel is hidden. To toggle a 
channel’s visibility, click on this checkbox. 

Hiding and Showing Channels directly in the Display Window 
1 Position the mouse pointer on a blank area of the Display Windows, i.e., where there is 

no signal. 

2 Click on the right mouse button to bring up the Display Window context menu. 
A checkmark next to a channel number indicates it is currently visible. 

3 Click on Ch 1 to hide or show channel 1, Ch 2 for channel 2, etc. 
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Display Control: Settings Tab: Grid Button 
The Grid button is located in the Settings tab of the Display Control. 

 

The grid is a set of vertical and horizontal lines drawn at regular intervals in the Display 
Window. The resulting grid has 8 squares from top to bottom and 10 squares from left to 
right. Each square is counted as a “division” and is used as a reference in other parts of 
GageScope® (such as the Position setting in the Parameter tab of the Channel Control). The 
grid is a permanent fixture in the Display Window and is not affected by movement of the 
scroll bar. 

To toggle the grid on and off, click on the Grid button. You also have the option of changing 
the color of the grid by clicking on the Color button next to the Grid button. 

The Grid may not be that noticeable as the default Grid color is a subtle gray. To make the 
grid stand out more, change its color to white by clicking on the grid’s Color button. 
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Display Control: Settings Tab: X Axis Button 
The X Axis button is located in the Settings tab of the Display Control. 

 

The X axis is a dashed horizontal line that divides the Display Window into two equal parts. 
The X Axis is a permanent fixture in the Display Window and does not move with changes to 
the vertical scroll bar.  

To toggle the X axis on and off, click on the X Axis button. You also have the option of 
changing the color of the X axis by clicking on the Color button next to the X Axis button. 

 

 

 



C-112 Reference 

Display Control: Settings Tab: Y Axis Button 
The Y Axis button is located in the Settings tab of the Display Control. 

 

The Y Axis is a dashed vertical line that divides the Display Window into two equal parts. The 
Y Axis is a permanent fixture in the Display Window and does not move with changes to the 
horizontal scroll bar.  

To toggle the Y axis on and off, click on the Y Axis button. You also have the option of 
changing the color of the Y axis by clicking on the Color button next to the Y Axis button. 
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Display Control: Settings Tab: Persistence 
The Persistence button is located in the Settings tab of the Display Control. 

 

 

The Persistence setting allows the user to control the persistence of the signal display in the 
Display Window. 

How it works 

1 By default, Persistence is disabled.  The button underneath Persistence reads None.  To 
enable persistence, click on None. 
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2 The Persistence field appears, allowing editing of the length of time that the signal will 
persist on the screen.  The default value is 0.5s. 

 

To change the degree of persistence, click on the Persistence increment/decrement 
buttons to change the time value. 

3 Or, click on the Infinite checkbox for infinite persistence.  This is equivalent to clicking 
the Overdraw Mode button in the toolbar. 

 

4 An Erase Display button becomes available in the toolbar when Persistence mode is 
turned on. 

 

Use this button to clear the display. 
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5 To disable Persistence Mode, click on the Persistence field so that it reads “None.” 
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Display Control: Settings Tab: Trigger Lines Button 
The Trigger Lines button is located in the Settings tab of the Display Control. 

 

The trigger line is shown as a dashed horizontal line with a slope icon to the far left of a 
channel.  The trigger line indicates the level the trigger signal must cross in order for a trigger 
event to occur. By default the trigger level is set to the zero line of channel 1. 

To toggle this line on and off, click on the Trigger Lines button. The color of the Trigger Line 
is always set to the same color as the channel it is set to trigger on. For more information on 
the Trigger Lines, see page C-72. 
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Display Control: Settings Tab: Zero Lines Button 
The Zero Lines button is located in the Settings tab of the Display Control. 

 

The zero line of a channel is the dashed horizontal line that runs near the middle of the signal, 
and indicates the 0 Volts reference. To toggle the zero lines on and off, click on the Zero 
Lines button. 

The color of a Zero Line is always set to the same color as its channel. 
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Display Control: Settings Tab: 
Background Color Button 

The Background Color button is located in the Settings tab of the Display Control. 

 

Click on the Back Color button to change the background color of the Display Window. By 
default the background color is set to black. 
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Channel Control 

The Channel Control contains options for changing the settings of individual channels, such 
as position, vertical scale, color, coupling, and polarization. When changing channel settings, 
make sure the changes are being made to the intended channels by clicking on the appropriate 
channel tab at the bottom of the control. 

 

 

The All Channels tab allows you to control certain settings for all current channels 
simultaneously.  These settings are: 

• Vertical Scale 
• Polarization 
• Current Record Number in Multiple Record Mode and AutoSave 
• Connect Dots 
• Input Range 
• Probe 
• Coupling 
• Impedance 
• Null Channel Input 
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The channel control contains the following tabs and settings: 

Subchannel Tab – Page C-122 
• Starting and Ending of the Subchannel 
• References 
• Start and End Offset 

Averaging Tab – Page C-128 
• Acquisitions 
• Average on Multiple Record 
• Averaging vs. Co-adding 
• Intermediate results 
• Running Average 

CS Input Tab – Page C-135 
• Input Range 
• Probe 
• Coupling 
• Impedance 
• Null Channel Input 
• Decimation 

Trace Tab – Page C-142 
The options available on this tab vary depending on whether the All Channels tab or an 
individual channel tab is current.  The list below contains all of the possible options. 

• Vertical Scale 
• Position 
• Connect Dots 
• Method 
• Polarization 
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Drawing Tab – Page C-151 
This tab is not available when the All Channels tab is current.  Drawing tab elements apply to 
individual channels only. 

• Method 
• Connect dots 
• Format 
• Color 
• Align by Start (available only when a channel is loaded which does not cross the Trigger 

Marker) 
• Align by Trigger (available only when a channel is loaded which does not cross the 

Trigger Marker) 

AWG Input Tab – Page C-160 
• Duration 
• Equation 
• Ampl 
• Offset 
• Waveform 
• Duty 
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Channel Control: Subchannel Tab: Start 
The Start setting is located in the Subchannel tab of the Channel Control. 

 

Start This setting allows the user to select an appropriate reference for the starting 
point of the Subchannel. 
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Channel Control: Subchannel Tab: End 
The End setting is located in the Subchannel tab of the Channel Control. 

 
 

 End Allows you to select the ending point of the subchannel with respect to a selected 
reference. 
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Channel Control: Subchannel Tab: Reference 
The reference is located in the Subchannel tab of the Channel Control. 

 

The references are available both for the Start and End. This allows the user to select any 
portion of the acquired channel with relative ease and flexibility. Following options are 
available from the drop down menu: 

Src Start is the first sample point of the source channel which can be used as a 
reference for the subchannel signal starting and ending samples. Source 
signal refers to the original channel to be subchanneled. 

Trigger refers to time when the trigger event occured. The selected subchannel can 
be referenced to the trigger.  

Src. End is the last point of the source signal. The first and the last sample points of 
the subchannel can be referenced to the end of the source signal. 

Rise specifies the selected rising edge to be the starting reference 

Fall specifies the selected falling edge to be the starting reference 

Edge specifies the selected rising or falling edge to be the starting reference 

Peak specifies the selected peak to be the starting reference 

Trough specifies the selected trough to be the starting reference. Trough is the valley 
in a sine wave. 
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Figure below shows all the available references 

  

Shown below is the first peak taken as the starting reference while the fifth peak is chosen to 
be the end reference. Note that any combination of these references can be used to select the 
Subchannel. 
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Channel Control: Subchannel Tab: Offset 
The offset setting is located in the Subchannel tab of the Channel Control. 

 

Offset The number entered in this box specifies the first sample of the subchannel 
displaced with respect to the selected reference. This is the case when the offset 
appears in the Start dialog area. 

When a number is entered in this field in the End dialog area, the last sample of 
the subchannel will be selected with respect to the reference. 

The figure below shows the Start and End Offsets for the available references: 

• The Source Start Reference 
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• Trigger Reference 

 

• Source End Reference 

 

See the Tutorial Section of this manual for further details on Subchanneling. 
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Channel Control: Averaging Tab: Count 
The Count setting is located in the Averaging tab of the Channel Control. 

 

The number in the Count field specifies the number of averages to be performed by the 
GageScope®. The default number of averages is 1.  

To change the number of count, do one of two things: 

• Click on the increment/decrement buttons to change the value 
• Click in the Counter field, press Backspace to erase the current value, and type in a new 

value. 

For more details on Count, see Averaging tool on page C-191. 
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Channel Control: Averaging Tab: Start 

The Start setting is located in the Averaging tab of the Channel Control. 

 

The Start setting specifies the first sample of the averaged region relative to the trigger 
position. For a selected portion of the acquisition to be averaged, the user can select the 
starting point of the signal by entering a number in this field.  

For more details on Start, see Averaging tool on page C-191. 



C-130 Reference 

Channel Control: Averaging Tab: Depth 
The Depth setting is located in the Averaging tab of the Channel Control. 

 

The Depth setting specifies the total length of the signal to be averaged. Use the increment 
buttons to set the desired length.  

For more details on Depth, see Averaging tool on page C-191. 
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Channel Control: Averaging Tab: MulRec 
The Multiple Record setting is located in the Averaging tab of the Channel Control. 

 

The Multiple Record setting with the Average radio button selected, specifies the type of 
averaging to be performed when Multiple Record mode is enabled. 

When in Multiple Record mode, averaging can be performed in one of the following ways: 

• A single “MulRec” record can be used to produce a single averaged non-MulRec record.  
This method is best when the incoming signals are non-repetitive, such as in Imaging 
applications. 

• A specified number of MulRec records can be averaged to produce a single averaged 
record.  This method is best for applications like Mass Spectrometry, where the signals 
are highly repetitive. 

• The running average of any single “MulRec” record can be accomplished. 

Note 
When Mulrec is checked, the Record Counter disappears from the Trace tab of the Channel 
Control. 

For more details on Averaging, see Averaging tool on page C-191. 
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Channel Control: Averaging Tab: Average vs. CoAdd 
The Average and CoAdd settings are located in the Averaging tab of the Channel Control. 

 

When Averaging is enabled, the first point of the first acquisition is added to the first point of 
the second, third, fourth..., nth acquisition to produce the first point of the “Result.”  The same 
is done for all other points in the record.  

Users are provided an option to either average or simply co-add the data.  

• Averaging:  The result is divided by “n.” 
• Co-Adding: No division is done on the result.  The data resulting from co-adding is 32 

bit data. 

For more details on Averaging, see Averaging tool on page C-191. 
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Channel Control: Averaging Tab: Intermediate Results 
and Reset 

The Intermediate Results and Reset settings are located in the Averaging tab of the Channel 
Control. 

 

When acquisitions are co-added, the Averaging tool allows the user to request the display of 
intermediate results. This means that GageScope® will display the results while it performs 
the adding process, rather than displaying just the final result. 

• To display intermediate results, click the Intermediate Results check-box. 

• By clicking the Reset button, the Averaging or the CoAdding procedure starts all over 
again. 

Notes 
• Please note that display of Intermediate Results may slow the co-adding process. 
• For more details on Averaging, see Averaging tool on page C-191. 
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Channel Control: Averaging Tab: Running 
The Running average settings are located in the Averaging tab of the Channel Control. 

 

The running average is performed on the acquisitions. The N most recent acquisitions are 
averaged and the result is stored in the results channel. 

This option is also available for the MulRec channels, however, only one MulRec channel can 
be averaged at a time.  

Notes 
• The maximum number that can be entered for the Count in the Running average mode is 

256 in the GageScope® Professional Edition. The Running average is not available in the 
Standard Edition of GageScope®. 

• For more details on Running, see Averaging tool on page C-191. 
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Channel Control: CS Input Tab: Input Range 
The Input Range setting is located in the CS Input tab of the All Channel Control. 

 

 

The input range defines the range in volts the CompuScope card should measure when 
converting analog signals. For example, if the input range is set to ±1 V, then a signal that 
reaches 900 mV will be captured in its entirety, while the peaks of a signal measuring 1.1 V 
will be cut off or clipped. 
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Changing the Input Range 

1 Click on the CS Input tab of the Channel Control. 

2 Click on the Input Range drop-down list. 

3 Select a value from the list. 

Notes 
• The list that appears in the input range will depend on the type of CompuScope card 

being used. 

• The input range for the CompuScope 1016 is fixed at ±2V, so if you are using this 
card you will not be able to change this setting. 

Note that Input Range is not linked to the Vertical Scale setting, unless you 
select Scope Mode. 

We have decoupled vertical scale from the input range in order to allow you to take advantage 
of the high vertical resolution offered by CompuScope cards.  You can capture a signal with 
±1V range and still view it with a vertical scale of 50 mV/div. 

All digital oscilloscopes on the market are limited to 8 bit resolution and can digitize the 
signal with 256 levels only.  This way, they can fit all 256 pixels on screen.  CompuScopes, 
which offer up to 16 bit resolution, digitize the signal with up to 65,536 levels.  There is no 
screen in the world that can display that many pixels.  Hence, the ability to display only a 
portion of the capture signal’s dynamic range is necessary. 

If, however, you are more familiar with the traditional linkage of vertical scale and input 
range, simply select Scope Mode. 
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Channel Control: CS Input Tab: Probe 
The Probe setting is located in the CS Input tab of the All Channel Control. 

 

 

The Probe setting is used to define the gain of the oscilloscope probe used to capture external 
signals.  The available values are ±1V, ±2V, ±5V, ±10V, ±20V, ±50V, ±100V, ±200V, ±500V, 
±1000V, ±2000V and ±5000V. 

It should be noted that GageScope® does not read the probe settings used.  It is entirely up to 
the user to enter the correct probe setting. 

Changing the Input Range 

1 Click on the CS Input tab of the Channel Control. 

2 Click on the Probe drop-down list. 

3 Select a value from the list. 
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Channel Control: CS Input Tab: Coupling 
The Coupling setting is located in the CS Input tab of the All Channel Control. 

 

By default GageScope® sets all channels to DC coupling. This option will not be available if 
your CompuScope card does not support this feature. 

Toggling the Coupling via the Channel Control 
1 Click on the CS Input tab in the Channel Control. 

2 To change to AC coupling, click on the AC button. To change back to DC coupling, click 
on the DC button. 

Toggling the Coupling via the Channel Context Menu 
1 Position the mouse pointer on a channel’s zero line. The channel will turn white to 

indicate that it has the current focus. 

2 Click on the right mouse button to bring up the channel context menu. 

3 Click on Coupling with the left mouse button. The Coupling sub-menu appears. The 
current setting has a bullet next to it. 

4 Click on AC or DC. 

Notes 
• This setting will not be available if you are using a CompuScope 1016, as this card is 

DC only. 

• For most CompuScope cards, only DC coupling is available when impedance is set 
to 50 Ohm. 
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Channel Control: CS Input Tab: Impedance 
The Impedance setting is located in the CS Input tab of the All Channel Control. 

 

By default GageScope® sets all channels to 1 MOhm impedance. This option will not be 
available if your CompuScope card does not support this feature.  

Changing the Impedance 
1 Click on the CS Input tab in the Channel Control. 

2 To change to 50 Ohm impedance, click on the 50 Ohm button. To change to 1 MOhm 
impedance, click on the 1 MOhm button. 
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Channel Control: CS Input Tab: Null Channel Input 
The Null Channel Input setting is located in the CS Input tab of the All Channel Control. It 
also appears in the CS Input tab of the individual channel control. 

 

Click the Null Channel input command button, , to activate this feature. In the 
activated state the button will appear disabled: 

 

When clicked, the Null Channel Input button will force recalibration of the hardware taking 
the average value of the current input as a new reference for the zero level. 

Notes 

• Changing hardware settings such as sample rate, acquisition mode or input range 
will cancel the previously issued Null Channel Input command. Changing 
impedance or coupling will not change the calibration of the card however it can 
affect captured data and may require recalibration. 
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Channel Control: CS Input Tab: Decimation 
The decimation setting is located in the CS Input tab of the Channel Control.  

 

Decimation is a feature by virtue of which a user can view large amounts of acquired data 
within GageScope.   

Click on the Decimation command button view the Decimation dialog box: 

 
The settings in the decimation dialog box and the deep memory buffer size setting in the 
Preferences dialog box, controls the decimation procedure.  

Refer to the Tutorial section of this manual for a detailed explanation of how to use the 
decimation features. 
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Channel Control: Trace Tab: Vertical Scale 
The Vertical Scale setting is located in the Trace tab of the Display Control.  

 

This setting is available whether the All Channels tab or an individual channel tab is current. 

The vertical scale of a channel is measured in terms of Volts per division, a division equaling 
one square in the grid. (For more information on the grid, see page C-110.) 

Changing the Scale 
1 Click on the Trace tab in the Channel Control. 

2 • To increase the scale, click . This shrinks the signal. 

• To decrease the scale, click . This makes the signal taller. 
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Notes 
• The default vertical scale is 1V/div. In other words, for every 1V of signal, 

GageScope® shows 1V per grid square. If you increase the vertical Scale to 2V/div, a 
1V signal displays as half of one grid square. If you decrease the vertical scale to 
500mV/div, a 1V signal displays at the height of two grid squares. 

• If you increase the vertical scale so that the signal peaks go off screen, you can use 
the vertical scroll bar to scroll up or down to reach the peaks. 
 

Note that Input Range is not linked to the Vertical Scale setting, unless you 
select Scope Mode. 

We have decoupled vertical scale from the input range in order to allow you to take advantage 
of the high vertical resolution offered by CompuScope cards.  You can capture a signal with 
±1V range and still view it with a vertical scale of 50 mV/div. 

All digital oscilloscopes on the market are limited to 8 bit resolution and can digitize the 
signal with 256 levels only.  This way, they can fit all 256 pixels on screen.  CompuScopes, 
which offer up to 16 bit resolution, digitize the signal with up to 65,536 levels.  There is no 
screen in the world that can display that many pixels.  Hence, the ability to display only a 
portion of the capture signal’s dynamic range is necessary. 

If, however, you are more familiar with the traditional linkage of vertical scale and input 
range, simply select Scope Mode. 
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Channel Control: Trace Tab: Position 
The Position setting is located in the Trace tab of the Channel Control.  

 

This setting is available only if an individual channel tab is current (i.e., Ch1, Ch2…). 

The position of a channel is measured in terms of divisions relative to the X axis, a division 
equaling one square in the grid.  

It should be noted that changing the “position” of a channel only changes the display offset 
for that channel:  no hardware offset is induced due to position changes. (For more 
information on the grid, see page C-110.) 

Moving a Channel via the Position Buttons 
1 Click on the Trace tab in the Channel Control. 

2 • To raise a channel, click on . 

• To lower a channel, click on . 

Moving a Channel Directly in the Display Window 
1 Position the mouse pointer on a channel’s zero line. The channel will turn white to indicate 

that it has the current focus, and the mouse pointer will change to a drag pointer. 

2 Hold down the mouse button. 

3 Move the mouse up or down. 
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Notes 

• If you have one channel available upon startup, GageScope® places this channel at 0.0 
divisions (in other words, on the X Axis). If you have two channels available at startup, 
GageScope® places channel 1 at 2.0 divisions and channel 2 at –2.0 divisions. 

• To re-arrange the position of all channels quickly, use the Arrange Channels button in the 
toolbar. 
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Channel Control: Trace Tab: Connect Dots 
The Connect Dots button is located in the Trace tab of the Channel Control.  

 

This setting is available only if the All Channels tab is current.  If an individual channel tab is 
current, the Connect Dots setting appears under the Drawing tab. 

By default GageScope® draws a line between each sample point in order to display a 
continuous waveform. To have GageScope® display as single points, you can turn off the 
Connect Dots setting. 

Toggling the Connect Dots Button 
1 Click on the Trace tab of the Channel Control (make sure the All Channels tab is 

current). 

2 Click on the Connect Dots button to toggle this option on and off.  
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Channel Control: Trace Tab: Method 
This setting is located in the Trace tab of the Channel Control.  

 

This setting is available only if the All Channels tab is current.  If an individual channel tab is 
current, the Method setting appears under the Drawing tab. 

The Method setting defines how GageScope® displays traces based on the acquired data. The 
options are Mean and MinMax. 

MinMax When two or more samples are to be displayed on the same screen pixel 
column, MinMax will plot the minimum and maximum values, then draw a 
line between them. This method allows glitch detection even at very low 
timebases. 

  This is the default setting. 

Mean When two or more samples are to be displayed on the same screen pixel 
column, Mean will plot the average of the samples. In display terms, the Mean 
method reduces the apparent signal noise when capturing slow signals at high 
sample rates and then displaying many points on the screen.  The Mean display 
method allows over-sampled data to be digitally filtered before display, thereby 
improving the signal to noise ratio. 

Changing the Method via the Trace Tab 
1 Click on the Trace tab of the Channel Control. 

2 Click on the Method drop-down list. 

3 Select a method from the list. 
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Channel Control: Trace Tab: Polarization 
The Polarization setting is labeled “Invert” and is located in the Trace tab of the Channel 
Control.  

 

This setting is available whether All Channels or an individual channel is current. 

Polarization refers to how the trace is displayed relative to the X axis. When polarization is 
normal, the channel is displayed exactly as captured. Inverting the polarization inverts the 
signal about the X axis for Display purposes only, without affecting the actual data. 

If a channel is inverted, the color of the channel identifier at the far left of the signal will be 
reversed as well. For example, if channel 1 is inverted and its color is yellow, then the channel 
identifier will be black text in a yellow box. 

Toggling the Polarization via the Trace Tab 
1 Click on the Trace tab in the Channel Control. 

2 Click on the Invert button to toggle this option on and off. If  the Invert button is 
enabled, polarization is inverted; otherwise it is normal.  

Changing the Polarization via the Channel Context Menu 
1 Position the mouse pointer on a channel’s zero line. The channel will turn white to 

indicate that it has the current focus, and the mouse pointer will change to a drag pointer. 

2 Click on the right mouse button to bring up the channel context menu. 

3 Click on Invert to toggle this setting. If  Invert has a checkmark next to it, polarization 
is inverted; otherwise it is normal.  
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Channel Control: Trace Tab: Units 
The Units setting is labeled “Unit” and is located in the Trace tab of the Channel Control.  

 

Engineering units are now available in GageScope.  This feature allows the user to specify a 
conversion factor and a base units text string for each channel.  The factor must be entered in 
base units (e.g. A or Pa) and not in derived units (e.g. mA or kPa). GageScope® will 
automatically perform metric scaling.  

How To Invoke the Engineering Units 
1 Click on the Units tab in the Channel Control. The Engineering Units dialog box 

appears: 

 

 



C-150 Reference 

2 Assume that the user has his CompuScope connected to a thermocouple that produces a 
40 microVolt DC voltage for every 1 degree Celsius change in temperature. In this case, 
the user would enter "C" as the Units text string.  The conversion Factor would be:  1 / 
(40 x 10^ -6) = 25000.   

Enter 25000 for the Factor and C for the Units in the respective text boxes.  

 

3 Click OK.  You will notice that the Vertical Scale now measures in degree Celsius.   

 

Note that depending on the conversion factor, you may have to use the amplitude 
expansion or contraction buttons to view the signal properly. 
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Channel Control: Drawing Tab: Method 
The Method button is located in the Drawing tab of the Channel Control. 

 

The Drawing tab is not available when the All Channels tab is current.  Drawing tab elements 
apply to individual channels only.  If the All Channels tab is current, the Method setting 
appears in the Trace tab. 

The Method setting defines how GageScope® displays traces based on the acquired data. The 
options are MinMax and Mean.  These options affect the screen representation of the data 
only and do not change the actual signal data. 

MinMax When two or more samples are to be displayed on the same screen pixel 
column, MinMax will plot the minimum and maximum values, then draw a 
line between them. This method allows glitch detection even at very low 
timebases. 

  This is the default setting. 

Mean When two or more samples are to be displayed on the same screen pixel 
column, Mean will plot the average of the samples. In display terms, the Mean 
method reduces the apparent signal noise when capturing slow signals at high 
sample rates and then displaying many points on the screen.  The Mean display 
method allows over-sampled data to be digitally filtered before display, thereby 
improving the signal to noise ratio. 

Changing the Method via the Trace Tab 
1 Click on the Drawing tab of the Channel Control. 

2 Click on the Method drop-down list. 

3 Select a method from the list. 
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Channel Control: Drawing Tab: Connect Dots 
The Connect Dots button is located in the Drawing tab of the Channel Control. 

 

The Drawing tab is not available when the All Channels tab is current.  Drawing tab elements 
apply to individual channels only. If the All Channels tab is current, the Connect Dots setting 
appears in the Trace tab. 

By default GageScope® draws a line between each sample point in order to display a 
continuous waveform. To have GageScope® display as single points, you can turn off the 
Connect Dots setting. 

Toggling the Connect Dots Button 
1 Click on the Drawing tab of the Channel Control (make sure the All Channels tab is not 

current). 

2 Click on the Connect Dots button to toggle this option on and off.  
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Channel Control: Drawing Tab: Format 
The Format setting is located in the Drawing tab of the Channel Control. 

 

The Drawing tab is not available when the All Channels tab is current.  Drawing tab elements 
apply to individual channels only. 

The Format setting defines how GageScope® will draw a trace. 

Changing the Format 
1 Click on the Drawing tab of the Channel Control (make sure the All Channels tab is not 

current). 

2 Click on the Format button.  The Format trace dialog appears. 

 

3 Select a style from the list on the left and a pen width from the list on the right. 
GageScope® will show you a preview of your selection. 

4 Click Apply to confirm your selection. 
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Notes 
If Connect Dots is turned off, your changes to the Format settings will not be visible on the 
screen. The line style does not have any effect on the size of the dots but the pen width does 
change the dot size. 

 



Reference C-155 

Channel Control: Drawing Tab: Color 
The Color button is located in the Drawing tab of the Channel Control. 

 

The Drawing tab is not available when the All Channels tab is current.  Drawing tab elements 
apply to individual channels only. 

The Color Button allows you to change the color of a channel. 

Changing the Color via the Drawing Tab 
1 Click on the Color Button in the Drawing tab.  The color dialog appears. 

 

2 Click on a color in the dialog box, then click OK. 
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Changing the Color via the Channel Context Menu 
1 Position the mouse pointer on a channel’s zero line in the Display Window. The 

channel will turn white to indicate that it has the current focus, and the mouse 
pointer will change to a drag pointer. 

2 Right-click to bring up the channel context menu. 

3 Click on Color with the left mouse button. 

4 Click on a color in the dialog box, then click OK. 
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Channel Control: Trace Tab: Align by Start /  
Align by Trigger 

This setting is located in the Drawing tab of the Channel Control when a channel has been 
loaded which does not cross the Trigger Marker (start, or time zero). 

 

When displaying a saved signal that does not cross the trigger marker, you can specify where 
on the screen will that signal be displayed. 

• Align by Start: GageScope® will display the signal at the Start (at the Trigger 
Marker, or time zero). 

• Align by Trigger: GageScope® will display the signal at its original time position 
relative to time zero.  This is the default setting. 
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How it works 
1 When you load a channel that does not cross the Trigger Marker, by default it will 

be Aligned at Trigger (at its original time position in the grid).  Below, Channel 3 
is aligned at Trigger. 

 

2 Click on the appropriate Channel tab in the Channel Control.  Then click on the 
Drawing tab. 
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3 Click on Align by Start. 

 

4 The signal moves to line up with the Start (the Trigger Marker).  Below, Channel 3 
is aligned by Start. 

 

Notes 
• This setting can also be specified via the Preferences dialog in the Tools Menu.  See page 

C-41. 
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Channel Control: AWG Input Tab: Duration 
The duration settings are located in the AWG Input tab of the Channel Control. 

 

The duration setting refers to the total length, in Samples, of the signal being created.  The 
current setup shows that the duration of the signal under creation is 1600 Samples. Refer to 
the Tutorial section of this guide for further details. 
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Channel Control: AWG Input Tab: Equation 
The equation settings are located in the AWG Input tab of the Channel Control. 

 

You can enter or modify the equation to be created using the setting in the AWG Input control. 
You can observe that the equation for a sine function appears in the equation text box. Refer 
to the Tutorial section of this manual for further detail on entering or modifying equations to 
create user defined signals for arbitrary waveform generation. 
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Channel Control: AWG Input Tab: Ampl 
The Amplitude (Ampl) settings are located in the AWG Input tab of the Channel Control. 

 

The Amplitude is the amplitude of the signal to be generated. The amplitude can be specified 
as the percentage of the selected output range. You can modify the amplitude of the signal to 
be created by using the increment/decrement buttons. You can also change the amplitude by 
clicking inside the amplitude text box and entering the value. 
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Channel Control: AWG Input Tab: Offset 
The Offset settings are located in the AWG Input tab of the Channel Control. 

 

The Offset is the DC offset that can be specified as a percentage of the selected range for the 
signal to be generated.  You can modify the Offset of the signal to be created by using the 
increment/decrement buttons. You can also change the Offset by clicking inside the amplitude 
text box and entering the value. 
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Channel Control: AWG Input Tab: Waveform 
The waveform settings are located in the AWG Input tab of the Channel Control. 

 

There are three types of standard signals that can be created for generation using the AWG 
capabilities of GageScope. Click on the Waveform drop down button to view the list of 
available standard signals as follows: 
 

 
 
Click on the desired waveform to be selected for generation. The generation process is 
discussed in the System Control section on page C-98. 
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Channel Control: AWG Input Tab: Duty 
The duty settings are located in the AWG Input tab of the Channel Control. 

 

The Duty setting provides a means for specifying the duty cycle for the signal to be created 
and later generated.  Note that the number entered in the duty cycle text box is a certain 
percentage of the total number of samples in the cycle. The total number of samples is 
specified in the Samples text box.  
In the example above, a duty cycle of 50% is desired. The total number of samples in the 
cycle is given to be 1600.  Therefore a 50% duty cycle for a sine wave will create an evenly 
balanced sine wave.  
 



C-166 Reference 

Channel Control: AWG Input Tab: Samples 
The samples settings are located in the AWG Input tab of the Channel Control. 

 

For standard waveform generation, the Samples setting specifies the total number of samples 
for a single period of the wave.  Looking at the settings in the figure above, a 1600 samples 
sine wave will be created. The period of the sine wave will be determined by the generation 
rate specified in the system control. Refer to the system control section of this chapter for 
details on the generation procedure (page C-98). 
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Display Window 

The Display Window shows live signals being acquired from a CompuScope card as well as 
signals loaded from disk. You can move signals directly in this window as well as change 
certain settings via context menus. 

In this Section… 
• Channel Context Menu..................................... C-168 
• Display Window Context Menu ....................... C-170 
• Trigger Context Menu ...................................... C-172 
• General Shortcuts ............................................. C-173 
 



C-168 Reference 

Channel Context Menu 
Many options found in the controls and menus are also available through the channel context 
menu.  

1 Position the mouse pointer on a channel’s zero line. The channel will turn white to 
indicate it has the current focus, and the mouse pointer will change to a drag pointer. 

2 Click the right mouse button. The channel context menu appears. 

 

3 Click on a command using the left mouse button. 
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Options 

Save Channel This is equivalent to saving a channel via the Save Channel command 
in the File menu. 

Hide Hides the selected channel. This is equivalent to hiding a channel via 
the Channel List in the General tab of the Display Control. 

Send To You can save the signal files to a floppy drive, My Briefcase folder on 
your hard disk, or post these directly on a web site.  

Delete Channel Removes the channel from the Display Window.  No equivalent. Only 
math channels and channels originating from a file may be deleted, not 
live signals originating from a CompuScope card.  Note that all 
channels that were created from the channel selected for deletion will 
also be deleted.  For example, if Ch 5 is a math channel that was 
created by adding Ch 3 and Ch 4, and Ch 3 is deleted, Ch 5 will be 
deleted also.  You will be notified of this via the Confirm Deletion 
dialogs. 

Invert Inverts the polarization. This is equivalent to inverting the polarization 
via the Trace tab of the Channel Control. 

Reference Lines The reference settings High, Middle and Low are used to determine 
the High Level, Middle Level, and Low Level when calculating certain 
time parameters. For example, the Rise Time is the length of time for a 
signal’s rising edge to go from the low level to the high level. 

Color This is equivalent to changing the channel color via the Drawing tab of 
the Channel Control. 

Edit Select this option to perform basic editing operations like Cut, Copy, 
and Paste on signals. 
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Display Window Context Menu 
Several of the general display options, such as channel visibility and full screen view, are 
located in the Display context menu.  

1 Position the mouse pointer on an empty area of the Display Window (not on a channel or 
other item). 

2 Click with the right mouse button to bring up the Display context menu. 

 

Note that few options are disabled depending on GageScope® settings. 

3 Click on a command using the left mouse button. 
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Options 
New Math Channel Creates a new channel by combining other channels 

mathematically. This is equivalent to creating a channel via the 
Math command in the Tools menu. 

Load Channel This is equivalent to loading a channel via the Load Channel command in 
the File menu. 

Arrange Traces Rearranges the visible channels in the Display Window in order of 
channel number. This is equivalent to clicking on the Arrange 
Traces button in the toolbar. 

Ch 1 
Ch 2 
… 

Hides or shows a channel. This is equivalent to hiding a channel via 
the Channel List in the General tab of the Display Control. 

Grid 
Zero Line 
Trigger Line 

Hides or shows the Grid, Zero Line or Trigger Line. This is 
equivalent to hiding these display elements via the Settings tab of 
the Display Control. 

Left Bar Hides the left bar of the Display Window, which contains the slope 
icon, the channel label, the sample rate indicator and the number of 
records captured in a multiple record acquisition. This is equivalent 
to selecting Left Bar from the Window menu. 

Status Bar Hides the status bar of the Display Window. This is equivalent to 
selecting Status Bar from the Window menu. 

Color > Background 
Color > Grid 

The options in the Color sub-menu allow you to change the 
background and grid color. This is equivalent to changing the color 
via the Settings tab of the Display Control. 

Full Screen Hides all controls to all the Display Window to expand to a full 
screen view. This is equivalent to selecting Full Screen from the 
View menu. 

Cut, Copy, Paste Cut, Copy and Paste are the three options available to edit the 
signals. 
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Trigger Context Menu 

Trigger slope can be changed via the trigger context menu.  

1 Position the mouse pointer on the trigger slope icon, located to the left of the channel. 

2 Click with the right mouse button to bring up the trigger context menu. 

3 Click on a command using the left mouse button. 

Options 
Positive Slope 
Negative Slope 

This is equivalent to double-clicking on the slope icon to change the 
slope, or clicking on the slope buttons via the Trigger tab of the 
Systems Control. 

 

A bullet next to an option indicates the setting currently being used.  

 



Reference C-173 

General Display Window Shortcuts 

Moving Channels 
1 Position the mouse pointer on a channel’s zero line. The channel will turn white and the 

mouse pointer will change to a drag pointer, to indicate that the channel has the current 
focus. 

2 Hold down the mouse button, then move the mouse up or down. 

Raising the Trigger Level 
1 Position the mouse pointer on the slope symbol at the far left of a channel. This is the 

trigger level. 

2 Hold down the mouse button, then move the mouse up or down. 

Changing the Trigger Slope 
1 Position the mouse pointer on the slope symbol at the far left of a channel.  

2 • Double-click to toggle the slope 
or 

• Click the right mouse button to bring up the Slope context menu; click on either 
Positive or Negative to select the slope. 

AutoRepeat Buttons 
1 Position the mouse pointer on any button in the System, Display and Channel Controls 

which provides an increment/decrement function.  These include: 

    All Increment/Decrement buttons  

   Timebase buttons 

   Vertical Scale buttons 

     Position buttons 

2 Press and hold the left mouse button.  The button will repeat its function for as long as 
you hold the button. 
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Scrolling using the Trigger Marker 
1 Position the mouse pointer on the trigger marker line (the vertical line with the T at the 

bottom). 

2 Press down the mouse button, and move the mouse left or right. 

Scrolling using the Scroll Bars 
The horizontal and vertical scroll bars allow you to scroll through the Display Window in 
order to see different parts of what was captured. To move toward the right, for example, you 
can click on the horizontal scroll bar’s right scroll arrow. 
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You can also drag the scroll bar—the Display Window will update dynamically. 

Scroll Bar Size 
The size of the bar in the vertical and horizontal scroll bar indicates the size of the Display 
Window relative to the overall width of the signal from end to end. If the scroll bar is very 
small, the portion of the signal you are seeing is small compared to the whole signal. 
Conversely, if the scroll bar is two-thirds the size of the Display Window, then you are seeing 
two-thirds of the whole signal. 

The scroll bar size is affected by the timebase. If the timebase is large (100us/d compared to 
the default 5us/d, for example), then the scroll bar gets larger, as you are able to see more of 
the  waveform in the same-size Display Window. The Scroll bar always remains visible. 
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Status Bar 

The Status Bar is located at the bottom of the Display Window. 

Current Settings Reflected in the Status Bar 

• Triggering activity 

• Timebase 

• M.Pos (distance from the trigger marker to the current position, in seconds) 

• Cursor 1 and/or Cursor 2 values (if a cursor is enabled) and Cursor deltas (if both cursors 
are enabled) – see Cursors on page C-54 for more information. 

Triggering Activity Messages 
The text and background color have special meanings in the Status Bar.  While the text 
indicates the current hardware status, the background color indicates the status of the 
currently displayed acquisition.   

Waiting The message “Waiting” means the system is currently waiting for a 
trigger to occur in order to perform a capture.  “Waiting” is displayed 
on a magenta background. 

Ready The message “Ready” means a trigger event has occurred and a capture 
is being performed. A green background means a trigger occurred 
normally.  A yellow background means a timeout occurred and 
GageScope® forced a trigger. A blue background means a trigger was 
forced in Continuous Capture mode. 

Stop The message “Stop” means GageScope® has stopped the current 
acquisition.  A blue background means a trigger was forced; a green 
background means a trigger occurred normally. 

Transferring The message “Transferring” means GageScope® is transferring data 
from the board to the internal buffers of GageScope®. 

Arming The message “Arming” means that GageScope® is transferring data 
from the internal buffers to the board for generation. 
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InfoView 

The InfoView Window truly differentiates GageScope® from all other oscilloscope programs 
on the market. Using the advanced analysis tools, GageScope® can analyze the signal data and 
display the results in the InfoView window. InfoView is what the marriage of instruments and 
computers is all about. 

Any results calculated in GageScope® are displayed in InfoView. 

Below is a sample of what the Waveform Parameters tool displays. For more information on 
advanced analysis tools, see page C-177. 
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Advanced Analysis Tools 

Advanced analysis tools are now an integral part of GageScope® program that provide 
additional functionality, such as measurement and display of waveform parameters. 

Following are the analysis tools currently available: 

• AutoSave ..............................................................page C-178 
• Averaging ............................................................page C-191 
• Waveform Parameters ..........................................page C-202 
• FFT Analysis ........................................................page C-215 
• Extended Math .....................................................page C-220 
These advanced analysis tools are installed automatically when you install the GageScope® 
software program. To be able to exploit the maximum capabilities offered by these advanced 
analysis tools, you should purchase the Professional Edition of GageScope® .The Standard 
Edition of GageScope® also provides a selected capability of these advanced features.  
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AutoSave 

AutoSave is a very powerful tool for data acquisition of transient signals. It allows unattended 
data capture to disk with accurate time and date stamping of when the trigger occurred.. 

The AutoSave tool allows the periodic output of a channel to file. Each such file represents a 
single AutoSave record.  The channels are saved to file using the current hardware 
configuration defined in the GageScope® session.  

The AutoSave tool also allows benchmarking of AutoSave settings.  The benchmarks allow a 
user to determine the time required to perform a single AutoSave cycle on a given system.   

The AutoSave tool defines a new file extension, *.asf.  ASF files contain AutoSave settings as 
defined inside GageScope®.  Those settings are the inter-sample delay, the number of records, 
the AutoSave file prefix, and the output directory.  Note that long file names are permitted. 
GageScope® can save and restore AutoSave setups to make them available for future sessions.   

Setting up for an AutoSave Session 
1 To set up AutoSave inside GageScope®, select AutoSave Setup from the Capture menu.   

 



Reference C-179 

2 The AutoSave dialog will appear. 

 

This dialog allows you to: 

• select the channels for which AutoSave should be set up 
• specify where the files will be saved 
• specify the prefix for each file in the series 
• specify the InterSample Delay, or the length of time between samples 
• specify the number of records to be saved 
• benchmark how long the system will need to perform a single AutoSave cycle 

using current settings 
• save the current setup 
• load a previously saved setup 
• apply the current settings, allowing you to exit the dialog, make changes to your 

hardware settings, and return to the dialog with your changes preserved 
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3 This dialog also provides the following information: 

• disk space required for the AutoSave files, based on current settings 
• free disk space on the current hard drive 
• status of the AutoSave session (“Done” is displayed after a successful 

Benchmark or AutoSave) 
• Time taken by the AutoSave session, either projected (benchmark) or actual 
• See below for more details. 

 
4 Click on one or more of the current channels to be included in the AutoSave session. 
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5 To determine how long it will take GageScope® to perform the AutoSave session based 
on current settings, select the channels you want to save and click on Evaluate.   
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6 The screen below shows a completed Benchmark.  Note that the Status field reads 
“Done.” GageScope® has determined that the specified AutoSave session will take 75 ms 
and will require 272KB of hard disk space.   

 

7 Note that if you wish to change hardware settings before beginning the AutoSave, you 
must exit the AutoSave Setup dialog.  To preserve the AutoSave setup changes you have 
made, click Apply, then Cancel.  Make the necessary hardware changes.  When you re-
open the AutoSave Setup dialog, your settings will have been retained. 
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8 After you have specified the desired AutoSave settings, click Start to begin the AutoSave 
process. 
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9 When the process is complete, the message “Done” will appear in the Status field. 
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Saving and Loading AutoSave Setups 
1 You can save the current AutoSave setup.  To save, click Save Setup.   
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2 You will see a Save Setup dialog, allowing you to specify the location and name for the 
setup file.   

 

The default directory is C:\Gage\Gagescope\AutoSave, and the default AutoSave setup 
file name is GagescopeAS.asf.  To save a new file, type in the File name field.  Click 
Save. 

Note:  If you save more than one series of AutoSave files with the same prefix, 
GageScope® will create additional AutoSave directories underneath the main AutoSave 
directory.  To prevent this, choose a different prefix, or save to another directory. 
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3 To load a previously saved AutoSave setup file, simply click Load Setup in the 
AutoSave Setup dialog.   

 

4 This brings you to an Open dialog, allowing you to select an .asf file to load. 

 

Click on the setup file you wish to load and then click Open. 
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AutoSave Playback 
1 When an AutoSave session is executed, it can be played back by selecting the AutoSave 

Playback button on the main toolbar. 

 

You can also select AutoSave Playback from the Tools Menu. 

2 A dialog box then allows you to locate the AutoSave records on your system as well as 
the channels that should be played back.   

 

3 Press the Search button to locate your AutoSave records.   
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4 GageScope® will automatically look in the Gagescope\AutoSave directory for saved 
records.  (If you saved in another directory, click  to browse.)  You will then see a list 
of channels to be played back, along with the destination channel, which will be used to 
display the AutoSave records on-screen. 

 

You can choose which channels will be displayed by clicking in the checkbox next to the 
channel in the list. 

5 Now click OK to display the first of your AutoSave records. 
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6 The record number is displayed to the left of the signal, for example, 1 of 16 is shown in 
the screen below.   

 

7 To move from record to record, use the Toolbar buttons shown below. 

 

If you choose Continuous Playback, GageScope® will cycle through all of the AutoSave 
records and loop back to 1 for another cycle.  You can see the record counter to the left of 
the signal, underneath the channel number (for example, 1 of 16, 2 of 16, 3 of 16…). 
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Averaging 

This advanced tool allows the user to capture many records and average them for display. 
This data can also be saved to disk as averaged data. You can control how many acquisitions 
are performed before they are displayed, as well as how these acquisitions are combined into 
a single trace display. 

Using the Averaging Tool 
1 Click on the Tools menu, then click on Averaged Channel or, you can click on  in 

the toolbar. 

2 When Averaged Channel is clicked from the drop-down menu, the following Channel 
dialog appears: 

 

3 Choose a channel from the Source combo box.  You can specify the following: 

• Average Count: This is the number of acquisitions to be averaged. 

• Start: It specifies the first sample of the averaged region relative to the trigger 
position. For a selected portion of the acquisitions to be averaged, the user has the
option to select the starting point of the acquisition to be averaged. 

• Averaging Depth: This is the length of the portion of the signal to be averaged. The 
maximum averaging depth, Max is 8192 in the GageScope® Professional Edition 
when the running average option is selected. 
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4 Select an averaging method from the Method menu. Users are provided with the 
following options: 

• Average: The first point of the acquisition is added to the first point of the second 
acquisition and the process is repeated till the number of additions equal the number
specified as the average count. This number is now divided by the average count and
is then identified as the first point of the results channel. The process is repeated for 
the average length of the acquisition.  

• CoAdd: When CoAdd is selected, all steps are followed as in the Average option,
except that after adding the specified number of acquisitions, the result is stored as a 
sum and is not divided by the average count. By selecting the intermediate display
option, one can view the results of the intermediate CoAdd steps.  

5 Choose an item from the Settings 

• Running Average:  The N most recent acquisitions are added and then averaged. 
The result is stored in the results channel. One can notice that this result is
continuously refreshed since the average is the running average. 

Note:  

1. The running average is not available in the Standard Edition of GageScope®. 
     N cannot exceed 256 for the Professional Edition. 

2.  The Maximum Averaging Depth is 8192 in the running average mode. 

 • Display Intermediate Results: When acquisitions are co-added, the averaging tool 
allows the user to request the display of intermediate results.  Note that this 
intermediate display may slow the co-adding process. 

• Average Multiple Record: The user must have the multiple record activated to 
make use of this option. See the details of this option in the Multiple Record Section 
on page C-88. 
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6 After entering the parameters for your application, Click OK. 

Averaging appears up as a tab in the Channel Properties dialog box: 

 

 
 

Details 
1 The selected number of acquisitions can either be averaged or co-added.  To Average the 

acquisitions, click the radio button next to Average.  To Co-add the acquisitions, click the 
radio button next to CoAdd. 
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2 To show Intermediate Results, click the Int. Results check box. This means that 
GageScope® will display the results while it performs the adding process, rather than 
displaying just the final result.   

 

3 When the Int. results box is checked, the Reset button is available.  This button allows 
you to set the counter back to 1.   

The screen below shows a Co-add with 300 acquisitions, showing intermediate results 
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4 Click the Trace tab in the Channel Properties dialog. Note that the peak-to-peak (p-p) 
amplitude of the CoAdded  Channel 3 is 300 volts. The signal on channel 1 was 
originally 1 Volt p-p.  
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Averaging in Multiple Record Mode 
When in Multiple Record mode, averaging can be performed in three ways.   

• A single “MulRec” record can be used to produce a single averaged MulRec record.  
This method is best when the incoming signals are non-repetitive, such as in Imaging 
applications. 

• A specified number of MulRec records can be averaged to produce a single averaged 
record.  This method is best for applications like Mass Spectrometry, where the 
signals are highly repetitive. 

• The running average of a single “MulRec” record. 

1 To perform averaging in Multiple Record mode, a Multiple Record acquisition must first 
be performed.  The MulRec item is available only if MulRec is enabled in the Depth tab 
of the System Control, as shown below: 

 

For more details on Multiple Record, see page C-88.   

2 In this Multiple Record acquisition, we will acquire 4096 samples. GageScope® 
calculates that we can acquire 31 records, each containing 4096 samples, given the 
amount of memory on-board our CS2125 card. 
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Averaging when MulRec is Not Checked 
1 MulRec appears at two places:  

• In the System Control, MulRec appears under the Depth tab.  

• In the Channel Control, MulRec appears on the Trace tab once Multiple Record 
Option is selected in the System Control and an acquisition has been made. 

It is important to remember that we have set the Multiple Record Mode by selecting the
MulRec button in the System Control and now referring to the MulRec under the 
Channel Control. 

By default, the MulRec item is unchecked in the Averaging Mode.  In this mode,
GageScope® takes a MulRec record and averages it over a specified number of
acquisitions to produce an averaged MulRec record.   

 

2 For instance, if we set the Count to 40 via the Increment buttons, GageScope® will 
acquire the current records or their portion forty times and average the records in each of 
the forty acquisitions to produce an averaged MulRec record.  
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3 In this case, although the multiple record depth was specified to be 4096 samples, we 
have changed the averaging depth to be the first 1024 samples. 

 

 

Note that by entering an integer number in the Start field and the averaging depth, we can 
select any arbitrary portion of the acquisition to be averaged.  

4 Change the count to 40. The result of the 40 averages for the selected portion of the 
acquisition is shown as 

 

This is shown diagrammatically below.  A single MulRec record is averaged over n 
acquisitions to produce an averaged MulRec record. 
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 You can specify which resultant record is averaged and displayed via the Record 
Counter in the Trace Tab of the Channel Control, or the Multiple Record Playback 
buttons in the toolbar. 
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Averaging when Mulrec is Checked 
1 Now we will perform the second type of averaging possible in Multiple Record mode.  

Click the MulRec checkbox in the Averaging tab. 

 

 

2 In this mode, GageScope® averages a specified number of records in one Multiple 
Record acquisition to produce a single averaged result. 
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3 Notice that the Averaging Depth has been changed to 1024 

 

4 The number of records to be averaged is specified in the Count. This field can be set to 
any number from 2 up to the total number of records in the Multiple Record acquisition. 
In our example, our Multiple Record acquisition contains 31 records, so we can average 
anywhere from 2 to 31 records to produce a single resultant averaged record. 

 

 

If you attempt to set the counter to a number higher than the current number of records 
in your acquisition, GageScope® will automatically set the field to the maximum 
number allowed.  

This is shown diagrammatically below. GageScope® averages n records in the current 
acquisition to produce a final result, which is displayed in the Display Window. 
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Note 
When Mulrec is checked, the Record Counter disappears from the Trace tab of the Channel 
Control, after the averaging operation is completed. 

 

Averaging when Running is Checked 

1 When Running is checked, the running average of the selected multiple record is taken.   

 

2 The result of the running average of the first multiple record is shown as  
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Note that although the record length is 4096, yet the length of the average channel is 
being chosen as 1024. 

CoAdding Multiple Record Acquisitions 

1 A single multiple record acquisition can be CoAdded a specific number of times. Select 
the CoAdd radio button to activate this feature while in the Multiple Record Mode. 
Remember that Multiple Record Mode is selected via the System Control. 

 

2 A single multiple record on channel 1 is being CoAdded 4 times. 
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Note  

• Record 1, out of the 31 records, is a 1MHz sine wave with a record length of 
4096 post trigger points 

• The peak-to-peak amplitude of the sine wave is 1 Volt 

• The length of the CoAdded signal is chosen to be 1024. 

• The peak-to-peak amplitude of the CoAdded result shown as Channel 3 is 4 
Volts 
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Waveform Parameters 

The Waveform Parameters tool automatically calculates various voltage and time parameters 
of a signal, such as mean, amplitude, and rise time. In all, 28 parameters are available: 

• Mean 
• RMS 
• Amplitude 
• Peak to Peak 
• Period 
• Frequency 
• Fall Time 
• Rise Time 
• Positive Width 
• Negative Width 

• Positive Duty 
• Negative Duty 
• Positive Overshoot 
• Negative Overshoot 
• Peak 
• Trough 
• Top Value 
• Bottom Value 
• TAAPos 
• TAANeg 

• TAA 
• Pk-Pk time 
• Pk-Thr time 
• Tr-Pk time 
• Tr-Thr time 
• Ext-Ext time 
• Base line 
• Delta Base line 
 

 

Parameters are displayed in the InfoView window at the far left of the GageScope® screen. 

 

For definitions of what each parameter measures, see About the Parameters on page C-212. 
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Adding Parameters to the InfoView 

1 To display a parameter, right-click on the InfoView window and choose Edit Waveform 
Parameters.  You can also choose Waveform Parameters from the Tools menu or the 

 button in the Toolbar. 

 

 

The Parameters dialog box appears. 
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2 Click on the channel number you want to measure. 
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3 Click on the checkbox of each parameter you want to display in the InfoView window. 
You may have to scroll down the list to find the parameter you want. 

A checkmark indicates the parameter will be shown; the lack of a checkmark indicates 
the parameter will not appear. 

 

To enable all parameters, click on the Select All button. To disable all parameters, click 
on the Deselect All button. 

4 Click OK when finished or Cancel to abort the changes. 

Once you click OK, the parameters appear in the InfoView window. 
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Expanding and Collapsing Parameters 
Many of the parameters can display the average value and standard deviation. Such 
parameters have a plus sign to the left of their name in the list. To expand a parameter and see 
the average values and standard deviations, click on the plus sign to the left of a parameter. To 
collapse the parameter back to its original state, click on the minus sign. 

  

Method and Reference Settings 
When calculating certain parameters, the Waveform Parameters tool relies on the Reference 
and Method settings located in the Parameters dialog. 
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For information on how particular parameters are affected by these settings, see About the 
Parameters on page C-212. Not all parameters make use of these settings. 
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The Method Setting 
The options for Method are MinMax and Histogram. To change the Method setting, select a 
value from the drop-down menu. The default is MinMax. 

The Histogram Method is preferred for pulse-based signals such as digital logic (CMOS, 
TTL, ECL, etc.). 

The MinMax Method is preferred for other signals, such as sine waves. 

The Reference Settings 
The reference settings High, Middle and Low are used to determine the High Level, Middle 
Level, and Low Level when calculating certain time parameters. For example, the Rise Time 
is the length of time for a signal’s rising edge to go from the low level to the high level. 

To change the Reference settings, click on the Increment buttons next to High, Middle and 
Low. 

The definitions for High Level, Middle Level, and Low Level are shown below. 
Reference:High%, Reference:Middle%, Reference:Low% refer to the values in the Reference 
settings in the Parameters dialog box. 

High Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:High% 
Middle Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:Middle% 
Low Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:Low% 
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About the Parameters 
Use the diagrams below to get an idea of what each parameter measures. More detailed 
explanations are offered on the pages following the diagram. 

Voltage Parameters 

 
 

Time Parameters 
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The parameters are defined as follows: 

Mean Mean is the average of all the points in the signal. 

RMS RMS is the Root Mean Square voltage. 

Amplitude When the MinMax method is chosen, Amplitude is equal to the Peak 
to Peak value. When the Histogram method is chosen, the Amplitude 
is the difference between the High Flat and Low Flat values, in Volts. 

PeakToPeak Peak-to-Peak is the absolute difference between the Maximum and 
Minimum values, in Volts. 

Period Period is the time it takes for a signal to complete one cycle and is 
equal to the sum of the Positive and Negative Widths. 

Frequency Frequency is the number of cycles per second in a signal, measured in 
Hz, with 1 Hz equaling 1 cycle per second, and is equal to 1 / Period. 

FallTime Fall Time is the length of time for a signal’s falling edge to go from the 
High Level to Low Level. (These two levels are specified in the 
Reference:High and Reference:Low settings in the Parameters dialog 
box.) 

RiseTime Rise is the length of time for a signal’s rising edge to go from Low 
Level to High Level. (These two levels are specified in the 
Reference:High and Reference:Low settings in the Parameters dialog 
box.) 

PosWidth Positive Width is the length of time between the rising and falling edge 
of the portion of  the signal above the Middle Level. (This level is 
specified in the Reference:Middle setting in the Parameters dialog 
box.) 

NegWidth Negative Width is the length of time between the falling and rising 
edge of the portion of  the signal below the Middle Level. (This level 
is specified in the Reference:Middle setting in the Parameters dialog 
box.) 

PosDuty Positive Duty is a percentage of the time it takes for the positive 
portion of a signal to complete, compared to one whole cycle. It is 
defined as: 

(Positive Width ÷ Period) x 100 
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NegDuty Negative Duty is a percentage of the time it takes for the negative 
portion of a signal to complete, compared to one whole cycle. It is 
defined as: 

(Negative Width ÷ Period) x 100 

PosOvershoot Positive Overshoot is measured in Volts and is defined as: 

Maximum Value - High Flat Value 

When the method is set to MinMax, Positive Overshoot is 0. 

NegOvershoot Negative Overshoot is measured in Volts and is defined as: 

Minimum Value - Low Flat Value 

When the method is set to MinMax, Negative Overshoot is 0. 

Top Top is the average of the highest values recorded for all the cycles in 
the signal. 

Bottom Bottom is the average of the lowest values recorded for all the cycles 
in the signal. 

Minimum Minimum is the lowest voltage recorded for the signal. 

Maximum Maximum is the highest voltage recorded for the signal. 

NumCycles Number of cycles is the total number of cycles in the signal. 
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FFT Analysis  
The FFT Analysis tool for GageScope® provides multiple-channel spectral analysis with 
simultaneous viewing of time and frequency domain data, all within the easy-to-use 
framework of GageScope®. 

 

Notes 
• You must set your screen to 256 colors (minimum) in order to use the FFT Analysis tool, 

otherwise your screen display may be garbled. 
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Using the FFT Analysis Tool 
1 To initiate an analysis of a signal, select the  button in the Toolbar. 

 

You can also select FFT… from the Tools menu.   

2 The FFT Dialog will appear.   
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3 Choose from the available options that appear at the right. 

Source: The channel the FFT analysis will be performed on. 

Target Window: The window that FFT analysis will be displayed in. 

Start: The starting sample point for the analysis. 0 means the point at which 
a trigger occurred and capture began. 

Num. Points: The number of points to use in the analysis. The maximum number of 
points supported in the Professional Edition of GageScope® is 4 
Million. 

FFT Type: Choice of FFT Type includes Full Scale (dBfs), 1 milliwatt (dBm) and
1 Volt (dBV). 

Window Type: Choice of window type includes Rect, Parzen, Hanning, Welch, 
Hamming, ExactBlackman and BlackmanHarris. 
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4 Click OK when ready. A new window opens with the FFT on display. 

 

 

Once you have created an FFT window, the Display and Channel Controls change to offer 
new options.  

Specifically, a new tab appears at the bottom of 
the Display Control called FFT2. This tab allows 
you to switch from the normal signal window to 
the FFT window. Several new options appear here 
as well. The Center and Span settings in the 
Combo box titled Horizontal allow you to change 
the horizontal scale of the FFT Display 
Window.The Max and Min settings in the Combo 
box titled Vertical allow you to change the 
vertical scale of the FFT Display Window. The 
Channel Name is used to display/hide the FFT 
corresponding to a particular Channel. 
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If the FFT Display Window is being 
shown, the Channel Control changes to 
display all the settings you specified in the 
FFT dialog. You can change the settings in 
this control at any time in order to change 
the FFT Display. 

You can also zoom in on a specific portion of the FFT by using the toolbar’s Zoom Tools. 
 

 
 
Cursors can also be used to make precise readings of frequencies and power.  Upon activation 
of a cursor, you can immediately read frequencies, but to get the dB level, you must first 
attach the cursor to the FFT trace. This is done by right-clicking on the cursor and selecting 
the channel to which the cursor is to be attached. 
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Extended Math 
The Extended Math tool gives GageScope® the ability to perform the following operations on 
the acquired signals: 

• Integration 

• Differentiation 

• Autocorrelation 

• Crosscorrelation 
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Integration 
1 The signal of interest is as follows: 

 

The acquisition is a series of output pulses with of 1MHz frequency from a frequency 
generator. We will perform the integration operation on this channel. 

2 From the Tools menu, select Extended Math or select  from the toolbar. The New 
Analysis Dialog box will appear 
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3 Select Channel 2 from the Operand 1 drop down menu. 

4 Click on the  button. 

5 Select channel 3 for the Result drop down menu.  

6 Click OK. The result of the integration appears will appear as 

 

The result of integrating a constant amplitude function is a linear function. Note that the 
scaling of the integration operation is not preserved. Current analysis will be useful in
applications where the relative and not the absolute value of the integration is desired.  
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Differentiation 
1 The signal of interest in this case will be the integrated signal shown as Channel 3 in step 

6. 

2 From the Tools menu, select Extended Math or or select  from the toolbar. The 
New Analysis Dialog box will appear 

 

3 Select Channel 3 from the Operand 1 drop down menu. 

4 Click on the  tab. 

5 Select channel 4 for the Result drop down menu.  
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6 Click OK. The result appears as 

 

The result of differentiating an linear function should be a constant amplitude function. 
The scaling is however not preserved. 
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Autocorrelation 
The Correlation function shows  

• How similar two functions are  

• How long these functions remain similar when one is shifted with respect to the 
other 

Correlating a signal with itself is called Autocorrelation. Autocorrelation is a fundamental 
analysis tool in applications such as ultrasonics, vibrations, disk drive testing, 
communications, etc. 

1  From the Tools menu, select Extended Math or select  from the toolbar. The New 
Analysis Dialog box will appear.  

Select Operand 1. Click the autocorrelation button  

 

2  Choose a channel for the Result 
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Channel 1 is a 1024 point sine wave. The autocorrelation function is shown as Channel 
3. In taking the autocorrelation of the acquired signal, the acquired signal was divided 
into half. This half portion of the signal was then slided on the original signal. The entire 
length of the slided portion was contained in the original signal at all times. 

Note that phase information is not preserved under this operation. 

3  The autocorrelation of random noise appears as follows: 
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Notice the huge spike which seems like a dirac delta function at the start of the result in 
channel 3. 
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Crosscorrelation 
It is well known in the test and measurement world that the response of a system can be 
characterized by subjecting the system to a random excitation. The concept of 
Crosscorrelation is a useful analysis tool in such applications. 

1 From the Tools menu, select Extended Math or select  from the toolbar. The 
New Analysis Dialog box will appear.  

Select Operand 1. Click the Crosscorrelation button  

 

2 Choose Operand 2 

3 Choose a channel for the Result.  

As an example, Channel 3 below shows a simulated two echo system while channel 4 
is the single echo which is extracted out of Channel 3 to perform the crosscorrelation 
operation between the two channels. 

The result of Crosscorrelation is shown as Channel 5. 
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Troubleshooting 

Q. GageScope® launched properly, but my signal is a flat line. 

A. There are many reasons this could happen.  

• Do you have a signal generator connected to your CompuScope card? 

• Is the signal plugged into channel A or B of the CompuScope card, and not the other 
connectors (EXT for example)? 

• Is the signal generator turned on? 

• If you have several CompuScope cards in your machine, is GageScope® looking at 
the right card? 

• If you are using a CompuScope card that requires a mezzanine power cable, is that 
power cable connected? 

Q. How can I easily find the settings I want to change? 

A. If you are looking for a particular feature you can always search the online help. Click on 
the Help menu, then Help Topics, then on the Find tab. 

Q. I pressed the One Shot button but GageScope® acts as if I had clicked on Stop. 

A. In Continuous mode, GageScope® looks for a trigger event, performs a capture, then 
rearms the CompuScope card for another trigger. In One Shot mode, GageScope® looks 
for a trigger event, performs a capture, then stops. 
If a trigger situation existed the moment you clicked on the One Shot button, 
GageScope® performs a capture immediately, then stops. This could happen so quickly it 
may look like it went directly to Stop. 

Q. The sample rates I have on my screen don’t match what’s in the manual. 

A. The available sample rates and other settings depend on the model of CompuScope card. 
The manual was written using a CompuScope 2125, which has a maximum sample rate 
of 250 MS/s in single channel mode. If you have a CompuScope 8012A, the maximum 
sample rate in single channel mode is 100 MS/s. 
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Q. My card is supposed to have a maximum sample rate of 100 MS/s. The maximum in the 
sample rate list is 50 MS/s. 

A. You are in dual channel mode. In dual channel mode, the maximum sample rate is half 
that of single channel mode. To resolve this problem, click on the single channel button 
in the CS tab of the System Control. 

Q. I know I have a channel in the Display Window, but I can’t see it. 

A. This could happen for a few reasons. 

• The channel is hidden. Check the channel list in the General tab of the Display 
Control (lower middle of the screen). 

• The channel is off-screen (outside of the Display Window). Click on the Arrange 
Channels button in toolbar to clean up the display. 

• You are in single channel mode. In single channel mode, you do not get access to 
channel 2, if your CompuScope card supports a second channel. Click on Dual 
Channel in the CS tab of the System Control. 

• The channel is the same color as the background color. For example, if the 
background color is black (the default), and the channel is black, it will appear 
invisible. To fix this problem, click on the tab of the channel you are looking for in 
the Channel Control (lower right of the screen), click on the Drawing tab, click on 
the Color button, and choose a new color. 

Q. Impedance is listed in the manual, but I don’t see it when I run GageScope® on my 
computer. 

A. The Impedance setting normally appears in the CS Input tab of the Channel Control 
(lower right of the screen). If your CompuScope card does not support Impedance, the 
Impedance setting will not show up in the Channel Control. 
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Q. I want to hide all controls. Is there a quick way to do it? 

A. You can hide controls individually by selecting them from the View menu, or you can 
select Full Screen from the View menu to hide everything at once. When you want to 
return the display to normal, click on the Full Screen button in the toolbar. 

 

 

Q. How can I turn off some of the Display Window settings (such as the grid)? 

A. The visibility and color of the grid and most other Display Window elements can be 
changed through the Settings tab of the Display Control. 

Q. How can I quickly get to the trigger marker (where the trigger event occurred)? 

A. Use the trigger align buttons in the toolbar. 

Q. After I press the MulRec button in the Depth tab of the System Control, nothing 
happens. 

A. Actually, quite a bit is happening, but the results usually aren’t visible right away. 
Depending on the depth settings, your CompuScope card can fit a maximum number of 
records into its onboard memory. It takes a few moments to capture all these records. 
Click the Multiple Record buttons in the toolbar to move from record to record to check 
if GageScope® has finished capturing data. 

Q. How do I tell how many records I have captured in Multiple Record mode? 

A. After finishing all the captures, GageScope® displays the number of records underneath 
each channel’s identifier at the left of the signal, in the form of 1/32, where 1 is the 
current record and 32 is the total number of records. 

Q. I changed the channel mode (in the CS tab of the System Control) from single to dual, 
but acquisition stopped and the Stop button became active. 

A. In certain cases you may find that when you change the channel mode from single to dual 
mode or vice-versa, continuous capture stops and the Stop button becomes active. This 
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usually happens when the threads in GageScope® have to be stopped to achieve proper 
synchronization. You can start continuous capture again by clicking on the Continuous 
button . 

Do you have a question? 
Visit Gage’s web site for more help on GageScope®.  

 http://www.gage-applied.com/ 

Or submit a support question through our online form. 

 www.gage-applied.com/support.asp 
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Appendix A: The Instrument Manager Utility 

The Instrument Manager configures the following: 
 

• PC-based Instruments 
 

These include the Gage high speed input and output, analog and digital data 
acquisition cards such as Compuscope 85G, 5 GigaSamples per second analog input 
card, which is the world’s fastest PC based A/D card in the market today. 

 
 

PC-based Instruments 

Follow the steps outlined below to configure PC-based instruments such as Gage high speed 
data acquisition cards.   
 
1 Right click Start on your computer’s desktop.  
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2 Click Explore. Windows Explorer will launch and you will see the following window 
with Start Menu selected as a default: 
 

 
 
Note: 

• Depending on the settings on your computer, you will see different contents in 
the explorer’s left pane.  

• You can also start Windows Explorer by clicking My Computer Icon from 
your computer’s desktop. 
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3 To look for the Instrument Manager folder, scroll down the window in the left pane. If 
the Instrument Manager has been installed, you will find a folder named Instrument 
Manager.  

Click Instrument Manager Icon  to launch the Instrument Manager Explorer. You 
can also get directly to this step by double-clicking the Instrument Manager Icon on your 
computer’s desktop. 
 

 
 
Note that the active Window title now reads Exploring: Instrument Manager. 
The contents of Instrument Manager folder appear in the right pane of the Instrument 
Manager Explorer. The right pane is divided into two fields: Name and Type. 
 
Name shows the name of the folder while Type specifies the type of resource contained 
in the corresponding named folder. 
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4 Click PC-based Instrumentation Icon, . The PC-based Explorer opens: 
 

 
 
Note that the right pane displays the PC-based resources currently present in the system.  
 
Four fields appear on the right hand side:  
Name  
Configuration Info 
Type  
Status 
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 Name The Name appears as System1, System2,… This list 
corresponds to the total number of Systems present in 
the PC. A system may comprise of a single or 
multiple Compuscope or Compugen cards. 

 
Configuration File Specifies the location of the configuration file in your 

personal computer. 
  
 The configuration file is saved with .inc extension in 

the Windows directory in your PC’s local drive. For 
example, the name assigned to the configuration file 
will be Gagescop.inc,  in case a CompuScope card is 
present in the PC. For a CompuGen card present in 
your machine, the name of the configuration file will 
be Gage_gen.inc 

 
Type The type of resource, e.g. CompuScope, which 

refers to the Gage A/D fast data acquisition card and 
CompuGen which is the 12 bit arbitrary waveform 
generator by Gage Applied Technologies, Inc. 

 
Status This field shows the Status of the configuration file. 

Saved is displayed in the Status field whenever the 
system configuration has been saved. Otherwise the 
Status field is left blank. 

  



 

D-8 Appendices 

5 Double click on System1 to view the System1 configuration as follows: 
 

 
 
You can see that the CompuScope card, CS8500, present in the system, has 2 
MegaSamples of onboard memory. Note that the CS8500 configuration settings are 
saved as shown in the Status field. In case the Status field does not show Saved, click on 
Save configuration icon from the toolbar or the drop down Gage menu. 
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6 Follow the same procedure for the CompuGen card to view and save the configuration 
settings for that card. 
 
Double click on System2 to view the System2 configuration as follows: 
 

 
 
You can view the configurations settings for a single CompuGen card, CG1100, present 
in your PC. Click on Save configuration icon from the toolbar or the drop down Gage 
menu. 
 

7 For the PC-based resources, the available fields in the right pane are  
 
Board Name 
IO Address 
Memory Base 
Memory 
Status  
 
The description of each of these fields is given as follows: 
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 Board Name This field identifies the name of the board present in 
the system. In the window shown above, CS8500 
refers to CompuScope 8500 ultra high speed A/D 
card manufactured by Gage Applied Technologies, 
Inc. 

 
IO Address The IO address corresponds to the |nput/Output 

address of the card specified as System1.  
 PCI PnP in this field shows that the CS8500 card is 

a Plug-and-Play device. For such cards, the IO 
address is automatically assigned by the Operating 
System. However, for an ISA card present in the 
system, the IO address of the card must be correctly 
specified. This is due to the fact that the Plug-and-
Play feature is not supported by the ISA bus cards.
  

 
Memory Base Memory Base specifies Base Memory address of the 

card in the system. For a list of permissible base 
memory addresses, refer to the Appendix D section 
of this chapter.  

  
 Note that the Base Memory address of a PCI bus card 

is automatically set by the Operating System. Hence, 
PCI PnP appears in the Memory Base field for the 
CS8500 card. 

  
 As for the IO address of the ISA bus cards, the Base 

memory address of an ISA bus card needs to be 
specified by the user. 

 
Memory The number in this field signifies the total amount of 

onboard memory in Samples present on the card. For 
CS8500 presently configured, 2M means that the 
total onboard memory available is two Mega 
Samples. 
 
For 8 bit cards, the memory specified in Samples is 
the same as the number of Bytes since a sample for 8 
bit Gage cards is a Byte. 

 
For 12 and 16 bit Gage cards, the memory specified 
in Samples is to be multiplied by two to obtain the 
memory size in Bytes. 
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 Status Status shows the status of the configuration file, 
Saved and Error are the two possible entries for 
Status. 

 Saved correspond to successful installation of drivers 
for the data acquisition card. Saved means that the 
configuration settings for Compuscope or Compugen 
cards have been saved in the Windows directory. 

 Error status means that a card does not exist in the 
system. 
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Gage Menu 

Gage Menu in the Menu bar allows users to configure newly installed Gage cards, set various 
options like adding, removing, saving file configurations for Gage CompuScope and 
CompuGen cards. Follow the steps below to explore Gage menu items:  
 
  
1 View Gage Menu drop down list by selecting Start --> Explore --> Instrument 

Manager --> PC-based Instruments --> Gage  
 
The Gage menu drop down list appears: 
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2 Gage menu is subdivided into four classes: 
 
• Driver Information 
 
 Compugen Driver 
 

Select Compugen Driver from the menu. The Compugen Driver 
information dialog box appears: 
 

 
 
The Compugen Driver information dialog box shows the types of 
boards supported, the version of the driver, location of the driver file in 
your machine, the driver size and date of creation. 

 
 Compuscope Driver 
 

Select Compuscope Driver from the menu. The Compuscope Driver 
information dialog box appears: 
 

 
 
The Compuscope Driver information dialog box shows the types of 
boards supported, the version of the driver, location of the driver file in 
your machine, the driver size and date of creation. 
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3 • Adding/Removing Cards 
 
 Add Card 
   

To add a CompuScope or a CompuGen card, click Add Card from the 
drop down menu. The Modify System dialog box appears: 
 

 
   

Two important pieces of information required to add a new card are the 
IO and Memory base addresses. 
  
Adding an ISA bus card 
 
To specify the IO address for the new ISA card, click on the display list 
symbol next to the text box under New Group. This is the text box, 
which is located in the first row. Select the address of the card from the 
drop down list. When you click on the appropriate address value, it 
shows in the IO address New text box. 
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Click on the selected IO address to view the following: 
 

 
 
The selected IO address appears in the IO address text box in the New 
Group. 
 
Repeat the same procedure for the Base Memory address for the ISA 
card. Click on the drop down list button besides the text box in the 
New Group.  The list of available memory base addresses appear: 
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4  Adding a PCI bus card 
 
To specify the IO address for the new PCI card, click on the display list 
symbol next to the text box under New Group. This is the text box, 
which is located in the first row. Select PCI PnP from the drop down 
list. When you click on the selected value, PCI PnP appears in the IO 
address New text box. 
 
Scroll down to the bottom of the list. Select PCI PnP. 
 

 
 
PCI PnP appears in the IO address text box in the New Group. 
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 Repeat the same procedure for the Base Memory address for the PCI 
card. Click on the drop down list button besides the text box in the 
New Group.  The list of available memory base addresses appear: 
 

 
 
Scroll down to the bottom of the list. Select PCI PnP. 
 

 
 
Note that the text boxes under the Current setting are greyed out since 
the new configuration has not been saved as yet. 

 



 

D-18 Appendices 

5  Remove Card 
 
To be able to remove a card from the system, you must select an 
already installed card from within the Instrument Manager Explorer.  
 
Follow the following sequence of steps to get to the PC-based 
Instruments folder in the Instrument Manager Explorer: 
Start --> Explore --> Instrument Manager --> PC-based 
Instruments  
 
You will see the following window: 
 

 
 
Click on System1 to select it. You will notice that the entire row will 
be selected. 
 
Now, right click on Gage Menu and select Remove card command. 
System1 will be deleted and you will see only System2 in the right 
pane. 
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6 • System Options 
  
 Set Mode 
   

Set Mode Option specifies whether a card is to be used in an 
independent unit or part of a Master/Slave system. 
 
As implied by independent, a Gage data acquisition card is to be used 
as a single card contrary to the Master/Slave Mode in which two or 
more Gage cards are set up as a multi channel system. 
 
Click Set Mode to select either of the two options, depending on the 
boards in your system: 
 

  
 

7  Verify System 
   

Once the new cards are configured properly, these need to be verified 
for proper operation. Click Verify System to make sure that the newly 
installed card(s) are verified. 
 

 Save System 
   

Save System command allows the Gage system configuration to be 
saved in the Windows directory as a GageScop.inc or Gage_gen.inc 
file. 
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8  Add System 
   

Add System command allows you to add two or more Compuscope or 
Compugen cards cards to your system.  
 
Click on Add System to view the two options. Select either of the two 
depending on the type of card you are trying to install.  
 

 
 
As soon as an option is selected, the Instrument Manager creates a new 
folder with an appropriate name in the PC-based Instrumentation 
folder. 
 
As an example, we have a CompuScope and a Compugen card 
configured in our PC. These appear as System1 and System2 under 
PC-based Instrumentation folder in the Instrument Manager: 
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System1 comprises of a Compuscope card while System2 shows that 
this system contains a Compugen card. 
 
When Add System command is selected from the Gage drop down 
menu, Instrument Manager creates a new System folder. The Name of 
the folder depends on whether the System belongs to Compuscope or 
the Compugen cards. 
 
In the present setup, if you add a CompuScope card as a new system, 
the name of the folder will be System2 and the Compugen system 
folder name will be automatically changed to be System3 instead of 
System2. 
 
In case the system being added comprises of a single or multiple 
Compugen cards, the name of the new System will be System3. 
  
Note that the cards in the new System need to be configured properly 
after the creation of the System folder. 

 
9  Remove System 

   
Click on the System to be removed from the setup.  
 
Click Gage Menu to view the drop down list. Select Remove System 
to remove the selected System from your PC. 
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10  Verify All Systems 
 
When this option is selected, all Systems in your personal computer are 
verified. 

 
11  Save All Systems 

 
When this option is selected, all Systems in your personal computer are 
saved. 
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List of Instruments Supported by GageScope® 
 
 
Type Model/Family Vendor     
DSO CompuScope 85G Gage     
DSO CompuScope 82G Gage     
DSO CompuScope 8500 Gage     
DSO CompuScope 14100 Gage     
DSO CompuScope 1450 Gage     
DSO CompuScope 12100 Gage     
DSO CompuScope 1250 Gage     
DSO CompuScope 1602 Gage     
DSO CompuScope 8012 Gage     
DSO CompuScope 8012A Gage     
DSO CompuScope 6012 Gage     
DSO CompuScope 1012 Gage     
DSO CompuScope 512 Gage     
DSO CompuScope 2125 Gage     
DSO CompuScope 265 Gage     
DSO CompuScope 250 Gage     
DSO CompuScope 225 Gage     
DSO CompuScope 220 Gage     
DSO CompuScope LITE Gage     
DSO CompuScope 8012A/PCI Gage     
DSO CompuScope 8012/PCI Gage     
DSO CompuScope 6012/PCI Gage     
DSO CompuScope 1012/PCI Gage     
DSO CompuScope 512/PCI Gage     
    
AWG CompuGen 1100 Gage  
 
Note 

For an updated list of supported instruments, visit the GageScope® web site at 
http://www.gagescope.com 
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Appendix B: GageScope® Signal File Format 
(.SIG) 

GageScope® signal files are binary files which contain a 512 byte header followed by any 
number of data points.  The first 512 bytes of a GageScope® signal file contain the header, the 
exact format of which is listed below:  
 

File 
Index 

Field 
Type 

Field 
Size 

Field Variable Field Description 

0 char 
Note 1. 

14 file_version Either GS V.1.20, GS V.2.00, GS 
V.2.05, GS V.2.10,  
GS V.2.15, GS V.2.20, GS V.2.25, GS 
V.2.50, GS V.2.60, GS V.2.65, GS 
V.2.70, GS V.2.75, GS V.2.80, GS 
V.2.85, GS V. 2.95 or GS V. 3.0. 

14 int16 2 crlf1 A carriage return line feed pair. 
16 char 9 name The channel name when stored. 
25 int16 2 crlf2 A carriage return line feed pair. 
27 char 256 comment The channel comment when stored. 

283 int16 2 crlf3 A carriage return line feed pair. 
285 int16 2 control_z A control Z, artificial end of file. 
287 int16 2 sample_rate_index Index to the sample rate table.  Note 2. 
289 int16 2 operation_mode 1 = single channel, 2 = dual channel. 
291 int32 4 trigger_depth Number of samples after the trigger 

point. 
295 int16 2 trigger_slope 1 = positive slope, 2 = negative slope. 
297 int16 2 trigger_source 1 = chan A, 2 = chan B, 3 = external, 

4 = automatic, 5 = keyboard. 
299 int16 2 trigger_level Stored as an int, actually a byte with the 

same format as the data.  Note 5. 
301 int32 4 sample_depth Number of samples stored in the signal 

section of the file. 
305 int16 2 captured_gain Index to the input range table.  Note 3. 
307 int16 2 captured_coupling 1 = DC, 2 = AC. 
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File 
Index 

Field 
Type 

Field 
Size 

Field Variable Field Description 

309 int32 4 current_mem_ptr Where display started when signal was 
stored. 

313 int32 4 starting_address The first point in the data. 
317 int32 4 trigger_address The point in the data where trigger 

occurred. 
321 int32 4 ending_address The last point of the captured data. 
325 uInt16 2 trigger_time The time when the trigger event 

occurred.  Note 7. 
327 uInt16 2 trigger_date The date on which the trigger event 

occurred. 
329 int16 2 trigger_coupling 1 = DC, 2 = AC.  For the external trigger 

input. 
331 int16 2 trigger_gain Index to the input range table.  Note 3. 
333 int16 2 probe Index to the probe table.  Note 4. 
335 int16 2 inverted_data 0 = normal data, 1 = inverted data 

(CS220), 2 = inverted and flipped data 
(CS220). 

337 uInt16 2 board_type The CompuScope board type on which 
the saved data was captured.  Note 6. 

339 int16 2 resolution_12_bits 0 = 8 bit file format, 1 = 12/16 bit file 
format. 

341 int16 2 multiple_record The mode that the saved data was 
captured in: 0 = normal mode, 1 = 
Hardware multiple record, 2 = Software 
multiple record.  Note: 5 = Multiple 
record with least significant bits saved 
and 6 = Software multiple record with 
least significant bits saved are not 
available in GageScope®.  They are 
currently only available in the drivers 
with a hardware upgrade. 

343 int16 2 trigger_probe Index to the probe table.  Note 4. 
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File 
Index 

Field 
Type 

Field 
Size 

Field Variable Field Description 

345 int16 2 sample_offset Used to offset the data for display and 
conversion to real voltages.  Normally 
127 for 8-bit CompuScopes and -1 for 
12-bit CompuScopes.  File versions 
before GS V. 2.95 will have sample 
offset=0 for 12-bit CompuScopes and 
128 for 8-bit CompuScopes. 

347 int16 2 sample_resolution Used to scale the data for display and 
conversion to real voltages.  Normally 
128 for 8-bit CompuScopes and 2048 for 
12-bit CompuScopes. 

349 int16 2 sample_bits Number of bits in the sampled data.  
Normally 8 for 8-bit CompuScopes and 
12 for 12-bit CompuScopes. 

351 uInt32 4 extended_trigger_ time The time when trigger event occurred.  
Note 7. 

355 int16 2 imped_a Impedance for Channel A.  0 = 1 
MegaOhm0x10 = 50 Ohm. 

357 int16 2 imped_b Impedance for Channel B. 0x0 = 1 
MegaOhm; 0x10 = 50 Ohm. 

359 float 4 external_tbs Time between samples in nanoseconds 
when using external clock. 

363 float 4 external_clock_rate Minimum sample rate when using 
external clock. 
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File 
Index 

Field 
Type 

Field 
Size 

Field Variable Field Description 

367 int32 4 file_options 01 = GAGE_SINGLE_CHAN 
02 = GAGE_DUAL_CHAN 
04 = GAGE_MODE_EXT_CLK_ADJ.  
Can be ORed with either 
GAGE_DUAL_CHAN or 
GAGE_SINGLE_CHAN. 
08 = GAGE_MODE_MR_JITTER_ADJ.
Can be ORed with either 
GAGE_DUAL_CHAN or 
GAGE_SINGLE_CHAN. 
10 = GAGE_FAST_RAM_ADJ. Can be 
ORed with either GAGE_DUAL_CHAN 
or GAGE_SINGLE_CHAN. 
20 = GAGE_X012X_VERS_ADJUST. 
Can be ORed with either 
GAGE_DUAL_CHAN or 
GAGE_SINGLE_CHAN. 

371 uInt16 2 version Version of the CompuScope hardware, 4 
BCD digits. 

373 uInt32 4 eeprom_options Hardware options stored in the 
CompuScope board’s on-board 
EEPROM. 

377 uInt32 4 trigger_hardware Auxiliary trigger hardware in use.  0 = 
none; 1 = Trigger Marker Board 
(TMB). 

381 uInt32 4 record_depth The size of each Multiple Record 
record when operating in Pre-trigger 
Multiple Record (PTM) mode. 

385 uInt8 127 padding 0 filled section to complete the 512 
byte header. 
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File 
Index 

Field 
Type 

Field 
Size 

Field Variable Field Description 

512 uInt8 
/ 

int16 
 
 

See 
note 

var signal RAM image of the CompuScope 
memory at the time the signal file was 
stored.  This data is in two different 
formats.   
The first format is when 
"operation_mode" is equal to two.  The 
data is stored contiguously as a binary 
image of the saved channel's signal 
storage space (one-half the memory 
depth).   
The second format is when 
"operation_mode" is equal to one.  The 
data is interleaved as a binary image of 
the complete signal storage space for 
the single channel mode (full memory 
depth).   
Interleaved in this example means the 
data is in two sections after the header.  
The first section is the data that was 
stored in the CompuScope memory for 
converter A and the second section of 
data is the memory assigned to 
converter B.  All even addresses are in 
the area for converter A while the odd 
addresses are in the same place as the 
next smaller address, but offset into the 
converter B data area.   
In both cases, the stored addresses for 
the signals are indexes into the data.  
When extracting data, care must be 
taken to "wrap the pointers around" at 
the end of the file.   
NOTE:  If the "resolution_12_bits" 
flag equals zero then the data is stored 
as unsigned 8 bit bytes.  Note 5.  
Otherwise, if the "resolution_12_bits" 
flag equals one then the data is in the 
12/16 bit format which is stored as 16 
bit signed integers (in the 12 bit mode 
the sampled data is sign extended to 16 
bits). 
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Note 1:  Memory types 

For portability reasons, the signal files use the following predefined memory types: 
 
char = ASCII character 
 
int 8  =  signed char (or byte) 
 
uInt 8  = unsigned char (or byte) 
 
int 16  = signed 16-bit integer 
 
uInt 16 = unsigned 16-bit integer 
 
int 32  = signed 32-bit integer 
 
uInt 32 =  unsigned 32-bit integer 

Note 2:  Miscellenous 

• GageScope® files are always stored in the dual channel format i.e. (Op Mode == 2) 

• GageScope® can also save files in the 32 bit format 
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Note 3:  The "sample_rate_index" to the sample rate table 

For all file 
versions 

Version 2.65 and 
below 

Version 2.70 and above Version 2.85 and 
above 

Index Sample 
Rate 

Index Sample 
Rate 

Index Sample Rate Index Sample 
Rate 

0 1 Hz 18 1 MHz 18 1 MHz 18 1 MHz 
1 2 Hz 19 2 MHz 19 2 MHz 19 2 MHz 
2 5 Hz 20 5 MHz 20 4 MHz 20 4 MHz 
3 10 Hz 21 10 MHz 21 5 MHz 21 5 MHz 
4 20 Hz 22 20 MHz 22 10 MHz 22 10 MHz 
5 50 Hz 23 25 MHz 23 20 MHz 23 12.5 MHz 
6 100 Hz 24 40 MHz 24 25 MHz 24 20 MHz 
7 200 Hz 25 50 MHz 25 30 MHz 25 25 MHz 
8 500 Hz 26 100 MHz 26 40 MHz 26 30 MHz 

9 1 kHz   27 50 MHz 27 40 MHz 
10 2 kHz   28 60 MHz 28 50 MHz 
11 5 kHz   29 100 MHz 29 60 MHz 
12 10 kHz   30 120 MHz 30 65 MHz 
13 20 kHz   31 125 MHz 31 80 MHz 
14 50 kHz   32 150 MHz 32 100 MHz 
15 100 kHz   33 200 MHz 33 120 MHz 
16 200 kHz   34 250 MHz 34 125 MHz 
17 500 kHz   35 300 MHz 35 130 MHz 

    36 500 MHz 36 150 MHz 
    37 1 GHz 37 200 MHz 
    38 2 GHz 38 250 MHz 
    39 5 GHz 39 300 MHz 
    40 External Clock 40 500 MHz 
    39* 4 GHz 41 1 GHz 
    40* 5 GHz 42 2 GHz 

* For File Version 2.80 and above 41* External Clock   
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For all file versions Version 3.00 and above Version 3.00 and above 

Index Sample Rate Index Sample Rate Index Sample Rate 

0 1 Hz 18 1 MHz 33 120 MHz 
1 2 Hz 19 2 MHz 34 125 MHz 
2 5 Hz 20 2.5 MHz* 35 130 MHz 
3 10 Hz 21 5 MHz 36 150 MHz 
4 20 Hz 22 10 MHz 37 200 MHz 
5 50 Hz 23 12.5 MHz 38 250 MHz 
6 100 Hz 24 20 MHz 39 300 MHz 
7 200 Hz 25 25 MHz 40 500 MHz 
8 500 Hz 26 30 MHz 41 1 GHz 
9 1 kHz 27 40 MHz 42 2 GHz 

10 2 kHz 28 50 MHz 43 4 GHz 
11 5 kHz 29 60 MHz 44 5 GHz 
12 10 kHz 30 65 MHz 45 8 GHz 
13 20 kHz 31 80 MHz 46 10 GHz 
14 50 kHz 32 100 MHz 47 External Clock 

15 100 kHz     
16 200 kHz     
17 500 kHz     

 
*This entry was previously 4 MHz.  Used on CSx012 and CSx012/PCI boards except for 
CS512 and CS512/PCI.  Support for this sample rate has been dropped. 
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Note 4:  The "captured_gain" and "trigger_gain" input ranges 

If "file_version" equals "GS V.1.20" Index Input Range 

 0 +/- 1v 

 1 +/- 200mv 
 

If "file_version" is greater than or equal to "GS V.2.00" Index Input Range 

 0 +/- 10v 

 1 +/- 5v 

 2 +/- 2v 

 3 +/- 1v 

 4 +/- 500mv 

 5 +/- 200mv 

 6 +/- 100mv 

Note 5:  The "probe" connected to the input channel at time of capture. 

If "file_version" is less than or equal to "GS V.2.10" Index Probe Multiplier 

 0 x1 

 1 x10 

 2 x20 

 3 x100 

 4 x200 
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If "file_version" is greater than or equal to "GS V.2.15" Index Probe Multiplier 

 0 x1 

 1 x10 

 2 x20 

 3 x50 

 4 x100 

 5 x200 

 6 x500 

 7 x1000 

Note 6:  The "trigger_level" and the "captured_data" 8 bit uInt8 format 

The byte stored as the trigger level is in the following format:  the data on the CS8500, 
CS2125, CS265, CS250, CS225 and CSLITE is represented as an 8-bit unsigned integer, 
where the smallest value (0) represents -1 V and the largest value (255) represents +1 V. On 
the other hand, for the captured data, smallest value (0) represents +1 V and the largest value 
(255) represents -1 V. The data is normalized into a signed floating-point representation.  The 
input range and probe are then multiplied by the return value to produce the actual level either 
sent to the hardware as the trigger level or returned from it after capture. 
 
If the "resolution_12_bits" flag equals zero then the data is stored as unsigned 8 bit bytes.   
Otherwise, if the "resolution_12_bits" flag equals one then the data is in the 12/16 bit format 
which is stored as 16 bit signed integers (in the 12 bit mode the sampled data is sign extended 
to 16 bits). For the 12 bit boards, the smallest value (-2047) represents –1V while the largest 
value (+2047) represents +1V for the trigger level whereas the smallest and the largest values 
represent +1V and –1V respectively for the captured data. 
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Note 7:  The "board_type" constants 

"board_type" CompuScope Hardware 

0x0000 Unknown (pre "file_version" GS v2.25) 

0x0001 CompuScope 265 

0x0002 CompuScope 8500 

0x0004 CompuScope 8012-TYPE* 

0x0008 CompuScope 8012 

0x000E CompuScope 12100, CompuScope 12130,  
CompuScope 1250 

0x0010 CompuScope PCI 

0x001C CompuScope 8012/PCI 

0x0020 CompuScope 512 

0x0040 CompuScope 225 

0x0080 CompuScope 250 v1.8+ 

0x0100 CompuScope LITE (pre-hardware version 1.5) 

0x0200 CompuScope 220 

0x0400 CompuScope 250 

0x0800 CompuScope LITE (hardware version 1.5 & up). 

0x1000 CompuScope 1012 

0x1010 CompuScope 1012/PCI 

0x2000 CompuScope 6012 

0x2010 CompuScope 6012/PCI 

0x4000 CompuScope 2125 

0x8000 CompuScope 1016 

0x8006 CompuScope 1610 

* CompuScope 8012-TYPE refers to CSx012 cards, version 2.0+. 
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Note 8: Extended trigger time 

GageScope® now supports an extended time stamp for the trigger event time of day.  The 
resolution of this timer is in hundredths of a second.  However, on some computer systems 
the real-time clock does not support complete accuracy at this resolution.  If the normal 
trigger time in the signal file is zero, then the extended trigger time stamp is being used.  The 
encoded long integer is hhhhhmmmmmmssssssddddddd, where dddddd is hundredths of a 
second.  Note also that the new time supports full seconds. 
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Appendix C: Default Settings 

The following settings are used upon startup of GageScope®. 

CompuScope Card and Display Settings 

Capture Mode: Continuous 
Channel Mode: Dual (if two channels are available) 
Sample Rate: Maximum allowed by your CompuScope 
SuperRes Mode: Off 

Channel Settings 

Identification: Channel A of the CompuScope is channel 1 
Channel B of the CompuScope is channel 2 

Colors: Channel 1 set to yellow, channel 2 set to green 
Input Range: All channels set to ±1V (±2V for CS1016) 
Position: Depends on the number of channels. If there are two channels, 

channel 1 is displayed in the top half of the Display Window, and 
channel 2 is displayed in the bottom half. If there is only one channel, 
it is displayed in the middle of the Display Window 

Vertical Scale: All channels set to 1 Volt per division 
Method: Min Max 
Trace: Connect Dots 
Impedance: 1 MOhm (if the CompuScope allows it) 
Probe:  X1 

Trigger Settings 

Trigger: Set to channel 1 
Trigger Level: 0 mV 
Timeout: 10 ms 
Slope: Positive 
Pre-trigger depth: 4096 Samples 
Post-trigger depth: 4096 Samples 
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Display Settings 

Timebase: 5 us/d 
Channels Shown: All channels visible. A CompuScope channel that is not connected to 

a signal will display as a flat line 
Persistence: Off 
Grid: On 
X/Y Axis: On 
Zero Lines: On 
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Appendix D: CompuScope I/O Settings 

This appendix contains brief information on solving I/O address conflicts encountered when 
configuring your CompuScope cards using the Instrument Manager. It is assumed that the 
cards have been properly installed in your computer. For more details on installing your 
CompuScope card, consult your CompuScope hardware manual or Start-up Guide. 
 
Before changing the I/O address on your CompuScope card, ensure that the I/O address 
entered in Instrument Manager matches that set via the switches or jumpers, as outlined in the 
Configuring PC-based cards using the Instrument Manager. 

Alternate I/O Addresses 

Note about PCI-based Boards 

I/O addresses are not specified by the user for following PCI-based boards: 
 

• CompuScope 85G 
• CompuScope 82G 
• CompuScope 1602 
• CompuScope 14100 
• CompuScope 12100 
• CompuScope 1250 
• CompuScope 8500 

 
The assignment of I/O addresses for these boards is handled by the PCI BIOS at boot time. 
Please refer to the Gage Driver Installation Guide for CompuScope Cards for further details. 
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CompuScope 8012A/PCI, 8012/PCI, 6012/PCI, 1012/PCI and 512/PCI 

The DIP switch SW1, as shown in the diagram below, defines the base I/O address of the 
CS8012A/PCI, CS8012/PCI, CS6012/PCI, CS1012/PCI and CS512/PCI boards. 
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus. As the CS8012A/PCI, CS8012/PCI, CS6012/PCI, CS1012/PCI and 
CS512/PCI use two I/O locations, there is no need to configure a switch for A0. A10 is not 
used.  
 

0200 0202

0204 0206

0208 020A

020C 020E

0210 0212

0214 0216

0218 021A

021C 021E

0280 0290

0300 0302

0304 0306

0308 030A  
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0220 0230

0240 0250

0260 0270

030C 030E

0310 0320

0330 0340

0350 0360

0370 0380

03E00390  

CompuScope 1016 

The SIP switch SW1, as shown in the diagram below, defines the base I/O address of the 
CS1016 board. (Note: The illustration below shows CS1016 v1.1, but the I/O Switch SW1 
has the same location on CS1016 v1.0.)  
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus. As the CS1016 uses two I/O locations, there is no need to configure a 
switch for A0. A10 is not used.  
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0200 0202

0204 0206

0208 020A

020C 020E

0210 0212

0214 0216

0218 021A

021C 021E  

0220 0230

0240 0250

0260 0270

 

0280 0290

0300 0302

0304 0306

0308 030A  

030C 030E

0310 0320

0330 0340

0350 0360

0370 0380

03E00390  

 

CompuScope 8012A, 8012, 6012, 1012, and 512 

The DIP switch SW, as shown in the diagram below, defines the base I/O address of the 
CS8012A, CS8012, CS6012, CS1012 and CS512 boards. (See the following page for I/O 
Addresses for CS8012A v3.0.) 
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus. As the CS8012A, CS8012, CS6012, CS1012 and CS512 use two I/O 
locations, there is no need to configure a switch for A0. A10 is not used. 
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0200 0202

0204 0206

0208 020A

020C 020E

0210 0212

0214 0216

0218 021A

021C 021E  

0220 0230

0240 0250

0260 0270

 

0280 0290

0300 0302

0304 0306

0308 030A  

030C 030E

0310 0320

0330 0340

0350 0360

0370 0380

03E00390  
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CompuScope 8012A Board Version 3.0 

The DIP switch SW1, as shown in the diagram below, defines the base I/O address of the 
CS8012A v3.0 board. 
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus. As the CS8012A uses two I/O locations, there is no need to configure a 
switch for A0. A10 is not used. To change the switch setting, a 1 mm (1/16 in.) jeweler’s 
screwdriver is recommended.  
 
NOTE FOR MULTI-CARD SYSTEMS:  If you need to change the I/O switch setting, you 
must remove the Interconnect first in order to access the I/O switch. 
 

 
 

0200                9 
UP 

0202               1,9 
UP 

0204                  2,9 
UP 

0206               1,2,9 
UP 

0208                  3,9 
UP 

020A              1,3,9 
UP 

020C              2,3,9 
UP 

020E            1,2,3,9 
UP 
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0210                  4,9 
UP 

0212               1,4,9 
UP 

0214               2,4,9 
UP 

0216            1,2,4,9 
UP 

0218               3,4,9 
UP 

021A            1,3,4,9 
UP 

021C           2,3,4,9 
UP 

021E         1,2,3,4,9 
UP 



 

Appendices D-45 

CS8012A  v3.0 I/O Switch Settings (Continued) 

0220                 5,9 
UP 

0230              4,5,9 
UP 

0240                  6,9 
UP 

0250               4,6,9 
UP 

0260               5,6,9 
UP 

0270            4,5,6,9 
UP 

0280                  7,9 
UP 

0290               4,7,9 
UP 

0300                  8,9 
UP 

0302               1,8,9 
UP 

0304               2,8,9 
UP 

0306            1,2,8,9 
UP 

0308               3,8,9 
UP 

030A           1,3,8,9 
UP 

030C           2,3,8,9 
UP 

030E         1,2,3,8,9 
UP 

0310               4,8,9 
UP 

0320               5,8,9 
UP 

0330            4,5,8,9 
UP 

0340               6,8,9 
UP 

0350            4,6,8,9 
UP 

0360            5,6,8,9 
UP 

0370         4,5,6,8,9 
UP 

0380               7,8,9 
UP 

0390            4,7,8,9 
UP 

03E0         5,6,7,8,9 
UP 
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CompuScope 2125 and 265 

The SIP switch SW1, as shown in the diagrams below, defines the base I/O address of the 
CS2125 and CS265 boards. 
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus. As the CS2125 and CS265 use two I/O locations, there is no need to 
configure a switch for A0. A10 is not used. 
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CompuScope 250 and 225 (32K and 128K Memory Depths) 

The connector JP7, as shown in the diagram below, defines the base I/O address of the CS250 
or CS225  board. 
 

 
 

The switch position SW9 is indicated by the arrow at the top of JP7.  Each of the switches 
SW1 through SW9 corresponds to an address line A1 through A9 from the ISA bus.  As the 
CS250 and CS225 use two I/O locations, there is no need to configure a switch for A0.   
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CompuScope 250 and 225 with Extended Memory 

The DIP switch JP1, as shown in the diagram below, defines the base I/O address of the 
CS250 or CS225 board. 
 

 
 

Each of the switch positions A1 through A9 corresponds to an address line A1 through A9 
from the ISA bus.  As the CS250 and CS225 use two I/O locations, there is no need to 
configure a switch for A0. 
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0200
ON

0202
ON

0204
ON

0206
ON

0208
ON

020A
ON

020C
ON

020E
ON

0210
ON

0212
ON

0214
ON

0216
ON

0218
ON

021A
ON

021C
ON

021E
ON

0220
ON

0230
ON

0240
ON

0250
ON

0260
ON

 

0270
ON

0280
ON

0290
ON

0300
ON

0302
ON

0304
ON

0306
ON

0308
ON

030A
ON

 
030C

ON

030E
ON

0310
ON

0320
ON

0330
ON

0340
ON

0350
ON

0360
ON

0370
ON

0380
ON

0390
ON

03E0
ON
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CompuScope 220 

The connector J5, as shown in the diagram below, defines the base I/O address of the CS220 
board: 
 

SW1
SW2
SW3
SW4
SW5
SW6

J5

J5

 
 

Each of the switches SW1 through SW6 corresponds to an address line A4 through A9 from 
the ISA bus.  As the CS220 uses 16 I/O locations, there is no need to configure switches for 
A0 to A3. 
 

 
 SW1

SW2
SW3
SW4
SW5
SW6

0200

SW1
SW2
SW3
SW4
SW5
SW6

0220

SW1
SW2
SW3
SW4
SW5
SW6

0240

SW1
SW2
SW3
SW4
SW5
SW6

0250
SW1
SW2
SW3
SW4
SW5
SW6

0260

SW1
SW2
SW3
SW4
SW5
SW6

0280

SW1
SW2
SW3
SW4
SW5
SW6

0290

SW1
SW2
SW3
SW4
SW5
SW6

02A0

SW1
SW2
SW3
SW4
SW5
SW6

0300

SW1
SW2
SW3
SW4
SW5
SW6

0310

SW1
SW2
SW3
SW4
SW5
SW6

0330

SW1
SW2
SW3
SW4
SW5
SW6

0340

SW1
SW2
SW3
SW4
SW5
SW6

0350

SW1
SW2
SW3
SW4
SW5
SW6

0360

SW1
SW2
SW3
SW4
SW5
SW6

0390

SW1
SW2
SW3
SW4
SW5
SW6

03E0
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CompuScope LITE 

The connector JP8, as shown in the diagram below, defines the base I/O address of the 
CSLITE board: 
 

 
 

Each of the switches SW1 through SW9 corresponds to an address line A1 through A9 from 
the ISA bus. As the CSLITE uses two I/O locations, there is no need to configure a switch for 
A0. 
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Appendix E: Using the Test Output Connector 

If you do not have a signal generator in order to use GageScope®, you can use the test output 
connector found on certain CompuScope cards. These are: 
 
• CompuScope 8012A/PCI 
• CompuScope 8012/PCI 
• CompuScope 6012/PCI 
• CompuScope 1012/PCI 
• CompuScope 512/PCI 

• CompuScope 8012A 
• CompuScope 8012 
• CompuScope 6012 
• CompuScope 1012 
• CompuScope 512 
 

• CompuScope 2125 
• CompuScope 265 
• CompuScope 250 
• CompuScope 225 

If your card is not listed here, consult your user’s manual to see if it is equipped with a test 
output connector. 
 
If your CompuScope card is equipped with such special options as Gated Digitization or 
External Clock, which make use of the test output BNC connector, you must use a signal 
generator to provide a test signal. 
 
Note that the test output only works at 20 MHz or less in the CompuScope 8012A/PCI, 
CompuScope 8012A, CompuScope 8012/PCI, CompuScope 8012, CompuScope 6012/PCI, 
and CompuScope 6012. 

Setting up the Test Signal 

1 Set up an external probe to capture the test signal from the connector at the rear of the 
board. 

2 Connect the probe’s BNC connector to the BNC connector of the Channel A Input at the 
rear of the board. 

3 Plug the other end of the probe into the TEST output BNC connector. 

CompuScope LITE 

You do not need external probes to capture the test signal from the CSLITE, since this board 
is equipped with an Internal Test Output. 
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Aliasing 

Aliasing occurs when a signal is sampled at a frequency lower than twice its highest 
frequency component (2 * fmax). If this happens, the resulting digital representation will be 
incorrect. Typically, the signal would appear to have a frequency very different from the 
actual. No amount of digital filtering can correct errors induced by aliasing. See Nyquist 
Theorem. 

Amplitude Resolution and ENOB 

The A/D converter used in a digitizing scheme typically has a fixed vertical resolution. This 
resolution is limited by the number of on-chip comparators for a flash converter (like the 
ones used on the CompuScope boards). 

The Signal to Noise Ratio (SNR) of a digitizer system is another measure of the vertical 
resolution. The SNR is measured in dB and the ideal maximum is approximately 6 dB per 
1 bit of resolution. 

In practice, the SNR is always less than this ideal number due to aperture jitter, EMI and 
general system noise. The Effective Number of Bits (ENOB) of a digitizer system is 
calculated using the following equation: 

 ENOB = (SNR - 1.76) / 6.02 

Analog Bandwidth 

The analog bandwidth of a digitizer system depends upon the bandwidth of the front-end 
amplifier or the A/D converter, whichever is less. 

The Full Power Analog Bandwidth is defined as the frequency at which the output is 3 dB 
below the input when the input is at its full scale.  

The Small Signal Analog Bandwidth is defined as the frequency at which the output is 3 dB 
below the input when the input is 20 dB below the full scale. 
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Analog to Digital Conversion 

Analog to digital (A/D) conversion is a process by which an analog signal is sampled and 
converted to a digital pattern of n bits where each n-bit “sample” represents the amplitude of 
the analog signal at a given time. This conversion is necessary as computers do not 
understand analog signals. 

Flash A/D Converters are the most popular devices for use in a High Speed A/D Conversion 
system. An n-bit flash ADC contains 2n comparators. Each comparator compares the input 
signal with a fixed voltage level generated by a resistor ladder. The 2n outputs are encoded 
to an n-bit word by the on-chip encoder. 

Capture Modes 

GageScope® has two capture modes: Continuous and One Shot. In Continuous mode, 
GageScope® repeatedly waits for a trigger event, acquires and displays the data, then waits 
for another trigger event.  

In One Shot mode, GageScope® waits for a trigger event, acquires and displays the data, 
then stops. This allows for unattended capture of both pre- and post-trigger data. 

Channel 

A channel on a CompuScope card refers to the card’s input connectors, named Channel A 
and, if the card is equipped with two channels, Channel B. 

A channel in GageScope® refers to any one of the waveforms available for processing, 
whether they originated from a CompuScope card, a channel file, or a mathematical formula. 

Channel Mode 

Most, but not all, CompuScope cards are equipped with two input channels. Dual channel 
mode refers to having access to both channels at the same time for data acquisition. Single 
channel mode refers to “shutting off” the second channel and acquiring data only from the 
first channel. 

The advantage of single channel mode is that the sample rate is twice that of dual channel 
mode. For example, the CS8012A can sample at 50 MS/s in dual channel mode and 
100 MS/s in single channel mode. 
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Continuous Capture Mode 

See Capture Modes. 

Cursors 

Cursors allow the user to measure the distance between two locations on the same signal or 
on different signals. In GageScope®, a cursor is represented by a small x in the display 
window. 

Display Method 

The Display Method is the method GageScope® uses to draw traces when two or more pixels 
are to be displayed in the same pixel column. 

In many situations, the number of screen pixels available is much smaller than the number of 
sample points to be displayed. For example, with screen depth set to 800x600 pixels, 
GageScope® might have to display 6000 points in a display window 600 pixels wide. In 
order to draw the waveform, GageScope® must make a choice as to which pixel to use. 

See Mean Display Method and MinMax Display Method. 

DLL (Dynamically Linked Library) 

A DLL is a library of routines dynamically linked at run-time under Windows operating 
system. 

Dual Channel Mode 

See Channel Mode. 

Effective Aperture Delay 

The finite period of time between the rising edge of the CONVERT clock and the instant at 
which the sample is taken. 
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ENOB 

Effective Number Of Bits, defined using the following equation: 

 ENOB = (SNR - 1.76) / 6.02 

See Amplitude Resolution and ENOB. See also Signal to Noise Ratio (SNR). 

Equivalent Time Sampling 

With Equivalent Time Sampling, the A/D system repeatedly samples the input at a rate Fs, 
but delays sampling every time by time td such that: 

 td = 1 / (N * Fs). 

This yields a sampling rate of N * Fs with the condition that, in an Equivalent Time 
Sampling system, the input signal must be repetitive. 

If the input signal changes even by a very small margin for a short period of time, Equivalent 
Time Sampling method will either not capture the change or capture it and give an erroneous 
result. 

See Real Time Sampling. 

Full Power Analog Bandwidth 

Full Power Analog Bandwidth is defined as the frequency at which the output is 3 dB below 
the input when the input is at its full scale. See Analog Bandwidth. 

Gated Digitization 

An optional hardware upgrade for CompuScope cards that allows the user to select the 
portion of the input signal to be digitized. When nothing is connected to the Gate, or Gate is 
made HIGH, data is stored in the on-board memory. 
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Grid 

The Grid is a set of vertical and horizontal lines drawn at regular intervals in the display 
window. The resulting grid has 8 squares from top to bottom and 10 squares from left to 
right (although this can be changed by the user). Each square is counted as a “division” and 
is used as a reference in other parts of GageScope® (such as the Position setting in the 
Parameter tab of the Channel Control). The grid is a permanent fixture in the display 
window and is not affected by movement of the scroll bar. 

Input Range 

The Input Range is the range in Volts that GageScope® uses to acquire data. The current 
range of a signal can be measured by eye using the Display Window grid—by default, each 
grid square measures 1V high.  

Inter Sample Delay 

The time that must elapse between two successive high speed data captures. This feature is 
important for long term monitoring of signals. 

Interpolation 

A signal might become pointed or jagged when the number of samples per grid square 
becomes very small. When GageScope® performs interpolation on a signal, it uses a 
mathematical formula to add extra sample points in order to smoothen its appearance. See 
Spline Interpolation. 
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ISA and PCI Bus 

The ISA bus is the computer bus found inside all IBM PC AT, 386, 486 and Pentium 
systems. It is by far the most popular 16 bit bus in the industry and has become the standard 
for PC-based data acquisition and instrumentation. With a standard 8 MHz clock speed, the 
ISA bus can transfer data with a throughput of up to 1.5 Megawords per second. 

The PCI bus is a processor-independent, 32 bit local bus featured on almost all computers 
built around the Pentium, PowerPC and Alpha microprocessors. With its 33 MHz clock 
speed, PCI has the capability of burst transfer rates as high as 133 MB/s. This number can be 
doubled if the 64 bit extension of PCI is used. 

Mean Display Method 

When two or more samples are to be displayed on the same pixel column, Mean averages all 
the data points in order to display one single point. This is useful when the number of 
samples per grid square becomes very large (such as when the timebase is increased).  

Mean increases the Effective Resolution when capturing and displaying low frequency 
signals at high sample rates, i.e., when a signal is being oversampled. 

See Display Method. 

Megasamples 

A Megasample is 1,000,000 Samples. 

Memory Depth 

The A/D data has to be stored in digital memory so the microprocessor can read it at a later 
time. The amount of memory available for this purpose is called the memory depth of the 
A/D system. See On-board Memory. 
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MinMax Display Method 

When two or more samples are to be displayed on the same pixel column, MinMax plots the 
minimum and maximum values, then draws a line between them. This method allows glitch 
detection even at very low timebases. 

See Display Method. 

Multi-Card System 

A Multi-Card System is a system with multiple CompuScope or CompuGen cards that can 
be used with a common clock and trigger, to provide multiple input or output channels at 
very high speed. 

Multiple Record 

A feature supported by a number of CompuScope cards which lets the user take advantage of 
the very deep on-board buffers.  

The user is able to set the number of samples to be captured after a trigger, but, unlike the 
normal capture sequence, the CompuScope card acquires the specified number of points and 
then re-arms itself to acquire more data after another trigger. Data collected from each 
successive acquisition is "stacked" on top of the previous acquisition until the on-board 
buffer fills up.  

For example, if a post-trigger depth of 1024 points is specified, the first acquisition stores 
data in addresses between 0 and 1023, the next acquisition from 1024 to 2047, and so on 
until the buffer is full. 

This feature is invaluable in applications in which trigger events are occurring rapidly or 
unpredictably, and A/D down-time has to be minimized. 
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Nyquist Theorem 

The Nyquist Theorem states that a function, v(t), whose highest frequency component is fmax, 
must be sampled at a frequency Fs such that  

 Fs = 2 * fmax 

In other words, if an A/D device samples the input signal at a maximum frequency of Fs, the 
signal frequency can not be determined unless it is guaranteed that the maximum frequency 
component of the input signal is half the sampling frequency (0.5 * Fs). For example, in the 
case of CompuScope 250, Fs is 100 MHz, therefore the input signal must not have frequency 
components higher than 50 MHz. 

Note: To reconstruct the signal in the time domain, the sample rate should be at least five 
times the maximum frequency component (Fs = 5 * fmax). 

On-board Memory 

In CompuScope cards, on-board memory refers to the amount of high-speed memory the 
card has. On-board Memory is measured in Megasamples. 

As an ultra-fast data acquisition device, the CompuScope card can convert analog signals 
must faster than the resulting data can be transferred to the PC’s host memory. To solve this 
problem, the CompuScope card can be instructed to store the data in its on-board memory, 
until such time that the data can be transferred later. 

The amount of this high-speed memory determines the Record Length of data capture, i.e., 
how long a snapshot the CompuScope can take. 

See Sample Rate, Record Length, and ISA and PCI Bus. See also Memory Depth and 
Samples. 

One Shot Capture Mode 

See Capture Modes. 

PCI Bus 

See ISA and PCI Bus. 
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Points 

See Samples. 

Polarization 

Polarization refers to how the trace is displayed relative to the X axis. When polarization is 
normal, the channel is displayed exactly as captured. Inverting the polarization inverts the 
signal about the X axis for purposes of the display, without affecting the actual data. 

Post-trigger Data 

Post-trigger data is the data acquired after a trigger event occurs. Post-trigger data is located 
to the right of the trigger marker. 

Pre-trigger Data 

Pre-trigger data is the data acquired before a trigger event occurs. Pre-trigger data is located 
to the left of the trigger marker. 

Real Time Sampling 

Real Time sampling, as used in the CompuScope cards, is defined as the sampling of the 
input waveform every T seconds, such that the sampling rate Fs is equal to 1 / T.  

This is the best method of digitizing any signal, be it transient or continuous. Samples are 
taken on every clock cycle and stored in a memory buffer. The signal is then recreated in 
software with a guarantee that no transient event which satisfied the Nyquist Criterion has 
been missed. 

See Equivalent Time Sampling. 
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Record Length 

The total amount of data that can be stored in a CompuScope card’s on-board memory, 
measured in units of time. Record Length is defined as: 

 On-board Memory Depth (samples) / Sample Rate (MS/s) 

For example, a CS250 with 32K memory sampling at 100 MS/s provides a record length of: 

 (32,768 bytes) / (100,000,000 8-bit samples / second) 
 (32,768 bytes) / (100,000,000 bytes / second) 
 (32,768 / 100,000,000) seconds 
 327.6 microseconds 

See Memory Depth and Sample Rate. 

Sample Rate 

The sample rate is the number of times per second analog signals are converted to digital 
signals. The sample rate is measured in Megasamples per Second (MS/s). The timing is 
controlled by an internal or external clock.  

See also Record Length and Memory Depth. 

Samples 

A sample is a single value measured in Volts converted at a single point in time from an 
analog signal. A sample is also referred to a sample point or a point. 

Note that the terms samples and bytes, or megasamples and megabytes, cannot be used 
interchangeably. Although it is true that a sample acquired through an 8-bit CompuScope 
card takes up 1 byte, a sample acquired through a 12-bit card (such as the CS8012) or 16-bit 
card (such as the CS1016) takes up 2 bytes. Furthermore, a megasample is equal to 
1,000,000 samples, while a megabyte is 1,048,576 bytes. 

SIG File 

A SIG file is the signal file format shared by GageScope® and GageScope® for DOS. SIG 
files record the voltage levels vs. time as recorded during a data acquisition. SIG file are in 
binary format so as to keep the files as small as possible. 
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Signal to Noise Ratio (SNR) 

Signal to Noise Ratio (SNR) is a frequency domain parameter measured at specific input 
frequencies. Using FFT analysis, the power spectrum of a known input sine wave is 
calculated. The contents of all frequency bins containing frequencies other than the 
fundamental (input frequency) and its harmonics are added. The ratio of the content of the 
fundamental frequency bin to this sum is the SNR of the system. 

This parameter is more useful for specifying the performance of a high-speed A/D device 
than the conventional DC accuracy figures used for oscilloscopes.  

Also see Total Harmonic Distortion and Effective Number Of Bits. 

SINAD 

SINAD is the ratio of the power in the fundamental bins to all other bins, including 
harmonics. 

Single Channel Mode 

See Channel Mode. 

Slope 

See Trigger Slope. 

Small Signal Analog Bandwidth 

The Small Signal Analog Bandwidth is defined as the frequency at which the output is 3 
dB below the input when the input is 20 dB below the full scale.  See Analog Bandwidth. 

SNR 

See Signal to Noise Ratio (SNR). 
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Software Trigger 

A trigger event issued by GageScope® when a timeout limit is reached. 

Spline Interpolation 

When GageScope® performs Spline Interpolation, intermediate sample points are added to a 
signal in order to smoothen its appearance. See Interpolation. 

Timeout 

The timeout limit is the amount of time GageScope® waits for a trigger event. A timeout 
occurs when the timeout limit is reached before a trigger event occurs. In the event of a 
timeout, GageScope® issues a software trigger, i.e. it triggers at the moment of timeout. 

Total Harmonic Distortion 

Total Harmonic Distortion (THD) is measured in a similar fashion to SNR (Signal to Noise 
Ratio), except for the fact that in the analysis, the fundamental is compared to the size of the 
sum of the harmonics. If some of the harmonics lie outside the 0 to Fs / 2 range, it is the 
aliased versions of the harmonics that are seen in the base band. 

Trace 

A Trace refers to the actual line displayed to represent a waveform in GageScope®. 

Trigger Event 

A trigger event is the moment when a trigger is detected by GageScope®, causing it to begin 
a data acquisition. For example, if the trigger source is set to channel 1, and the trigger 
level is set to 600 mV, then a trigger event will only occur if the input signal of channel 1 
rises past 600 mV. The detection of a trigger is affected by a variety of settings in 
GageScope®.  

See trigger level and trigger source. Also see Basic Concepts of the Triggering tutorial. 
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Trigger Level 

The trigger level is the level in Volts a signal must cross in order for a trigger event to occur. 
For example, if the trigger is set to 500 mV, and the signal reaches 400 mV, a trigger event 
does not occur. But if the signal rises to 600 mV, the signal will have crossed the trigger 
level, invoking a trigger event and subsequent data acquisition. 

In the display window, the trigger level is represented by a slope icon to the far left of a 
channel, with a dashed horizontal line connected to it. 

Trigger Marker 

The vertical line with a small T in the display window marking time-zero in a data 
acquisition. The trigger marker points to when the trigger occurred. Data to the left of the 
trigger marker is Pre-trigger Data; data to the right is Post-trigger Data. 

Trigger Source 

The source GageScope® looks at when determining if a trigger event has occurred. In 
GageScope® the choices are input signals (channel 1 and channel 2), External Trigger, and 
Free Run. 

Trigger View 

Trigger View is a powerful feature of GageScope® software which allows the user to view 
the signal being captured by a CompuScope card in real-time. This feature differentiates 
Gage products from all other PC based and stand-alone digital oscilloscopes. 

Vertical Resolution 

Vertical resolution is the number of bits with which an A/D system can estimate the 
amplitude of the analog signal. It must be noted that the vertical resolution is not the same as 
the Effective Number of Bits. 
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X Axis 

The X axis is a dashed horizontal line that divides the display window into two equal parts. 
The X Axis is a permanent fixture in the display window and does not move with changes to 
the vertical scroll bar.  

X-Y Mode 

X-Y mode allows channel display on both the X and Y axes, with up to 4096-point, real-time 
display for channels from the same board, or unlimited X-Y display in post-processing 
mode. 

Y Axis 

The Y Axis is a dashed vertical line that divides the display window into two equal parts. 
The Y Axis is a permanent fixture in the display window and does not move with changes to 
horizontal scroll bar.  

Zero Line 

The zero line of a channel is the dashed horizontal line that runs through the middle of the 
signal. The color of a Zero Line is always set to the same color as its channel. 
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A 
Abort command C-30 
Abort dialog C-44 
Acquisitions command C-122, C-128 
Acquisitions Counter C-129, C-130 
Add Parameters command C-176 
Advanced Analysis Tools C-177 
Align by Start C-157 
Align by Trigger C-157 
Aligning the Trigger Marker C-48 
Amplitude (InfoView) C-212 
Appendices D-1 
Arbitrary Waveform Generator B-164 
Arrange Channels command C-50 
Auto/Normal command C-86 
Autocorrelation C-224 
AutoSave C-178 
AutoSave Playback command C-39 
AutoSave Setup command C-31 
Averaged Channel C-36 
Averaging C-191 

Acquisitions C-122, C-128 
Acquisitions Counter C-129, C-130 
Average vs. CoAdd C-132 
Avg on Mulrec C-131 
In Multiple Record mode C-195 
Intermediate Results C-133 
Reset Count C-133 

Avg on Mulrec C-131, C-195 
AWG Input Tab: Ampl C-162 
AWG Input Tab: Duration C-160 
AWG Input Tab: Duty C-165 
AWG Input Tab: Equation C-161 
AWG Input Tab: Offset C-163 
AWG Input Tab: Samples C-166 
AWG Input Tab: Waveform C-164 

B 
Background Color C-118 
Bottom (InfoView) C-213 

C 
Capture Menu C-26 
Capture Modes B-8 

Continuous C-27 
One Shot C-26 

Cascade Windows C-46 
CG1100 Tab: Mode C-98 
CG1100 Tab: Sample Rate C-95 
CG1100 Tab: Triggered C-97 
Channel Context Menu C-168 
Channel Control B-6, C-119 

Align by Start C-157 
Align by Trigger C-157 
Color C-155 
Connect Dots C-146, C-152 
Format C-153 
Impedance C-139, C-140, C-141 
Input Range C-135 
Method C-147, C-151 
Polarization C-148, C-149 
Position C-144 
Probe C-137, C-138 
Vertical Scale C-142 

Channel List C-109 
Channel Mode B-18, C-67 
Channels 

Alignment C-157 
Color C-155 
Connect Dots C-146, C-152 
Drawing Format C-153 
Drawing Method C-147, C-151 
Hiding C-109 
Impedance C-139, C-140, C-141 
Input Range C-135 
Loading C-15 
Lowering C-144 
Measuring C-54 
Polarization C-148, C-149 
Position C-144 
Probe C-137, C-138 
Raising C-144 
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Saving C-16 
Scaling C-142 

Channels (Tutorial 2) B-39 
CoAdd command C-132 
Color 

Channel Color C-155 
Printing C-21 

CompuScope I/O Switch Settings D-39 
Configuring PC-based Cards A-9 
Connect Dots C-146, C-152 
Context Menus 

Channel C-168 
Display Window C-170 
Trigger C-172 

Continuous Capture command C-27 
Controls 

Channel Control B-6 
Display Control B-5 
System Control B-5 

Controls and Tabs B-14 
Copy and Paste Operations B-208 
Creating New Nodes B-191 
Crosscorrelation C-227 
Cursors C-54 
Cut and Paste Operations B-196 
Cut, Copy and Paste Features B-196 

D 
Decimation Mode B-140 
Default Settings A-17, D-37 
Deleting Existing Nodes B-193 
Deltas (between cursors) C-57 
Depth See Trigger Depth 
Differentiation C-222 
Display Control B-5, C-107 

Background Color C-118 
Channel List C-109 
Grid C-110 
Persistence C-113 
Timebase C-108 
Trigger Level C-116 
X Axis C-111 
Y Axis C-112 
Zero Lines C-117 

Display Window B-4, C-167 
Display Window Context Menu C-170 
Display Window Shortcuts C-173 
Drawing Method C-147, C-151 
Dual Channel Mode C-67 

E 
Erase Display command C-51 
Existing Nodes B-187 
Exit command C-23 
Extended Math C-219 
Extended Math Command C-38 
External Clock C-63 
External Trigger xv 

F 
Fall Time (InfoView) C-212 
Features x 
FFT Analysis C-214 
FFT Command C-37 
File Formats 

GageScope Binary File (.SIG) A-13, D-
3, D-12, D-24 

File Menu C-7 
File: New C-9 
Fine Button C-85 
Force Trigger command C-29 
Format C-153 
Frequency (InfoView) C-212 
Full Screen command C-24 
Fundamentals (Tutorial 1) B-3 

G 
Gage Menu D-12 
GageScope Binary File (.SIG) 

board_type constants D-35 
captured_gain input ranges D-33 
Extended trigger time D-36 
Format A-13, D-3, D-12, D-24 
sample_rate_index 

to sample rate table D-30 
trigger_gain input ranges D-33 
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Getting Started A-1 
Glossary E-1 
Graphical Waveform Editor B-181 
Grid C-110 

H 
Hardware Setup xv 
Hide/Show Display Elements C-110 
Hiding all controls C-24 
How to Use this Manual xii 
Hysterisys C-72 

I 
I/O Switch Settings D-39 
Impedance C-139, C-140, C-141 
Independent Triggering C-74 
Independent Triggering (Tutorial 3) B-86 
Infinite Persistence C-113 
InfoView C-176 
Input Range C-135 
Installing GageScope® A-3 
Installing the Windows Device Drivers A-

2 
Instrument Manager D-3 
Integration C-220 
Intermediate Results command C-133 
Invert Polarization C-148, C-149 

L 
Launching GageScope® A-15 
Left Bar C-46 
Level (Trigger) C-72 
License Agreement v 
List of Instruments Supported by 

GageScope® D-23 
Load Channel command C-15 
Load Setup command C-8 

M 
Magnifying Channels C-49 
Math C-33 

Math Channel command C-33 
Maximum (InfoView) C-213 
Mean (InfoView) C-212 
Mean display method C-147, C-151 
Menu Bar B-4 
Menus and Toolbars C-5, C-6, C-47 
Method C-147, C-151 
Minimum (InfoView) C-213 
MinMax display method C-147, C-151 
Multiple Record C-52, C-88 

and Averaging C-131, C-195 
Multiple Record (Tutorial 4) B-114 

N 
Negative Duty (InfoView) C-213 
Negative Overshoot (InfoView) C-213 
Negative Width (InfoView) C-212 
No Instruments Detected? A-16 
Num Cycles (InfoView) C-213 

O 
One Shot Capture command C-26 
Out 01 Tab: Filter C-105 
Out 01 Tab: Gain C-102 
Out 01 Tab: Offset C-104 
Out 01 Tab: Source C-100 
Overdraw Mode command C-51 

P 
Parameters C-176 
Pattern (Trigger) C-74 
PC Based Instruments D-3 
Peak to Peak (InfoView) C-212 
Period (InfoView) C-212 
Persistence C-113 
Persistence (Tutorial 4) B-99 
Polarization C-148, C-149 
Position C-144 
Positive Duty (InfoView) C-212 
Positive Overshoot (InfoView) C-213 
Positive Width (InfoView) C-212 
Post-trigger Data B-67 
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Predefined Waveforms B-171 
 viii 
Preferences command C-41 
Pre-trigger Data B-67 
Pre-trigger Depth C-83 
Print command C-20 
Print Preview command C-21 

Color printing C-21 
Print Setup command C-19 
Probe C-137, C-138 

Q 
Quitting GSWin C-23 

R 
Ready message in Status Bar C-175 
Reference C-1 

Menus and Toolbars C-47 
Rise Time (InfoView) C-212 
RMS (InfoView) C-212 

S 
Sample Rate B-18, C-62 
Save Channel command C-16 
Save Setup command C-7 
Scope Mode B-131 
Setups 

Loading C-8 
Saving C-7 

Shortcuts C-173 
SIG file format A-13, D-3, D-12, D-24 
Signals See Channels 
Single Channel Mode C-67 
Slope C-71 
Specifications xiii 
Split Mulrec option C-93 
Standard Waveform Generation B-176 
Status Bar C-46, C-175 
Stop command C-28 
Stop message in Status Bar C-175 
SubChannel C-35 
Subchannel Tab: End C-123 

Subchannel Tab: Offset C-126 
Subchannel Tab: Reference C-124 
SuperRes Mode C-59, C-68 
SuperRes Mode (Tutorial 4) B-108 
Supported CompuScope Cards xiv 
System Control B-5, C-60 
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Acquisitions Counter C-129, C-130 
Auto/Normal C-86 
Average vs. CoAdd C-132 
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Channel Mode C-67 
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External Clock C-63 
Fine Button C-85 
Intermediate Results C-133 
Multiple Record C-88 
Pattern C-74 
Pre-trigger Depth C-83 
Sample Rate C-62 
SuperRes Mode C-68 
Timeout C-86 
Trigger Level C-72 
Trigger Slope C-71 
Trigger Source C-70 
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T 
Test Output Connector D-55 
Tile Windows C-46 
Timebase C-108 
Timeout C-86 
Tool Bar B-4 
Tools Menu C-33 
Top (InfoView) C-213 
Track Mode (Cursors) C-58 
Transferring message in Status Bar C-175 
Trigger 

Event B-66 
Hysterisys C-72 
Independent C-74 
Level B-66 
Post-trigger data B-67 
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Pre-trigger data B-67 
Summary B-97 
Time Zero B-66 
Trigger Mark B-66 

Trigger Align C-48 
Trigger Context Menu C-172 
Trigger Depth 

Fine Button C-85 
Multiple Record C-88 
Pre-trigger Depth C-83 
Total C-82 
Units C-85 

Trigger Level C-72 
Hiding and Color C-116 

Trigger Pattern (Tutorial 3) B-86 
Trigger Slope C-71 
Trigger Source C-70 
Trigger Timeout C-86 
Triggering xvi 

Windowed C-74 
Triggering (Tutorial 3) B-66 
Triggering and the Status Bar C-175 
Troubleshooting C-229 
Tutorials B-1 

V 
Vertical Scale C-142 

View Menu C-24, C-25 

W 
Waiting message in Status Bar C-175 
Warranty xvii 
Waveform Generation using Equation B-

165 
Waveform Parameters C-204 
Waveform Parameters command C-40 
Window Menu C-46 
Windowed Triggering C-74 
Working with Subchannels B-156 

X 
X Axis C-111 

Y 
Y Axis C-112 

Z 
Zero Lines C-117 
Zoom Tools C-49 
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